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安全信息
将电源线连接到正确接地的电源插座上，所连接的电源插座与产品的距离不可太远，并且要符合使用方便的原
则。

请只使用随此产品提供的电源和电源线或厂商的认可替代品。

当心—可能的伤害：为了降低火灾风险，当您将此产品连接到公共交换电话网络中时，请只使用随同此
产品一起提供的电信(RJ‑11)电缆或者 UL 认证的 26 美国线规(AWG)或更大的替代品。

当心—电击危险：请确认所有的外部连接（例如以太网和电话系统连接）都正确地安装在各自标示的插
口中。

本产品使用特定制造商的元件，并按照严格的世界安全标准来设计、测试及验证。有些零件的安全功能特征可
能不一定很明显。对于更换其他厂家零件所造成的不良后果，制造商概不负责。

当心—可能的伤害：请不要切割、扭曲、捆绑、挤压电源线，或者在电源线上放置重物。请不要使电源
线磨损或受压。请不要将电源线塞在物体之间，例如家具和墙壁之间。如果发生了这些事情，可能会产
生火灾或电击危险。请定期检查电源线，及时发现这种问题的迹象。在检查电源线之前，请先从电源插
座上断开。

有关操作说明书中未提及的其他服务或维修，请向专业的服务人员咨询。

当心—可能的伤害： 本产品中的锂电池不可更换。如果不正确更换锂电池，可能会有爆炸危险。不要再
充电、拆解或焚烧锂电池。丢弃旧的锂电池时应按照制造商的指导及当地法规进行处理。

重要安全指导：使用电话设备时，必须遵循基本的安全防范措施，以降低火灾风险、人员触电及损伤事件，包
括以下注意事项：

• 请勿在靠近水源处使用本产品，如浴缸、洗手台、厨房洗碗槽、洗衣盆附近、潮湿的地下室或游泳池附近。

• 请勿在雷暴天气中使用电话（无线电话除外）。闪电时可能有触电的危险。

• 如果燃气泄露，请勿在泄露区域附近使用电话进行报告。

当心—电击危险：当清洁打印机的外部时，为避免受电击的危险，请在操作之前先从墙壁插座中拔掉电
源线并从打印机上断开所有电缆。

当心—电击危险：在雷雨天气时，请不要使用传真功能。也不要在雷雨天气时设置本产品，或者使用传
真功能、电源线或电话线进行带电操作或线缆连接。

请保留这些安全指导。
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关于您的打印机

感谢您选择此打印机！
我们经过努力的工作，确保此打印机可以满足您的需求。

如要立刻开始使用您的新打印机，请使用随同打印机一起提供的安装资料，然后快速浏览用户手册了解如何完
成基本任务。如要实现您的打印机的最佳性能，请仔细阅读用户手册，并确认您在我们的网站上检查了最新的
升级。

我们致力于通过我们的打印机提供性能和价值，并且我们希望确保您满意。如果您在使用过程中遇到任何问
题，我们知识渊博的技术支持代表将会很高兴地帮助您迅速恢复正常使用。如果您发现哪些事情我们可以做得
更好，请告诉我们。毕竟我们所做的这一切都是为了您，您的建议可以帮助我们做得更好。

最小化打印机对环境的影响
我们致力于保护环境，并且不断地改善我们的打印机以减少其对环境的影响。通过选择某些打印机设置或任
务，您可以更进一步地降低打印机对环境的影响。

节约能源
• 选择最低睡眠时限。打印机空闲一段时间之后，“睡眠”功能将会让打印机进入最低能耗待机模式，这段
时间称为睡眠时限。

• 降低屏幕亮度。调暗打印机显示屏以降低打印机功耗。

• 共享您的打印机。无线/网络打印机允许您在多台计算机之间共享一台打印机，这样可以节约能源和其他资
源。

节约纸张
• 在纸张的一面上打印多页图像。“合并打印”功能允许您在一张纸上打印多页。您最多可以在一张纸的一
面上打印 16 页图像。

• 在纸张的双面进行打印。双面打印允许您手动或自动在纸张的双面进行打印（取决于您的打印机型号）。

• 在打印之前预览打印作业。您可以在工具栏中、“打印”或“打印预览”对话框中或打印机的显示屏上使
用预览功能（取决于您的打印机型号）。

• 使用可回收的纸张。

• 缩小要打印的文档的边距。

• 扫描并保存。为了避免打印多份，您可以扫描文档或照片，然后将它们保存在计算机程序、应用程序或闪
存驱动器中进行演示（取决于您的打印机型号）。

节约墨水
• 使用“快速打印”或“草稿”模式。使用这些模式打印文档可以比正常情况使用较少的墨水，推荐用于打
印文本为主的文档。

• 使用需要较少墨水的字体类型和字体设置。大部分程序或应用程序可让您调节颜色深浅。

• 使用高容量打印墨盒。高容量打印墨盒中的墨水允许您使打印更多的页数。

• 在打印之前预览打印作业。您可以在工具栏中、“打印预览”对话框中或打印机的显示屏上使用预览功能
（取决于您的打印机型号）。
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循环利用
• 通过 Lexmark 打印墨盒回收计划返还打印墨盒以进行再利用或再循环。如要返还打印墨盒，请访问

www.lexmark.com/recycle。按照指导索取已付邮资的返还袋。

• 回收产品包装。

• 回收您的旧打印机，不要将其丢弃。

• 从作废的打印作业中回收纸张。

• 使用可回收的纸张。

如要浏览 Lexmark 环保报告，请访问网站 www.lexmark.com/environment。

注意：您的打印机可能不提供某些程序，或者不支持程序的某些功能（具体取决于您购买的打印机的功
能）。

查找有关打印机的信息

出版物

查找内容 所在位置

初始设置指导：

• 连接打印机

• 安装打印机软件

设置文档

设置文档随打印机附带，也可以在 Lexmark 网站上获取，网址为：
http://support.lexmark.com。

使用打印机的其他设置和指导：

• 选择和保存纸张及特殊介质

• 装入纸张

• 根据打印机型号执行打印、复
印、扫描和传真任务

• 配置打印机设置

• 查看和打印文档及照片

• 设置和使用打印机软件

• 根据打印机型号设置并配置网
络上的打印机

• 管理和维护打印机

• 疑难解答和解决问题

《用户指南》

《用户指南》可从安装软件光盘中获得。

有关更新，请查看我们的网站：http://support.lexmark.com。

根据您的打印机型号创建和定制
打印机解决方案

《SmartSolutions 用户指南》

请访问 http://smartsolutions.lexmark.com。

关于您的打印机 8
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查找内容 所在位置

使用打印机软件的帮助 Windows 或 Mac 帮助

打开打印机软件程序或应用程序，然后单击帮助。

单击 可以浏览上下文相关信息。

注意：

• “帮助”随打印机软件一起自动安装。

• 打印机软件位于打印机程序文件夹中或者计算机桌面上，具体取决于您的操作系
统。

最新的补充信息、更新和在线技
术支持：

• 疑难解答提示和技巧

• 常见问答

• 文档

• 驱动程序下载

• 在线聊天支持

• 电子邮件支持

Lexmark 支持网站—http://support.lexmark.com

注意：选择您所在的国家或地区，然后选择您的产品以浏览相应的技术支持网站。

请记录以下信息（位于购买发票上和打印机背面），当您联系技术支持时请准备好这
些信息，以便我们能够更快地为您服务：

• MAC 地址号码

• 序列号

• 购买日期

• 购买商店

电话支持 在美国，请拨打我们的电话：

1-800-395-4039
周一–周五（8:00 AM–11:00 PM 东部时间），周六和周日（11:00 AM–8:00 PM 
东部时间）

您所在国家或地区的技术支持电话号码和服务时间可以在技术支持网站上获得
(http://support.lexmark.com)，也可以参阅打印机随附的保修手册。

质保信息 • 美国—请参阅打印机随附的有限质保声明，或者访问我们的网站：
http://support.lexmark.com。

• 其他国家或地区—请参阅打印机随附的质保手册。

注意：您的打印机可能不提供某些程序，或者不支持程序的某些功能（具体取决于您购买的打印机的功
能）。

关于您的打印机 9
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了解打印机的部件

选项 用途

1 自动文档传送器(ADF) • 扫描、复印或传真多页文档。

• 取出自动文档传送器中的卡纸。

注意：精选打印机型号允许通过自动文档传送器使用页面单通道进行双面打印扫
描、复印或传真。

2 自动文档传送器进纸匣 将文档原件装入自动文档传送器内。

注意：

• 请不要在 ADF 内装入明信片、照片、较小的物体或较薄的介质（例如杂志剪
辑）。请将这些物体放置在扫描仪玻璃上。

• 扫描、复印或传真之后，您可以抬起进纸匣的右端轻松取回原始文档。

3 PictBridge 和 USB 接口 将 PictBridge 兼容数码相机或闪存驱动器连接到打印机。

4 读卡器指示灯 检查读卡器的状态。当插入存储卡时，指示灯会打开；当访问存储卡时，指示灯会
闪烁。

5 存储卡插槽 插入存储卡。

6 打印墨盒保护门 安装、取出或更换打印墨盒。

7 进纸匣（进纸匣 1） 装入纸张。

8 第二个进纸匣（进纸匣 2）

注意：只有精选打印机型号
才具备此选项。

装入更多的纸张。

您可以装入和进纸匣 1 相同类型的纸张。您也可以装入不同类型的纸张，然后改变
默认纸张设置，让打印机为特定类型的打印作业使用进纸匣 2 中的纸张。

9 输出接纸架 盛放打印机送出的纸张。

注意：如果想要打印机可以进行任何打印作业，请确保充分拉开输出接纸架并翻开
接纸架扩展板。

10 接纸架扩展板 盛放打印机送出的纸张。

注意：如果想要打印机可以进行任何打印作业，请确保充分拉开输出接纸架并翻开
接纸架扩展板。

关于您的打印机 10



选项 用途

11 带触摸屏的打印机操作面板 操作打印机。

选项 用途

12 客户支持标签 确定打印机型号、客户支持热线和打印墨盒信息。

13 扫描仪玻璃 扫描、复印或传真照片和文档。

14 电源接口 将打印机连接到电源线。

15 双面打印部件 • 在纸张的双面进行打印。

• 取出卡纸。

16 USB 接口 使用 USB 电缆将打印机连接到计算机。

警告—可能的损坏：除了插入或断开 USB 电缆或安装电缆的时候，请不要触摸 USB 接
口。

注意：撕去胶带可以露出接口。

17 以太网接口 将您的打印机连接到计算机、本地网络、外部 DSL 或电缆调制解调器。

18 LINE（线路）接口 通过标准墙壁电话线插座(RJ‑11)、DSL 过滤器、VoIP 适配器或任何其他允许您使用电
话线路的适配器，将打印机连接到可以使用的电话线上以便发送和接收传真。

19 EXT（电话分机）接口 将其他设备（电话机或电话答录机）连接在打印机和电话线上。如果您的打印机没有使
用专用传真线路，并且您所在的国家／地区支持这种连接方法，请使用此插口。

注意：取下保护塞可以露出接口。
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选择打印机位置
选择打印机位置时，根据您的打印机功能，请预留足够的空间以打开进纸匣（包括可选进纸匣）、盖板和保护
门。包括以下重要措施：

• 提供一块平整坚固稳定的平面。

• 保持打印机：

– 远离空调、暖气机和换气扇的直接气流。

– 避免阳光直射、湿度过大或气温浮动

– 干净、干燥、无尘

关于您的打印机 12



订购和更换耗材

订购打印墨盒
请确保订购面向您所在地区上市销售的打印墨盒。

• 地区 1：美国、加拿大、拉丁美洲地区用户，请使用 200、200XL 或 200XLA 打印墨盒。

• 地区 2：欧盟(EU)、欧洲经济区(EEA)、瑞士地区用户，请使用 210、210XL 或 200XLA 打印墨盒。

• 地区 3：非洲、中东、中东欧（非欧盟）、独联体(CIS)以及亚太地区用户，请使用 220、220XL 或 200XLA
打印墨盒。

1 只允许单次使用。使用后请将此打印墨盒返还给 Lexmark 进行再制造、再填充或再循环。
2 只在 Lexmark 网站上提供：www.lexmark.com。

注意：

• 如要获取更多的墨水，请订购高容量打印墨盒。

• 根据您所在的国家或地区，您收到的打印墨盒可能是单独的或者带有包装。

• 根据您的需要，您可以组合订购标准打印墨盒和高容量打印墨盒。

• 如要获取可打印页数的信息，请访问 www.lexmark.com/yields。

• 用来打印文档的打印墨盒也可以用来打印照片。

• 要获得最佳效果，请仅使用原装 Lexmark 打印墨盒。

使用原装 Lexmark 打印墨盒
Lexmark 打印机、打印墨盒和照片纸互相配合，可以实现卓越的打印质量，并且我们的墨水专为您的打印机
设计，有助于延长您的产品的寿命。我们推荐您只使用原装 Lexmark 打印墨盒。

Lexmark 质量保证不负责修复由非 Lexmark 墨水或打印墨盒所引起的损坏。

订购和更换耗材 13
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更换打印墨盒
在您开始操作之前，请确认您有新的打印墨盒。在您取出旧的打印墨盒之后，必须立刻安装新的打印墨盒，否
则打印头喷头中剩余的墨水可能会干燥。

1 打开打印机电源。

2 打开打印墨盒保护门。

警告—可能的损坏：打开打印墨盒保护门时确保不要超过 90 度，以免门体断裂。

3 按释放按钮，然后取出旧的打印墨盒。

4 插入各打印墨盒，直到咔嗒 一声，卡入到位。

注意：从包装中取出新打印墨盒后请立即安装，以避免墨水暴露在空气中。

5 关闭打印墨盒保护门。

注意：

• 如果打印机显示屏上出现校正打印机，请触摸继续或按 （取决于打印机型号）。

• 打印完成之前，请不要移开校正测试页。

订购和更换耗材 14



订购纸张和其他耗材
如要订购打印机耗材，或者查找您附近的经销商，请访问我们的国际互联网站 www.lexmark.com。

项目 产品编号

USB 电缆 1021294

如要获取更多的信息，请访问网站 www.lexmark.com。

纸张 纸张尺寸

Lexmark 照片纸 • Letter

• A4

• 4 x 6 英寸

• L

注意：

• 在不同的国家／地区可能会有所不同。

• 要获得最佳效果，当您打印照片或其他高质量的图像时，请使用 Lexmark 照片纸。

• 如要获取更多的信息，请访问网站 www.lexmark.com。

回收 Lexmark 产品
如要返还 Lexmark 产品进行回收：

1 访问我们的国际互联网站 www.lexmark.com/recycle。

2 查找您希望回收的产品类型，然后从列表中选择您的国家或地区。

3 按照计算机屏幕上的指导进行操作。

注意：如果是未列在 Lexmark 收集计划中的打印机耗材和硬件，您可以通过当地的回收中心进行回收。请联
系您当地的回收中心以确定他们接受的回收物品。

订购和更换耗材 15
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使用打印机操作面板按钮和菜单

使用打印机控制面板
注意：当图标在当前界面中可以选择时，它们将会显示出来。如果图标没有显示，则功能无法使用。

使用 以便

1 电源 • 打开或关闭打印机的电源。

• 切换到“睡眠”模式。

注意：当打印机打开时，按 可切换到“睡眠”模式。按住 按钮 3 秒钟以关
闭打印机。

2 返回 • 返回到上一个界面。

• 从当前菜单退出到上一级菜单。

3 触摸显示屏

注意：在“睡眠”模式下，
显示屏将会关闭。

• 浏览打印机菜单。

• 改变设置。

• 查看打印机信息和动画。

4 开始 开始作业，取决于所选的模式。

5 取消 取消当前的作业或任务。

6 帮助 查看帮助文字信息。

位于主界面时可查看教程。

7 主页 返回到主界面。

了解主界面
打印机打开并预热一段时间后，显示屏将显示主界面。使用主界面中的选项初始化操作，例如复印或传真，或
者改变打印机设置。

使用打印机操作面板按钮和菜单 16



触摸 以便

1 复印 进入“复印”菜单并进行复印。

2 扫描 进入“扫描”菜单并扫描文档。

3 传真 进入“传真”菜单并发送传真。

4 存储设备 查看、选择或打印照片和文档。

注意：只有当存储卡、闪存驱动器连接在打印机上，并且您返回到主界面时，此图标才会出
现。如果 PictBridge 兼容数码相机已连接到打印机，但内存卡不在卡插槽时，此图标不会出
现。

PictBridge 浏览、选择或打印 PictBridge 兼容数码相机中的照片。

注意：

• 当您返回主界面同时 PictBridge 兼容数码相机已连接到打印机时，即使存储设备在卡插槽
中，此图标也会出现。

• 要更改默认打印设置，请在打印机操作面板上触摸更多选项。

5 SmartSolutions 访问 SmartSolutions 菜单。

6 墨水量图标 • 查看安装的打印墨盒的当前墨水量。

• 使用打印墨盒维护和信息功能。

7 设置图标 进入设置菜单并改变打印机设置。

使用打印机操作面板按钮和菜单 17



触摸 以便

8 网络指示灯 检查打印机的网络连接状态并读取网络设置。

使用触摸屏浏览菜单

使用 以便

1 左箭头 向左滚动。

2 右箭头 向右滚动。

3 接受 保存您的设置。

4 上箭头 向上滚动。

5 滚动条 向上或向下滚动菜单列表。

6 下箭头 向下滚动。

提示：

• 请用手指浏览界面。如果使用其他工具或设备浏览，将无法正常使用触摸屏。

• 拖动滚动条或触摸箭头，直到您希望的菜单或设置出现在显示屏上。

使用打印机操作面板按钮和菜单 18



• 使用您的手指上下拖动界面，然后从显示屏上抬起您的手指。要浏览上一个或下一个界面，请向两侧划动。
该操作与选择左右箭头的效果相同。

• 如要确认设置或者选择菜单或菜单项，请触摸它。

• 如有必要，请在选择设置或改变设置之后触摸确定或接受。

注意：本手册中的所有指导都从主界面开始。如果不是在主界面，那么请触摸 。

例如，如要浏览纸张类型并选择默认纸张类型设置：

1 请触摸  > 纸张设置 > 纸张类型。

注意：对于装有两个进纸匣的精选打印机型号，请触摸 ，选择纸进纸匣，然后触摸纸张 设置 > 
纸张 类型。

2 请使用滚动条或箭头，或上下划过显示屏，以使界面上下滚动，便于查看纸张类型列表。

3 触摸选择纸张类型设置，然后触摸接受保存设置。

更改睡眠时限
打印机将会在空闲一段时间之后进入睡眠模式，这段时间称为睡眠时限。与默认打印机设置相比，睡眠功能通
过降低打印机的能源消耗（一些打印机型号可以达到 28%）可以使能源效率达到最优化。如要最多地节约能
源，请选择最小的睡眠时限。

1 在主界面中触摸  >设备设置 >睡眠。

2 选择睡眠时限，然后触摸接受。

节约纸张和能源
要显著减少用纸降低浪费，请激活双面打印：

1 从主界面浏览至：

 > 打印模式设置 >双面打印 >开

2 触摸接受。

要使能源效率达到最优化，请降低“睡眠”时限和“屏幕亮度”：

1 从主界面浏览至：

 > 设备设置

2 触摸睡眠或屏幕亮度，然后调整设置。

3 触摸接受。

注意：如果您选择了双面打印，根据您的打印机型号，打印机会为复印、传真作业以及 Windows 和
Macintosh 打印作业在纸张的双面进行打印。
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恢复出厂默认设置
恢复出厂默认设置将会删除您所选择的所有打印机设置。

1 从主界面中，触摸  > 恢复出厂默认设置 > 恢复全部打印机设置 > 是。

2 当提示您设置您的打印机的初始设置时，请使用触摸屏进行选择。

当恢复出厂默认设置之后，打印机将会自动重新启动。

设置打印机的安全 PIN
为了防止对特定菜单设置进行未经授权的更改，您可以为打印机设置安全 PIN。

1 从主界面中，依次选择：

 >安全设置 >设置管理 PIN

2 输入 4 位数字的 PIN，然后触摸接受。

注意：请务必牢记您的安全 PIN。要恢复丢失的 PIN，您需要客户支持人员的协助。

3 触摸安全设置 >锁定设置 >开 >接受。

注意：当“锁定设置”设置为“开”时，如果要更改某些打印机设置，每次都需要输入安全 PIN。要禁
用安全 PIN，请将“锁定设置”设置为“关”。
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使用打印机软件

最低系统需求
打印机软件最多需要 500MB 可用硬盘空间。

支持的操作系统

• Microsoft Windows 7 (SP1)

• Microsoft Windows Server 2008 (R2)

• Microsoft Windows Server 2003 (SP2)

• Microsoft Windows Vista (SP2)

• Microsoft Windows XP (SP3)

• Macintosh Intel OS X 10.7.0 或更高版本（英文版）

• Macintosh Intel OS X 10.6.0 或更高版本（英文版）

• Macintosh Intel OS X 10.5.0 或更高版本（英文版）

• Macintosh Intel OS X 10.4.4 或更高版本（英文版）*

• Macintosh PowerPC OS X 10.5.0 或更高版本（英文版）

• Macintosh PowerPC OS X 10.4.0 或更高版本（英文版）*

• Ubuntu Linux 11.10、10.10、10.04、9.10 和 9.04*

• Red Hat Enterprise Linux WS 6、WS 5 和 WS 4*

• Red Flag Linux Desktop 6.0*

• SUSE Linux Enterprise Server 11 和 10*

• SUSE Linux Enterprise Desktop 11 和 10*

• Linux openSUSE 12.1、11.4、11.3 和 11.2*

• Linpus Linux Desktop 9.6*

• Fedora 16 和 14*

• Debian GNU/Linux 6.0 和 5.0*

* 适用于此操作系统的打印机驱动程序只能从下面的网站上获得：http://support.lexmark.com。

注意：关于与打印机兼容的其他操作系统版本的信息，可以从我们的网站上获取。

使用 Windows 打印机软件

在打印机安装过程中安装的软件

当您使用安装软件光盘安装打印机时，所有必需的软件都已经安装。您可能也选择了安装一些其他的程序。下
面的表格提供了各种软件程序的概述，以及它们可以帮助您做什么。

+如果您在初始安装过程中没有安装这些程序，请重新插入安装软件 CD，运行安装软件，然后单击高级选项 >
安装其他软件。
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打印机软件

使用 以便

LexmarkTM 打印机主页

（简称为打印机主页）

• 运行应用程序。

• 扫描或通过电子邮件发送照片或文档。

• 编辑扫描的文档。

• 将文档扫描成 PDF 格式。

• 调整打印机设置。

• 订购耗材。

• 维护打印墨盒。

• 注册打印机。

• 联系技术支持。

• 访问用户手册。

Lexmark 电话簿

（简称为电话簿）

管理传真联系人。

Abbyy Sprint OCR 扫描文档并生成您可以在文字处理程序中编辑的文本。

Lexmark 无线设置实用程序

（简称为无线设置实用程序）

• 在无线网络中安装无线打印机。

• 改变打印机的无线设置。

注意：如果打印机有无线功能，此程序将会随同打印机软件一起自动安装。

Lexmark Tools for Office
（Office 工具）

（简称为 Tools for Office）

在 Microsoft Office 2007 中读取您喜欢的设置。

打印机设置实用程序 配置打印机的传真和电子邮件设置。

状态报告器 了解更多关于遇到的打印问题的信息

状态监控中心 • 检查打印机耗材的状态

• 在线订购耗材。

产品升级 有新的更新可用时，接收打印机软件更新的自动通知。

打印首选项 当您打开一个文档，然后单击文件 >打印 >属性时，打印首选项对话框将会出现。您可
以在对话框中为打印作业选择选项，例如：

• 选择要打印的份数。

• 进行双面打印。

• 选择纸张类型。

• 添加水印。

• 增强图像。

• 保存设置。

注意：打印首选项随同打印机软件一起自动安装。

注意：根据您购买的打印机的功能，您的打印机可能不提供某些程序，或者不支持程序的某些功能。
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使用 Macintosh 打印机软件

在打印机安装过程中安装的软件

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击要使用的应用程序。

使用 以便

Print 对话框 调整打印机设置并安排打印作业。

注意：打开文档或照片，选择 File > Print 来访问 Print 对话框。

Printer Settings • 自定义传真作业设置。

• 创建和编辑联系人列表。

• 配置电子邮件连接设置。

Wireless Setup Assistant 在无线网络中安装打印机。

注意：如果打印机有无线功能，此程序将会随同打印机软件一起自动安装。

Uninstaller 从计算机中删除打印机软件。

注意：打印机可能未带有这些应用程序，取决于您购买的打印机的功能。

Web 链接

Web 链接是链接到预定义 Web 页面的链接。Web 链接保存在打印机文件夹中。

1 从 Finder 中依次选择：

Applications >选择您的打印机文件夹 > Web Links

2 双击要访问的 Web Link。

使用 以便

Customer Support 联系技术支持。

Lexmark Software Updates 下载并安装最新的打印机软件。

Lexmark Online 访问 Lexmark 网站。

Order Supplies Online 订购墨水或耗材。

Printer Registration 注册您的打印机。

Visit Lexmark SmartSolutions • 访问 SmartSolutions 网站。

• 选择您的自定义解决方案。

注意：打印机可能未带有这些 Web 链接，取决于您购买的打印机的功能。

使用打印机软件 23



查找并安装可选软件

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 >支持 > 在线支持

4 从网站选择您的打印机，然后下载驱动程序。

5 安装其他或可选软件。

对于 Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹 > Web Links > Lexmark Software Updates

2 从网站选择您的打印机，然后下载驱动程序。

3 安装其他或可选软件。

更新打印机软件

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 选择您的打印机，然后单击产品更新。

4 按照计算机屏幕上的指示进行操作。

对于 Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹 > Web Links > Lexmark Software Updates

2 从网站选择您的打印机，然后下载驱动程序。

下载 PCL 和 PS 驱动程序（仅限于 Windows）
可从我们的网站下载通用的打印驱动程序（例如 PCL 5 仿真、PCL XL 仿真和 PS 仿真）。您需要搜索打印机
型号以查看兼容的驱动程序。
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重新安装打印机软件
当您使用安装软件光盘设置打印机时，所有必需的软件都应该已经安装。如果您在安装过程中遇到了问题、您
的打印机没有出现在打印机文件夹中、或者发送打印作业时您的打印机没有出现在打印机选项中，请尝试卸载
并重新安装打印机。

反安装打印机软件

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 单击反安装程序。

4 按照计算机屏幕上的指示进行操作。

5 完成反安装后，请重新启动计算机。

对于 Macintosh（英文版）用户

1 关闭所有打开的应用程序。

2 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

3 双击 Uninstaller。

4 按照计算机屏幕上的指示进行操作。

安装打印机软件

注意：如果您以前在这台计算机上安装了打印机软件，但是需要重新安装软件，请先反安装当前的软件。

对于 Windows 用户

1 关闭所有打开的软件应用程序。

2 插入安装软件 CD。

如果 1 分钟之后“欢迎”对话框界面仍然没有显示，请手动运行 CD：

a 单击 ，或单击开始，然后单击运行。

b 在“开始搜索”或“运行”对话框中键入 D:\setup.exe，其中 D是您 CD 驱动器或 DVD 驱动器的
盘符。

c 按输入键，或者单击确定。

3 单击安装，然后按照计算机屏幕上的指导进行操作。
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对于 Macintosh（英文版）用户

1 关闭所有打开的应用程序。

2 插入安装软件 CD。

如果 1 分钟之后安装对话框仍然没有出现，请单击计算机桌面上的 CD 图标。

3 双击软件安装程序包，然后按照计算机屏幕上的指示操作。

使用 Internet

1 访问 Lexmark 网站 www.lexmark.com。

2 依次选择：

SUPPORT & DOWNLOADS > 选择您的打印机 > 选择您的操作系统

3 下载驱动程序并安装打印机软件。

注意：更新过的打印机软件可以从 http://support.lexmark.com 获得。
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装入纸张和文档原件

为进纸匣装入纸张
请确保：

• 打印机电源已打开。

• 您使用的是喷墨打印机专用纸张。

• 纸张未使用过或破损。

• 按照特殊介质随附的指导进行操作。

• 调整进纸导轨时不会导致纸张变形。

1 提起输出接纸架，然后将进纸匣完全拉出。

2 将纸张导轨移到进纸匣两侧。
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3 如果要装入 Legal 尺寸的纸张，请拉动导片扩展进纸匣。

4 将可打印面朝下装入纸张。

5 调整纸张导轨，使其紧靠纸张左侧、右侧和底部边缘。

注意：确认纸张低于进纸匣边缘处的最大加载线。进纸匣过载可能导致卡纸。
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6 装入进纸匣。

注意：如果您扩展了进纸匣以适应 Legal 纸张的尺寸，在插入进纸匣时，它将从打印机的前部露出来。

7 完全展开输出接纸架，抽出接纸架扩展板以承接输出的纸张。

装入各种类型的纸张
注意：不应将不同的纸张类型和尺寸同时装入进纸匣。

最多可以
装入

请确认

300 张普
通纸

• 该纸张专门用于喷墨打印机。

• 进纸导轨紧靠纸张左侧、右侧和底部边缘。

100 张涂
层纸

25 张照片
纸

25 张光面
纸

• 装入纸张时，将光面或可打印的一面朝下。如果您不确定哪一面可打印，请参阅纸张随附的说明。

• 进纸导轨紧靠纸张左侧、右侧和底部边缘。

• 请不要接触或刮擦未打印的纸张的光面，以防止出现可能影响打印质量的污迹或痕迹。

注意：

• 要获得最佳效果，请将照片单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储存。

• 要获得最佳效果，请装入充足的照片纸，但是不要超过所用纸张类型的最大张数。
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最多可以
装入

请确认

10 个信封

• 该信封专门用于喷墨打印机。

• 装入信封时，将可打印面朝下，信封舌面向左（如图示）。

• 根据图标指示，在进纸匣的中心装入信封。请始终将其装入进纸匣的后部。

• 请使用“横向”设置打印信封。

• 进纸导轨紧靠信封的左侧、右侧和底部边缘。

• 选择正确的信封尺寸。设置左边距和右边距，以便在信封上正确打印信封文本。

警告—可能的损坏：请不要使用带有金属扣、线绳或金属折杆的信封。

注意：

• 请不要装入带有孔洞、穿孔、剪贴或阳文的信封。

• 请不要使用带有外露粘胶的信封。

25 张标签
纸

• 请使用完整的标签纸。如果标签纸不完整（缺少部分标签），在打印过程中可能会脱落，从而导致卡纸。

• 您可装入 A4 或 letter 尺寸的标签纸。

• 将可打印面朝下装入标签。

• 标签的顶部先装入打印机。

• 进纸导轨紧靠标签纸的左侧、右侧和底部边缘。

50 张透明
胶片

• 将粗糙的一面朝下装入透明胶片。

• 您可装入 A4 或 letter 尺寸的透明胶片。

• 装入之前请撕去透明胶片的纸质背面。

• 如果透明胶片具有可撕除条带，那么每个条带都要朝下。

• 进纸导轨紧靠透明胶片的左侧、右侧和底部边缘。

注意：透明胶片需要较长的时间才能完全干燥。为了避免出现污迹，请立即取出打印机送出的透明胶片，等
墨水完全干燥后再进行叠放。

10 张热转
印纸

• 请按照随热转印纸提供的装入说明进行操作。

• 将可打印面朝下装入热转印纸。

• 进纸导轨紧靠热转印纸的边缘。

注意：要获取最佳效果，请一次装入一张热转印纸。
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最多可以
装入

请确认

25 索引
卡、照片
纸或明信
片

• 厚度不超过 0.025 英寸（0.635 毫米）。

• 将可打印面朝下装入照片纸。

• 请在进纸匣的中心装入照片纸。

• 进纸导轨紧靠纸张左侧、右侧和底部边缘。

注意：要获得最佳效果，请将照片单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储存。

保存纸张设置
您可以调整打印和复印作业的设置，使之与您在打印机中装入的纸张尺寸和类型匹配。

1 在主界面中触摸  >纸张设置。

注意：如果已在打印机中安装两个进纸匣，请触摸 ，选择进纸匣，然后触摸纸张设置。

2 选择设置：

• 如果您希望设置纸张尺寸，请依次选择：

纸张尺寸 > 选择纸张尺寸 >接受

• 如果您希望设置纸张类型，请依次选择：

纸张类型 > 选择纸张类型 >接受

在扫描仪玻璃上装入文档原件
1 打开扫描仪玻璃顶盖并将文档正面朝下放置在扫描仪玻璃上。

2 关闭扫描仪顶盖。
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将文档原件装入自动文档传送器(ADF)
注意：确认纸张低于进纸导轨边缘处的最大加载线。进纸匣过载可能导致卡纸。

1 调节 ADF 进纸匣上的进纸导轨，使之与文档原件的宽度相同。

2 将文档原件正面朝上并且页面顶部向前装入，直到文档顶端紧贴入 ADF 中。

您可以装入以下尺寸的纸张：

• Letter

• Legal

• 8 x 10 英寸

• A4

• B5

• A5

• 20 x 25 厘米
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• Executive

• Oficio (Mexico)

• Folio

注意：请确认装入的纸张尺寸与扫描选项菜单中设置的纸张尺寸匹配。

使用其他纸张尺寸和类型
为了获得最佳打印效果，请使用为打印机作业推荐的纸张。

推荐的纸张品牌

对于电子邮件、接收的传真、内部文档以及类似的打印作业

尺寸 推荐的纸张 重量 纸张类型设置为

Letter PrintWorks 30% Recycled Multipurpose Paper #00011 20 lb 普通纸张

A4 UPM Future Multitech 80 g/m2 普通纸张

对于彩色及高覆盖率文档

尺寸 推荐的纸张 重量 纸张类型设置为

Letter Georgia Pacific Everyday Ink Jet and Laser Paper #214305 24 lb ColorLok 认证的普通纸张

Hammermill Ultra Premium Laser Print #16600‑0
注意：要获得最佳效果，请将“页面干燥时间”设置为延长。

24 lb 优质普通纸

Georgia Pacific Premium Multipurpose Paper #214306 20 lb ColorLok 认证的普通纸张

A4 M‑Real Data Copy Colour Printing

注意：要获得最佳效果，请将“页面干燥时间”设置为延长。

90 g/m2 优质普通纸

SOPORCEL Navigator Universal Multifunctional 80 g/m2 优质普通纸

对于简历、信签文档以及类似的打印作业

尺寸 推荐的纸张 重量 纸张类型设置为

Letter Wausau Professional Series Royal Linen paper, 30% recycled, #WAU74089 24 lb 优质普通纸

对于照片、宣传手册、名片、热转印纸、窗花以及其他特殊打印作业

纸张和特殊介
质

单面或
双面打
印

推荐的纸张 纸张类型设置为

照片 单面 LexmarkPerfectFinishTM 照片纸 LexmarkPerfectFinish 照片纸

Lexmark 照片纸 Lexmark 照片纸
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纸张和特殊介
质

单面或
双面打
印

推荐的纸张 纸张类型设置为

哑光手册 双面 用于低覆盖率或中等覆盖率打印作业的喷墨哑光手册纸：

• Printworks Matte Photo Paper #00471

• Paperworks Inkjet 2‑sided Matte Coated 8.5x11 32lb/120g 
60pk P/C: PPPJJ32‑2

用于较高覆盖率打印作业的喷墨哑光手册纸：

• Paperworks Inkjet 2‑sided Matte Coated 8.5x11 44lb/165g 
60pk P/C: PPPJJ44

喷墨哑光手册

光面手册 • Red River Zeppelin SemiGloss

• Paperworks Inkjet 2‑sided Semi‑Gloss P/C:PPPJJ48 and 
Manufacturer #:JANUSSM8511

喷墨光面手册

Avery 特种纸 • Avery Half‑Fold Greeting Cards for Inkjet Printers #3265

• Avery Tri‑Fold Brochures for Inkjet Printers #8324

• Avery Two‑Side Printable Clean Edge Business cards for 
Inkjet Printers #8871

名片

热转印纸 单面 Avery T‑shirt Transfers for Inkjet Printers #3271 热转印纸

清晰窗花 Micro Format, Inc., Super Color Cling #SP5676 透明胶片

透明胶片 3M Inkjet Transparency Film #CG3480 透明胶片

设置纸张尺寸和类型

您可以调整打印和复印作业的设置，使之与您在打印机中装入的纸张尺寸和类型匹配。

使用打印机操作面板

从主界面中，执行以下操作之一：

• 如果您希望设置纸张尺寸，请依次选择：

 >纸张设置 >纸张尺寸 > 选择所需的纸张尺寸 >接受

• 如果您希望设置纸张类型，请依次选择：

 >纸张设置 >纸张类型 > 选择所需的纸张类型 >接受

使用打印机软件

对于 Windows 用户

1 打开文档，单击文件 >打印。

2 单击属性、首选项、选项或设置。

3 单击纸张/完成选项卡，然后选择要使用的纸张尺寸或类型以及纸张来源或进纸匣。

4 单击确定。

对于 Macintosh（英文版）用户

1 打开文档，选择 File >Page Setup。

2 在“Page Setup”对话框中，设置打印机、纸张尺寸和打印方向。
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3 单击 OK。

4 从菜单栏中选择 File >Print。

5 从“Printer”弹出菜单中选择您的打印机。

6 从打印选项弹出菜单中选择 Quality & Media。

7 从“Paper Type”弹出菜单中选择要使用的纸张类型。

设置页面干燥时间

使用操作面板

从主界面中，依次选择：

 >打印模式设置 >页面干燥时间 > 选择干燥时间设置 >接受

注意：根据您为打印作业所选择的打印质量，干燥时间会有所不同。选择延长可以延长打印干燥时间。

使用打印机软件

对于 Windows 用户

1 单击文件 >打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

布局选项卡 > “双面打印”区域 > 选择干燥时间设置

注意：在高湿度条件下，或者如果正常干燥时间不足以让墨水完全干燥，请选择延长。

4 单击确定。

对于 Macintosh（英文版）用户

1 从苹果图标菜单中依次选择：

System Preferences >Print & Fax > 选择您的打印机

2 依次选择：

Open Print Queue >Printer Setup >Driver 选项卡

或

Printer Setup >Installable Options

3 从“Two‑Sided Printing Dry Time”弹出菜单中，选择干燥时间设置。

注意：在高湿度条件下，或者如果正常干燥时间不足以让墨水完全干燥，请选择 Extended。

4 单击 OK 或 Apply Changes。
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关联进纸匣
进纸匣关联对于大的打印作业或多份副本很有用。如果两个进纸匣加载有相同尺寸和类型的纸张，并且设置相
同，进纸匣将被自动连接起来。当一个进纸匣变空时，打印作业继续使用连接的进纸匣。

在主界面中触摸  >纸张设置 >进纸匣关联 >自动 >接受。

注意：

• 进纸匣选件可单独购买。如需更多信息，请与您购买打印机处的销售商联系。

• 安装进纸匣选件前请确认打印机已关闭。

• 默认进纸匣中的纸张类型和尺寸应该与进纸匣选件中的相匹配，以避免介质类型不匹配错误。
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打印

打印提示
• 请确保完全展开输出接纸架且反转接纸架扩展板。

• 请使用适合打印作业的合适纸张。

• 请选择高打印质量以获得更好的打印结果。

• 请确保打印墨盒中有足够的墨水。

• 在打印照片或使用特殊介质时,请在每打印完一张后即取走。

• 打印照片时，请选择无边界设置。

打印基本文档

打印文档

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 选择打印质量、打印份数、纸张类型和如何打印页面。

4 单击确定以关闭打印机软件的所有对话框。

5 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项菜单中选择打印质量、打印份数、纸张类型和如何打印页面。

7 单击 Print。
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使用高级色彩选项进行打印

彩色打印功能默认情况下已启用。为了优化特殊打印作业的打印色彩，可以使用“颜色首选项”和“高级颜
色”选项。

对于 Windows 用户

1 打开文档，单击文件 >打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

质量选项卡 > “附加颜色”区域

4 选择颜色首选项或高级颜色选项。

• 如果选择颜色首选项，接下来选择自然或逼真。

• 如果选择高级颜色选项，接下来选择使用 ICC 测试图表流程。

5 从“要使用的墨水”区域，选择下列选项之一：

• 彩色+黑色—使用包括黑色墨水在内的四种墨水。

• 仅彩色—使用青色、洋红色和黄色墨水。

6 单击确定关闭打印机软件的所有对话框。

7 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File >Print。

2 从“Printer”弹出菜单中选择您的打印机。

3 从打印选项弹出菜单中选择 Quality & Media >Advanced Options。

4 从“Ink to Use”弹出菜单中，选择下列选项之一：

• Color + Black—使用包括黑色墨水在内的四种墨水。

• Color Only—使用青色、洋红色和黄色墨水。

5 从“Color Preferences”区域中选择 Natural 或 Vivid，或选择 Use ICC Test Chart Process。

6 单击 Print。

逐份打印

当您将一份文档打印多份时，您可以选择分别打印每一份（逐份）或者按照页数一组一组地打印（不逐份）。

逐份 不逐份

注意：

• 只有当您打印多份文档时，逐份打印选项才可用。

• 当您打印照片时，为了避免出现污迹，请随时移开打印机送出的照片，等墨水完全干燥后再进行叠放。
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对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

布局选项卡 > “份数”区域

4 输入您希望打印的份数，然后选中逐份打印。

5 单击确定以关闭打印机软件的所有对话框。

6 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 在 Copies 区域中输入您希望打印的份数，然后选择 Collated。

7 单击 Print。

改变页面的打印顺序

默认情况下，打印机首先打印最后一页。

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

布局选项卡 > “份数”区域

4 选择页面顺序：

• 要先打印第一页，请取消选中先打印最后一页复选框。

• 如要先打印最后一页，请选中先打印最后一页复选框。

5 单击确定以关闭打印机软件的所有对话框。

6 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。
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4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项弹出菜单中选择 Paper Handling。

7 从 Page Order 弹出菜单中选择页面顺序：

• 如要先打印第一页，请选择 Normal。

• 如要先打印最后一页，请选择 Automatic 或 Reverse。

8 单击 Print。

将多页文档打印到一张纸上

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

布局选项卡 >页面布局区域 >选择一面多页（合并打印）

4 选择您希望在每面纸上合并打印的页面图像数。

5 根据您的需要调整其他设置。

6 单击确定以关闭打印机软件的所有对话框。

7 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项弹出菜单中选择 Layout。

7 从 Pages per Sheet 弹出菜单中选择在每一张纸上合并打印的文档页数。

8 根据您的需要调整其他设置。

9 单击 Print。
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从存储卡或闪存驱动器中打印文档

要启动“文件打印”功能，存储卡或闪存驱动器中必须包含打印机支持的文档文件。如要获取更多的信息，请
参阅第45 页“支持的存储卡和文件类型”。

1 插入存储卡或闪存驱动器。

显示屏上将会出现“存储设备”界面。

2 触摸打印文档。

3 选择您希望打印的文档，然后按 。

打印特殊文档

打印信封

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

纸张/修饰选项卡 >纸张尺寸列表 >选择您的信封尺寸。

如果没有完全符合的纸张尺寸，请单击管理自定义尺寸并设置自定义尺寸。

4 依次选择：

纸张类型列表 >选择信封

5 依次选择：

布局选项卡 >页面方向区域 >选择方向

6 单击确定以关闭打印机软件的所有对话框。

7 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择您的信封尺寸。

如果没有完全符合的信封尺寸，请选择自定义尺寸。

4 选择打印方向，然后单击 OK。

5 从菜单栏中单击 File > Print。

6 从 Printer 弹出菜单中选择您的打印机。

7 单击 Print。
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注意：

• 多数信封使用横向打印。

• 请确认您在应用程序中选择了相同的打印方向。

打印标签

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

纸张/修饰选项卡 >纸张尺寸列表 >选择您的纸张尺寸。

如果没有完全符合的纸张尺寸，请单击管理自定义尺寸并设置自定义尺寸。

4 依次选择：

“纸张类型”列表 >选择您的纸张类型

5 单击确定以关闭打印机软件的所有对话框。

6 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择您的纸张尺寸。

如果没有完全符合的纸张尺寸，请选择自定义尺寸。

4 选择打印方向，然后单击 OK。

5 从菜单栏中单击 File > Print。

6 从 Printer 弹出菜单中选择您的打印机。

7 从打印选项弹出菜单中选择 Quality & Media。

8 从 Paper Type 弹出菜单中选择 Card Stock。

9 从 Print Quality 弹出菜单中选择除 Quick Print 以外的其他打印质量。

10 单击 Print。

有关装入标签纸的提示

• 请确认标签纸的顶部首先装入打印机内。

• 请确认标签纸上的粘性部分距离纸张的边缘至少 1 毫米。

• 请确认进纸导轨紧靠标签纸的边缘。

• 请使用完整的标签纸。如果标签纸不完整（缺少部分标签），其他的标签可能会在打印过程中脱落，从而
导致卡纸。

打印 42



打印自定义尺寸的纸张

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

纸张/修饰选项卡 >管理自定义尺寸 >新建

4 输入名称并按需要调整设置，然后单击确认。

5 单击关闭，然后单击确认以关闭所有打印机软件对话框。

6 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择 Manage Custom Sizes。

4 按需要调整设置以创建自定义尺寸，然后单击 OK。

5 单击 OK。

6 从菜单栏中单击 File > Print。

7 从 Printer 弹出菜单中选择您的打印机。

8 单击 Print。

打印照片

结合存储卡或闪存驱动器使用打印机

将存储卡插入卡插槽中，或者将闪存驱动器插入 USB 接口中
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插入存储卡 插入闪存驱动器

注意：

• 插入卡，带有商标名称标签的一面朝上。

• 确保卡上的箭头朝向打印机。

• 如有必要，请将存储卡连接在随同它一起提供的适配器上。

• 确保打印机可支持插入的存储卡。如要获取更多的信息，请参阅
第45 页“支持的存储卡和文件类型”。

• 读卡器指示灯将在插入存储卡后亮起，并在读取存储卡时闪烁。

注意：

• 闪存驱动器与 PictBridge 相机电缆使用同一端
口。

• 如果您的闪存驱动器无法直接插入端口，那么
必须使用适配器。

警告—可能的损坏：从存储设备打印、读取或写入时，切勿触摸区域中所示的任何
电缆、网络适配器、连接器、存储设备或打印机。可能会发生数据损坏。

显示屏上将会出现“存储设备”界面。

注意：

• 如果打印机无法识别存储设备，那么请取出并重新插入。

• 如果在卡插槽中插有存储卡的同时向 USB 端口中插入了设置为大容量存储模式的闪存驱动器或数码相
机，那么显示屏将提示您选择要使用的存储设备。
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支持的存储卡和文件类型

内存卡 文件类型

• Secure Digital (SD)

• Secure Digital High Capacity (SDHC)

• Micro Secure Digital（需要适配器）(Micro SD)

• Mini Secure Digital（需要适配器）(Mini SD)

• MultiMedia Card (MMC)

• Reduced Size MultiMedia Card（需要适配器）(RS‑MMC)

• MultiMedia Card Mobile（需要适配器）(MMCmobile)

• Memory Stick

• Memory Stick PRO

• Memory Stick Duo（需要适配器）

• Memory Stick PRO Duo（需要适配器）

• xD‑Picture Card

• xD‑Picture Card（H 型）

• xD‑Picture Card（M 型）

文档：

• .pdf (Adobe Portable Document Format)

图像：

• .jpg、.jpeg、.jpe (Joint Photographic Experts Group)

• .tiff、.tif (Tagged Image File Format)

使用打印机操作面板打印照片

1 装入照片纸。

2 插入存储卡、闪存驱动器或设置为大容量存储器模式的数码相机。

显示屏上将会出现“Memory Device（存储设备）”界面。

3 触摸“View Photos（浏览照片）”。

“Select Photos（选择照片）”界面将会出现。

4 触摸您希望打印的照片。

提示：

• 如果您希望清除所选的照片，请再次触摸照片。

• 如果您希望查看更多的照片，请触摸左箭头或右箭头，然后触摸并选择照片。

5 当您选择完您希望打印的照片之后，请触摸“Layout（版面）”。

6 如果您希望改变打印设置，请触摸“Change Settings（改变设置）”。

如有必要，请在选择完每一项之后触摸“Accept（接受）”。

7 按  按钮。

注意：要获得最佳效果，请将打印页单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储
存。
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从 PictBridge 兼容数码相机中打印照片

大部分数码相机都支持 PictBridge 技术，可以允许您直接从您的数码相机中打印照片，无需连接计算机。

1 将 USB 电缆的一端连接在数码相机上。

注意：请只使用随同数码相机一起提供的 USB 电缆。

2 将 USB 电缆的另一端插入打印机前面的 PictBridge 接口中。

注意：

• 请确认数码相机被设置为正确的 USB 模式。如果不正确，数码相机可能会被检测为一个闪存驱动
器，或者打印机操作面板显示屏上可能会出现错误信息。请参阅数码相机说明文档获取更多的信息。

• 打印机每次只能读取一种存储设备。

警告—可能的损坏：当正在从 PictBridge 兼容数码相机中打印时，请不要触摸任
何电缆、任何网络适配器、任何接口、存储设备或图中所示的打印机区域，否则
可能会发生数据丢失。

3 如果 PictBridge 连接成功，打印机显示屏上将会出现信息“Camera Connected. Use Camera to 
choose and print photos.（数码相机已连接。请使用数码相机选择并打印照片。）”。

4 如果您希望改变默认的打印设置：

a 触摸“More Options（更多的选项）”进入“PictBridge”菜单。

b 选择您希望打印的照片的纸张来源、纸张尺寸、纸张类型、照片尺寸、质量和版面。选择完每一项之后
请触摸“Accept（接受）”。

注意：打印机将会使用默认的打印设置，除非您在数码相机上改变了打印设置。

5 请参阅数码相机说明文档开始打印。

注意：当打印机正在打印其他作业时，如果您连接了数码相机，请等待作业完成，然后再从数码相机中进行
打印。
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在纸张的双面进行打印（双面打印）

自动在纸张的双面进行打印

自动打印部件支持 A4、A5、letter、legal、statement 和 executive 尺寸的纸张。

注意：

• 其他纸张可能不受支持。

• 打印停止前请不要取出打印页。

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

布局选项卡 >双面打印区域 >选择在双面打印

4 单击确定以关闭打印机软件的所有对话框。

5 单击确定或打印。

要返回单面打印，请重复步骤 1 和步骤 2，然后依次浏览至：

布局选项卡 >双面打印区域 >选择在单面打印

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项弹出菜单中选择 Quality & Media。

7 从 Paper Type 弹出菜单中选择 Plain Paper。

8 从打印选项弹出菜单中选择 Layout。

9 从 Two‑Sided 弹出菜单中选择 Long‑Edge binding 或 Short‑Edge binding。
• 如果选择了 Long‑Edge binding，页面将会沿着长边打印（纵向打印沿着左边，横向打印沿着顶边）。

纵向 横向

• 如果选择了 Short‑Edge binding，页面将会沿着短边打印（横向打印沿着左边，纵向打印沿着顶边）。
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纵向 横向

10 单击 Print。

设置双面打印干燥时间

使用操作面板

从主界面中，依次选择：

 >打印模式设置 >页面干燥时间 > 选择干燥时间设置 >接受

注意：根据您为打印作业所选择的打印质量，干燥时间会有所不同。触摸延长可延长打印件的干燥时间。

使用打印机软件

对于 Windows 用户

1 单击文件 >打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

布局选项卡 > “双面打印”区域 > 选择干燥时间设置

注意：在高湿度条件下，或者如果正常干燥时间不足以让墨水完全干燥，请选择延长。

4 单击确定。

对于 Macintosh（英文版）用户

1 从苹果图标菜单中依次选择：

System Preferences >Print & Fax > 选择您的打印机

2 依次选择：

Open Print Queue >Printer Setup >Driver 选项卡

或

Printer Setup >Installable Options

3 从“Two‑Sided Printing Dry Time”弹出菜单中，选择干燥时间设置。

注意：在高湿度条件下，或者如果正常干燥时间不足以让墨水完全干燥，请选择 Extended。

4 单击 OK 或 Apply Changes。
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管理打印作业

查找打印机的打印队列

打印队列代表连接到您的计算机上的打印机。打印队列名称通常是安装或添加打印机时分配的打印机型号或打
印机别名。

注意： 根据打印机连接到计算机的方式（USB、以太网或无线），列表中可能会显示数个打印队列。确保
您知道打印机连接到计算机的方式以便选择正确的打印队列。

对于 Windows 用户

1 打开打印机文件夹。

a 单击 ，或单击开始，然后单击运行。

b 在“开始搜索”或“运行”框中输入控制打印机。

c 按输入键，或者单击确定。

2 为您的打印机查找打印对列（网络或 USB）。

3 如果列表中没有该打印队列，那么请创建新的打印队列。

对于 Macintosh（英文版）用户

1 从 Apple 菜单依次选择：

System Preferences > Print & Fax >选择您的打印机打印序列

2 如果列表中没有该打印队列，那么请创建新的打印队列。

创建打印队列

对于 Windows 用户

1 从“打印机任务”区域中单击添加打印机。

2 按照计算机屏幕上的指示进行操作。

请参阅您的操作系统的帮助文档获取更多的信息。

对于 Macintosh（英文版）用户

1 在“Print & Fax”区域中单击+。

2 按照需要单击 Default 或 Default Browser 选项卡。

3 从列表中选择打印机。

注意：连接到网络的打印机或通过 USB 连接线连接的本地打印机可能拥有相同的默认打印机名称。如果
必要，请使用“Name”字段来重新命名打印机。

4 单击 Add。
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将您的打印机设置为默认打印机

当您发送打印作业时，您的打印机应该在“打印”对话框中自动被选中。如果您必须手动选择您的打印机，说
明您的打印机不是默认打印机。

如要设置默认打印机：

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后单击“设为默认打印机”。

Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

System Preferences > Print & Fax

2 从 Default Printer 弹出菜单中选择打印机，或者选择打印机，然后单击 Make Default。

改变默认打印模式

如要节省墨水，您可以为所有打印作业将默认打印模式改变为“草稿”或“高速”。此模式可以使用较少的墨
水，建议用于打印纯文本文档。如果您要打印照片或其他高质量的文档，并且需要改变为不同的打印模式，您
可以在发送打印作业之前在“打印”对话框中选择不同的模式。

对于 Windows 用户

1 打开文档，从应用程序中单击文件 >打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

质量 选项卡 > 选择打印质量 > 确定

对于 Macintosh（英文版）用户

1 打开文档，依次选择 File > Print。

2 从 Printer 弹出菜单中选择您的打印机。

3 从打印选项弹出菜单中选择 Quality & Media。

4 从 Print Quality 弹出菜单中选择打印质量。

5 单击 OK。
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暂停打印作业

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。

5 暂停打印作业：

• 如果您希望暂停特定的打印作业，请右键单击文档名，然后单击“暂停”。

• 如果您希望暂停队列中所有的打印作业，请单击“打印机”菜单，然后选中“暂停打印”。

Macintosh（英文版）用户

1 单击 dock 上的打印机图标。

打印队列对话框将会出现。

2 暂停打印作业：

• 如果您希望暂停特定的打印作业，请选择文档名，然后单击 Hold。

• 如果您希望暂停队列中所有的打印作业，请单击 Pause Printer 或 Stop Jobs。

继续打印作业

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。

5 继续打印作业：

• 如果您希望继续特定的打印作业，请右键单击文档名，然后单击“继续”或“重新启动”。

• 如果您希望继续队列中所有的打印作业，请单击“打印机”菜单，然后取消选中“暂停打印”。

Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

System Preferences > Print & Fax > 选择您的打印机

2 单击 Open Print Queue 或 Set Up Printers。

打印队列对话框将会出现。
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3 继续打印作业：

• 如果您希望继续特定的打印作业，请选择文档名称，然后单击 Resume。

• 如果您希望继续队列中所有的打印作业，请单击 Resume Printer 或 Start Jobs。

取消打印作业

如要取消从打印机操作面板开始的打印作业，请按  按钮。如要取消从计算机开始的打印作业，请根据您的
操作系统选择操作：

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。

5 取消打印作业：

• 如果您希望取消特定的打印作业，请右键单击文档名，然后单击“取消”。

• 如果您希望取消队列中所有的打印作业，请单击“打印机 > 取消所有文档”。

Macintosh（英文版）用户

1 单击 dock 上的打印机图标。

打印队列对话框将会出现。

2 选择您希望取消的作业，然后单击 Delete。
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复印

自动文档传送器(ADF) 扫描仪玻璃

自动文档传送器(ADF)适用于多页文档。

注意：ADF 只在精选打印机型号上才可用。如果您购买的打印
机没有自动文档传送器(ADF)，请将文档或照片的原件放置在扫
描仪玻璃上。

扫描仪玻璃适用于单页的文档、较小的物体（例如明信
片或照片）、透明胶片、照片纸或较薄的介质（例如杂
志剪辑）。

复印提示
• 请确保完全展开输出接纸架且反转接纸架扩展板。

• 如果您的打印机支持双面扫描且自动文档传送器(ADF)支持原文档大小，那么请在扫描双面页面时使用 ADF。

• 如果您的打印机不支持双面扫描或自动文档传送器(ADF)不支持原文档大小，那么请在扫描双面页面时使
用扫描仪玻璃。

• 当使用 ADF 时，请调节 ADF 上的进纸导轨，使之和文档原件的宽度相同。

• 若要在复印或扫描后更轻松的取回文档，请托起 ADF 进纸匣。

• 当使用扫描仪玻璃时，请尽可能合紧扫描仪顶盖，以避免扫描的图像中出现黑边。

• 请不要在自动文档传送器内装入明信片、照片、较小的物体、透明胶片、照片纸或较薄的介质（例如杂志
剪辑）。请将这些物体放置在扫描仪玻璃上。

• 设置好要复印的文档后，请按 以开始复印。

进行复印
1 装入文档原件。

注意：在主界面中，您可以按  按钮使用默认设置复印一份文档原件。

2 从主界面中依次选择：

复印 > 更多选项 > 份数

3 输入您希望复印的份数，然后触摸“接受”。
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4 触摸“彩色”或“黑白”设置彩色或黑白复印。

5 按  按钮。

复印 ID 卡
1 从主界面中，触摸 SmartSolutions > ID 卡复印。

2 将 ID 卡正面朝下放置在扫描仪玻璃的左上角。

3 触摸“Continue(继续)”。

4 当提示您复印 ID 卡的背面时，请触摸是。

5 将 ID 卡背面朝下放置在扫描仪玻璃的左上角。

6 触摸继续开始打印。

使用 ADF 复印双面文档
根据您的打印机型号，自动文档传送器可以用单通道扫描双面文档。

1 将文档原件面朝上装入自动文档传送器。

2 调节进纸导轨。

3 从主界面中，触摸复印 > 更多的选项 > 双面复印

4 选择双面复印选项，然后触摸接受。

• 双面到单面 — 将双面文档进行单面复印。

• 双面到双面 — 进行双面复印（和文档原件一样）。

如果您想指定原文档和复印页的页面方向和布局，那么请触摸高级。

注意：

• 如果选择了 Long‑edged binding，复印页面将会沿着页面长边复印（纵向打印沿左边、横向打印沿顶
边）。

• 如果选择了 Short‑edged binding，复印页面将会沿着页面的短边复印（纵向打印沿顶边、横向打印沿
左边）。

5 按  按钮。

6 按照显示屏上的指导进行操作。

使用扫描仪玻璃复印双面文档
1 将文档原件正面朝下放置在扫描仪玻璃上。

2 从主界面中，触摸复印 > 更多的选项 > 双面复印

3 选择双面复印选项，然后触摸接受。

• 双面到单面 — 将双面文档进行单面复印。

• 双面到双面 — 进行双面复印（和文档原件一样）。

如果您想指定原文档和复印文档的页面方向和布局，那么请触摸“高级”。
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注意：

• 如果选择了 Long‑edged binding，复印页面将会沿着页面长边复印（纵向打印沿左边、横向打印沿顶
边）。

• 如果选择了 Short‑edged binding，复印页面将会沿着页面的短边复印（纵向打印沿顶边、横向打印沿
左边）。

4 按  按钮。

5 按照显示屏上的指导进行操作。

放大或缩小图像
1 装入文档原件。

2 从主界面中，触摸复印 > 更多的选项 > 缩放。

3 选择缩放设置，然后触摸接受。

注意：

• 如果您选择了“适合页面”，打印机将会适当地调整文档或照片的大小，使之适合单页纸。

• 如果您选择了“自定义百分比”，请指定缩放设置，范围是 25%-400%。

4 按  按钮。

调整复印质量
1 装入文档原件。

2 从主界面中，依次选择：

复印 >更多选项 >质量

3 设置复印质量，然后触摸接受。

4 从“复印选项”界面中，依次选择：

内容 > 选择能够描述文档原件的内容类型。 >接受

5 从“内容来源”界面中，选择能够描述文档原件生成方式的选项，然后触摸接受。

6 按 。

使复印结果较浅或者较深
1 装入文档原件。

2 从主界面触摸复印 >更多选项 >深浅。

3 使用滑动条更改深浅等级，然后触摸接受。

4 按  按钮。
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使用打印机操作面板进行逐份复印
当您将一份文档打印多份时，您可以选择分别打印每一份（逐份）或者按照页数一组一组地打印（不逐份）。

逐份 不逐份

1 装入文档原件。

2 从主界面触摸复印 >更多选项 >复印份数。

3 输入您希望复印的份数，然后触摸接受。

4 滚动到逐份，然后触摸 。

5 按  按钮。

在复印件间插入分隔页
分割页是在所选页数、复印数或作业数上所放的一张纸。该功能在打印透明胶片时非常有用。

1 装入文档原件。

2 从主界面中，触摸复印 > 更多的选项 > 分隔页。

注意：要在复印件间插入分隔页，“逐份打印”必须设置为“开”。如果“逐份打印”设置为“关”，
那么分隔页将添加到打印作业的末尾。

3 选择分隔页设置，然后触摸接受。

4 按  按钮。

将多页文档复印到一张纸上
您可以通过打印每个页面缩小后的图像，将多个页面复印在一张纸上。例如，如果您使用此设置在一张纸上打
印 4 页文档，则您可以将一份 20 页的文档减少到 5 页。

1 装入文档原件。

2 从主界面触摸复印 >更多选项 >页/面。

3 选择纸张方向和希望在一张纸上复印的页数，然后触摸接受。您最多可以在一张纸上打印 4 页图像。

4 按  按钮。

在每一页上添加背景图案信息
1 装入文档原件。

2 从主界面触摸复印 >更多选项 >背景图案。
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3 选择背景图案设置，然后触摸接受。

注意：如果您选择了“自定义文本”，那么将提示您指定自定义背景图案。文本最长为 32 个字符。

4 按  按钮。

去除复印件背景
“去除背景”功能能够调整复印件上的可见背景数量。

1 从主界面中，触摸复印 > 更多的选项 > 去除背景。

2 选择去除背景设置，然后触摸接受。

3 按  按钮。

进行双面复印

自动进行双面复印

自动双面打印部件支持 A4、A5、Letter、Legal、Statement 和 Executive 尺寸的纸张。如果要使用其他纸张
尺寸进行双面复印，请参阅手动进行双面复印的指导。

注意：您不可以在信封、卡片纸或照片纸上进行双面复印。

1 装入文档原件。

2 在主界面中触摸复印 >更多选项 >双面复印。

3 选择双面复印选项，然后触摸接受。

• 单面到双面—对单面文档进行双面复印。

• 双面到双面—进行双面复印（和文档原件一样）。

4 按 。

5 按照显示屏上的指导进行操作。

手动进行双面复印

1 装入文档原件。

2 在主界面中触摸“复印”。

3 设置需要的复印选项。如有必要，请在选择完每一项之后触摸接受。

4 按 在纸张的单面进行打印。

5 装入文档的下一页：

• 如果您要复印单面文档，那么请装入下一页。

• 如果您要复印双面文档，那么请翻转原文档并重新装入。
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6 从出纸托盘中取出纸张，然后重新装入纸张以打印文档的另外一面。

7 如果系统提示您是否使用当前设置，请触摸是。

8 按  按钮。

取消复印作业
如要取消复印作业，请按  按钮。

扫描将会停止，并且打印机返回到之前的菜单。
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扫描

自动文档传送器(ADF) 扫描仪玻璃

自动文档传送器(ADF)适用于多页文档。

注意：ADF 只在精选打印机型号上才可用。如果您购买的打印
机没有自动文档传送器(ADF)，请将文档或照片的原件放置在扫
描仪玻璃上。

扫描仪玻璃适用于单页的文档、较小的物体（例如明信
片或照片）、透明胶片、照片纸或较薄的介质（例如杂
志剪辑）。

扫描提示
• 如果您的打印机支持双面扫描且自动文档传送器(ADF)支持原文档大小，那么请在扫描双面页面时使用 ADF。

• 如果您的打印机不支持双面扫描或自动文档传送器(ADF)不支持原文档大小，那么请在扫描双面页面时使
用扫描仪玻璃。

• 当使用 ADF 时，请调节 ADF 上的进纸导轨，使之和文档原件的宽度相同。

• 若要在复印或扫描后更轻松的取回文档，请托起 ADF 进纸匣。

• 当使用扫描仪玻璃时，请尽可能合紧扫描仪顶盖，以避免扫描的图像中出现黑边。

• 请不要在自动文档传送器内装入明信片、照片、较小的物体、透明胶片、照片纸或较薄的介质（例如杂志
剪辑）。请将这些物体放置在扫描仪玻璃上。

• 设置好要扫描的文档后，请按 以开始扫描。

扫描至本地计算机
1 装入文档原件。

2 从主界面中，触摸扫描 > 计算机 > USB 连接的计算机。

USB 连接的计算机是用于接收扫描结果的默认目的地。

注意：请确保目的地计算机上装有打印机软件。

3 选择您希望创建的输出文件类型和其他扫描选项。如有必要，请在选择完每一项之后触摸接受。

4 按  按钮。

扫描完毕后，打印机操作面板显示屏上将会出现信息，您扫描的文件已经保存了。
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扫描至网络计算机
1 装入文档原件。

2 在主界面中触摸扫描 > 计算机。

3 触摸目的地计算机的名称。

注意：

• 请确保目的地计算机上装有打印机软件。

• 请确保打印机能与目的地计算机通信。

• 如果计算机要求识别码，打印机可能会提示您输入识别码。

• 如要为计算机指定计算机名和识别码，请参阅与您的操作系统相关的打印机软件帮助。

4 选择您希望创建的输出文件类型和其他扫描选项。如有必要，请在每次选择完一项之后触摸接受。

5 按  按钮。

扫描完毕后，打印机操作面板显示屏上将会出现信息，您扫描的文件已经保存了。

扫描到网络文件夹

注意：

• 此功能可能不会显示在 Embedded Web Server 中（依打印机型号而定）。

• 开始操作前，请确保您已经创建了文件夹快捷方式。如需更多信息，请参阅第60 页“添加网络文件夹
快捷方式”。

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 从主界面中，依次选择：

扫描 >网络文件夹

3 选择需要的网络共享文件夹的名称。

系统可能会提示您输入用户名和密码。

4 设置颜色、质量、图像原件大小以及其他扫描选项。如有必要，请在每次选择完一项之后按 。

5 按 。

注意：对于 Macintosh（英文版）用户，您可能需要通过 Image Capture 启用扫描到计算机功能，以便使用
网络打印机扫描文档和保存扫描输出。

添加网络文件夹快捷方式

1 在计算机上，创建一个具有读/写访问权限的共享文件夹。

2 在 Web 浏览器中，输入您的打印机 IP 地址，然后按 Enter 键。
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3 导航到以下任一选项：

• 设置 >扫描到网络文件夹设置

• 设置 >管理快捷方式 >添加新的快捷方式 >扫描到网络

4 输入必需的信息，然后单击添加。

注意：为了避免有未保存的设置更改，请确保网络文件夹的快捷方式名称不同于文件夹名称。

使用自动文档传送器扫描双面文档
根据您的打印机型号，自动文档传送器可以用单通道扫描双面文档。

1 将文档原件面朝上装入自动文档传送器。

2 调节进纸导轨。

3 在主界面中触摸扫描。

4 遵从显示屏上的指导，设置其他扫描选项。如有必要，请在每次选择完一项之后触摸接受。

注意：请确保在“扫描选项”中的 Sides 菜单中选择了双面，然后触摸接受。

5 按  按钮。

6 按照显示屏上的指导进行操作。

扫描完毕后，打印机操作面板显示屏上将会出现信息，您扫描的文件已经保存了。

扫描至闪存驱动器或存储卡
在您开始操作之前，请确认您的闪存驱动器或存储卡没有设置写保护。

1 装入文档原件。

2 从主界面中，触摸扫描 > 存储设备。

3 插入存储卡或闪存驱动器。

注意：

• 打印机每次只能读取一种存储设备。

• 如果存储卡插槽中插入了存储卡，并且您同时将闪存驱动器插入 USB 接口中，显示屏上将会出现一
条信息，提示您选择希望使用哪种存储设备。

4 选择您希望创建的输出文件类型。

5 设置颜色、质量、图像原件大小以及其他扫描选项。如有必要，请在选择完每一项之后触摸接受。

6 从“扫描选项”的“面数”菜单中，选择单面或双面，然后触摸接受。

7 按  按钮。

按照显示屏上的指导进行操作。扫描完毕后，打印机操作面板显示屏上将会出现信息，您扫描的文件已经
保存了。
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扫描照片

对于 Windows 用户

1 将照片正面朝下放置在扫描仪玻璃上。

2 单击 或开始。

3 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 >扫描 >高级扫描

5 从“扫描来源”列表中选择平板。

6 从“扫描设置”选项卡中选择合适的设置：

a 将“分辨率(dpi)”设置为 150 dpi 或更高。

b 将“颜色深度”设置为彩色。

c 将“内容类型”设置为照片。

d 从“原件类型”列表中选择对照片原件描述最佳的项目。

• 例如，如果要扫描由喷墨打印机打印的光面照片，请选择喷墨光面。

• 如果要扫描从照片冲印店购买的光面照片，请选择零售照片。

7 单击扫描，然后按照计算机屏幕上的指导进行操作。

8 扫描完成后，将照片另存为 JPEG(*.JPG)。

对于 Macintosh（英文版）用户

1 将照片正面朝下放置在扫描仪玻璃上。

2 从 Finder 的“Applications”文件夹中，启动 Image Capture。

3 从设备列表中选择您的打印机。

注意：如果设备列表中未显示您的打印机名称，则需要为打印机创建打印列队。请参阅您操作系统随附
的文档以获取更多信息。

4 按照下列步骤调整扫描设置：

a 将“Kind”设置为 Color。

b 将“Resolution”设置为 150 dpi 或更高。

c 将“Format”设置为 JPEG。

d 将“Original Type”设置为对照片原件描述最佳的项目。

• 例如，如果要扫描由喷墨打印机打印的光面照片，请选择 Inkjet Glossy Photo。

• 如果要扫描从照片冲印店购买的光面照片，请选择 Retail Glossy Photo。

5 开始扫描作业。
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直接使用打印机操作面板扫描

1 将照片正面朝下放置在扫描仪玻璃上。

注意：如果 ADF 中装有文档，再将照片放在扫描仪玻璃上，将扫描 ADF 中的文档。因此如果要对扫描
仪玻璃上的照片进行扫描，请确保清空 ADF 中的文档。

2 从打印机主界面中依次选择：

扫描 > 选择扫描目的地

必要时按照打印机显示屏上的指导进行操作。

注意：如果选择计算机作为扫描目的地，请确认目的地计算机上装有扫描软件。

3 从“选择文件类型”菜单中选择照片。

4 从“扫描选项”菜单中选择合适的设置。

选择完每一项之后，触摸接受。

a 将“质量”设置为 150 dpi 或者更高。

b 将“内容”设置为照片。

c 将“内容来源”设置为对照片原件描述最佳的选项。

• 例如，如果要扫描由喷墨打印机打印的光面照片，请选择喷墨光面。

• 如果要扫描从照片冲印店购买的光面照片，请选择零售照片。

5 按 。

扫描文档并进行编辑
光学字符识别(OCR)应用程序允许您编辑已扫描的文档原件。要使用该功能，您必须在本地或网络计算机上安
装 OCR 应用程序，并且在设置扫描时必须能从应用程序列表中选择该 OCR 应用程序。

选择扫描设置时，请选择扫描到安装有 OCR 的本地计算机或网络计算机。

对于 Windows 用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 单击 或开始。

3 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 >扫描 >文档

扫描开始，同时显示扫描进度对话框。

5 扫描完成后，请保存文档。

该文件将转换为可编辑的格式。

6 用相应的应用程序打开该文档以进行编辑。
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对于 Macintosh（英文版）用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 从“Finder”中的“Applications”文件夹中，启动您要使用的应用程序。

注意：

• 使用支持打印机并允许您使用 OCR 软件 ABBYY FineReader 的任何应用程序。

• 如果缺少 OCR 软件，请插入安装软件光盘。使用自定义安装选项重新安装打印机软件，以便您可以
手动选择列出的所有程序包。

3 从设备列表中选择您的打印机。

注意：关于查找设备列表的信息，请检查应用程序随附的文档或者在“Help”菜单的“Search”字段中
搜索 Scanning an image。

4 根据需要调整扫描设置。

注意：请使用 300 dpi 或更高的扫描分辨率。

如果适用，单击“Preview”对话框上的 了解更多信息。

5 将 OCR 软件设置为扫描目的地，然后开始扫描作业。

6 如有必要，选择您要将文件转换为的格式。

7 保存文件。

注意：根据您的设置，系统可立即在相应的应用程序中打开该文件，以便您可以开始编辑。

使用打印机软件直接扫描到电子邮件
请确认您已设置了电子邮件设置，然后再继续。如要获取更多的信息，请参阅用户手册中关于电子邮件的部
分。

对于 Windows 用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 单击 或开始。

3 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

4 依次选择：

单击打印机主页 > 选择您的打印机 > 扫描

5 选择用电子邮件发送照片、用电子邮件发送文档或用电子邮件发送 PDF。

注意：如果您的计算机上装有 OCR 应用程序，那么您仅可以选择用电子邮件发送文档。

扫描开始，并且扫描进度对话框将会出现。扫描完成后，将创建新电子邮件信息并自动添加所扫描的文档。

6 撰写电子邮件信息。

注意：如果没有自动打开您的电子邮件程序，那么可以将文档扫描到计算机，然后将其以附件形式通过电子
邮件发送。
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对于 Macintosh（英文版）用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 从 Finder 中的 Applications 文件夹中，启动您要使用的应用程序。

注意：使用任何支持打印机和电子邮件选项的应用程序（例如 Image Capture）。

3 从设备列表中选择您的打印机。

注意：关于查找设备的列表的信息，请检查应用程序随附的文档或者在 Help 菜单的 Search 字段中搜索
Scanning an image。

4 根据您的需要调整扫描设置。

如果适用，请单击 Preview 对话框上的 以获取更多信息。

5 将电子邮件应用程序设置为扫描目的地，然后开始扫描作业。

6 撰写电子邮件信息。

扫描为 PDF

对于 Windows 用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 单击 或开始。

3 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 > 扫描 > PDF

扫描开始，并且扫描进度对话框将会出现。

5 将文档保存为 PDF。

对于 Macintosh（英文版）用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 从 Finder 中的 Applications 文件夹中，启动您要使用的应用程序。

注意：使用支持打印机的任何应用程序。

3 从设备列表中选择您的打印机。

注意：关于查找设备的列表的信息，请检查应用程序随附的文档或者在 Help 菜单的 Search 字段中搜索
Scanning an image。

4 根据您的需要调整扫描设置。

如果适用，请单击 Preview 对话框上的 以获取更多信息。

5 将支持 PDF 格式的应用程序设置为扫描目的地，然后开始扫描作业。

6 将文档保存为 PDF。
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扫描常见问答

如何提高扫描件的质量？
• 确认您的文档原件状况良好。

• 确认选择合适的应用程序用于接收扫描的文档。例如，如果要扫描某张图片并进行编辑，请确认选择照片
编辑应用程序用于接收扫描件。如果要扫描某个文档并编辑其文本内容，请确认选择 OCR 应用程序。

• 使用以下任一高分辨率：

– 300 dpi（用于照片）

– 600 dpi（用于图文混排文档）

如何调整扫描件的颜色？

在扫描选项菜单中，执行以下操作：

• 选择能够描述文档原件的“内容类型”选项。

• 选择能够描述文档原件生成方式的“内容来源”或“原件类型”选项。

我如何进行黑白扫描？

所有的扫描作业默认都是彩色的。如要进行黑白扫描，请按照以下的步骤进行操作：

1 在打印机操作面板主界面中触摸“Scan（扫描）”。

2 选择扫描目的地。

3 为扫描作业选择设置。

4 在“Scan Options（扫描选项）”界面中触摸 。

为什么会要求我输入识别码？

识别码是一种安全措施，用于限制扫描的信息只发送到指定的位置，或者防止其他人看到或使用扫描的内容。
如果您要发送扫描结果的网络计算机需要识别码，打印机可能会提示您输入识别码。

如要了解如何为网络计算机指定识别码，请参阅适用于您的操作系统的打印机软件帮助。

取消扫描作业
按打印机操作面板上的  按钮，或者在计算机屏幕上单击“取消”。
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电子邮件
您可以使用打印机向一个或多个收件人发送电子邮件，无需使用计算机。如要完成此任务，您可以扫描文档或
照片，然后将其作为电子邮件发送出去，或者您也可以将存储设备中保存的文档或照片附加到电子邮件中。

您必须首先配置您打印机的电子邮件设置，然后才可以使用打印机操作面板发送电子邮件。

设置打印机的电子邮件功能

设置电子邮件功能

1 从主界面中依次选择：

 > 电子邮件设置 > 是

2 输入您的电子邮件地址，然后触摸“确定”。

打印机会将您的电子邮件地址与已知电子邮件供应商的列表进行比较。

3 按照显示屏上的提示进行操作：

• 如果您的电子邮件地址与列表中的一个域名一致，打印机将会自动指定 SMTP 服务器设置。

注意：根据您输入的电子邮件地址，打印机可能会要求您输入您的电子邮件的用户名和密码。

• 如果电子邮件域名是未知的，“高级电子邮件设置向导”将会出现在显示屏上。

输入必需的信息。触摸“确定”或“接受”保存每一项。

安装后改变电子邮件设置

如果您希望改变 SMTP 服务器设置

1 从主界面中，触摸  >电子邮件设置 >SMTP 设置。

2 触摸每一项并输入必需的信息。触摸确定或接受保存每一项。

• 服务器—输入 SMTP 服务器的名称或地址。

• 端口—输入 SMTP 端口。

• 使用 SSL/TLS—选择在发送邮件时电子邮件客户端和 SMTP 服务器如何使用加密。

• 验证—为您的电子邮件账号选择验证类型。如果您选择了“无”，打印机将不会要求您输入用户名和密
码。如要获取更多的信息，请与您的电子邮件供应商或您的系统支持人员联系。

注意：根据您在电子邮件设置过程中输入的电子邮件地址，“验证”界面可能不会出现在显示屏
上。

• 发件人姓名—输入您的姓名。

• 用户名—输入您的电子邮件地址。

• 密码—输入您的电子邮件账号密码。

• 域—输入您的电子邮件帐号域。

注意：只有当“验证”设置为“NTLM”时，此设置才出现。如要获取更多的信息，请与您的电子邮
件供应商或您的系统支持人员联系。

3 如要检查 SMTP 服务器设置是否正确，请触摸测试 SMTP 设置。
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如果您希望改变电子邮件设置

1 从主界面中，触摸  >电子邮件设置。

2 触摸每一项并输入必需的信息。如有必要，请触摸确定或接受以保存每一项。

• 回复电子邮件地址—输入您的电子邮件地址。

• 给我发送一份副本—触摸是可以为您从打印机发送的每一封电子邮件向您自己发送一份副本。

• 标题行—输入您的默认电子邮件标题。

• 信息—输入您的默认电子邮件信息。

创建电子邮件联系人列表

使用打印机操作面板创建电子邮件联系人列表

1 从主界面中依次选择：

 > 通讯簿

2 添加联系人或电子邮件群组：

• 如要添加联系人：

a 依次触摸“添加联系人 > 添加联系名称”。

b 输入联系名称，然后依次触摸“确定 > 添加电子邮件地址”。

c 输入联系人的电子邮件地址，然后依次触摸“确定 > 接受”。

d 如果您希望添加其他的记录，请重复步骤 a-c。您最多可以输入 89 个联系人。

• 如要添加电子邮件群组：

a 依次触摸“添加群组 > 添加群组名称”。

b 输入群组名称，然后触摸“确定”。

c 触摸“添加群组成员”，然后选择您希望手动添加联系人还是导入联系人：

– 通讯簿 — 从通讯簿中导入联系人。

– 历史记录 — 从电子邮件历史记录中导入联系人。

– 新建记录 — 添加新的联系人。

d 每一次您导入联系人或添加联系人之后，请触摸“接受”保存记录。

使用计算机创建电子邮件联系人列表

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 >传真 >编辑联系人列表 >从电话簿中选择

4 从“电话簿”字段中选择一个电话簿。

您可以选择任何用于存储电子邮件地址的邮件客户端电话簿。
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5 选择您希望添加的联系人，然后单击添加到列表或改变列表导入联系人。

6 单击确定。

对于 Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Printer Settings。

3 依次选择：

Contacts 选项卡 >Individuals 选项卡

4 单击 打开通讯簿。

注意：如要添加联系人，您需要从 Macintosh 电脑上的通讯簿中导入联系人。如果联系人不在 Mac 通讯
簿中，请先将联系人添加到通讯簿中，然后再导入。

5 在通讯簿中单击您希望添加的联系人，然后将它拖动到“Contacts”列表中。

如要获取更多的信息，请单击帮助或 查看有关传真软件的帮助信息。

发送电子邮件

自动文档传送器(ADF) 扫描仪玻璃

自动文档传送器(ADF)适用于多页文档。

注意：ADF 只在精选打印机型号上才可用。如果您购买的打印
机没有自动文档传送器(ADF)，请将文档或照片的原件放置在扫
描仪玻璃上。

扫描仪玻璃适用于单页的文档、较小的物体（例如明信
片或照片）、透明胶片、照片纸或较薄的介质（例如杂
志剪辑）。

电子邮件提示
• 在发送电子邮件之前，请确认您输入了您的电子邮件帐号信息并设置了 SMTP 服务器。

• 在发送电子邮件之前，请确认打印机连接在以太网络或无线网络中。

如有必要，请确认网络连接在 Internet 中，以便打印机可以和 SMTP 服务器进行通讯。如果打印机不能连
接到 Internet，请与您的系统支持人员联系。

打印机在某一时刻只支持一种可用的网络连接(以太网或无线)。
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• 向您的通讯簿中添加联系人。当发送电子邮件时，您可以直接从您的通讯簿中选择联系人，而无须重复输
入他们的电子邮件地址。

• 如果您的打印机支持双面扫描且自动文档传送器(ADF)支持原文档大小，那么请在扫描双面页面时使用 ADF。

• 如果您的打印机不支持双面扫描或自动文档传送器(ADF)不支持原文档大小，那么请在扫描双面页面时使
用扫描仪玻璃。

• 当使用 ADF 时，请调节 ADF 上的进纸导轨，使之和文档原件的宽度相同。

• 若要在复印或扫描后更轻松的取回文档，请托起 ADF 进纸匣。

• 当使用扫描仪玻璃时，请尽可能合紧扫描仪顶盖，以避免扫描的图像中出现黑边。

• 请不要在自动文档传送器内装入明信片、照片、较小的物体、透明胶片、照片纸或较薄的介质（例如杂志
剪辑）。请将这些物体放置在扫描仪玻璃上。

• 设置好要用电子邮件发送的文档后，请按 以开始扫描。

扫描文档或照片至电子邮件

1 装入文档或照片原件。

2 触摸 扫描 > 电子邮件。

3 选择您希望创建的输出文件类型。

4 触摸选项并输入或选择收件人：

• 输入电子邮件地址－手动输入电子邮件地址。

• 通讯簿－触摸 按名称排列 或 按组排列，然后选择联系人。

• 历史记录－从历史记录列表中选择姓名或电子邮件地址。

如有必要，每次选择完一项之后请触摸确定或接受。

5 如要输入其他的收件人，请触摸添加收件人，然后输入您希望添加的电子邮件地址、名称或组。

添加完每一个收件人之后请触摸接受。

注意：您最多可以向 30 个收件人发送电子邮件。

6 设置颜色、质量、图像原件大小以及其他扫描选项。如有必要，请触摸接受保存每一项。

7 如果您希望改变默认的电子邮件标题，请依次浏览至：

标题 > 输入您的标题 > 接受。

8 如果您希望改变默认的电子邮件消息，请依次浏览至：

消息 >输入您的消息 > 接受

9 按  按钮。

取消电子邮件
如要取消电子邮件，请按  按钮。
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传真
当心—可能的伤害：请不要在雷雨天气使用传真功能。在雷雨天气下，切勿对此产品进行设置，或是进
行任何电源或电缆连接，例如连接电话或电源线。

设置打印机的传真功能

方法 1：标准电话线

安装方法 1：打印机连接在专用传真线上

如要进行连接：

使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

此安装方法的提示：

• 您可以设置打印机自动接收传真（自动应答开）或手动接收传真（自动应答关）。

• 如果您希望自动接收传真（自动应答开），请设置打印机在您希望的任意数目的铃响之后应答来电。
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安装方法 2：打印机和电话答录机共用电话线

连接在同一个墙壁电话线插座上

如要进行连接：

1 使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

2 从打印机后面的  插口上去掉保护塞，然后将电话答录机连接在此插口上。

连接在不同的墙壁电话线插座上

如要进行连接：

使用一根电话线连接墙壁电话线插座和打印机后面的  插口。
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此安装方法的提示：

• 如果您的电话线上只有一个电话号码，您需要设置打印机自动接收传真（自动应答开）。

• 请设置打印机比电话答录机多 2 声铃响应答来电。例如，如果电话答录机在 4 声铃响之后应答来电，请设
置打印机在 6 声铃响之后应答来电。在这种情况下，电话答录机首先应答来电并接收您的语音来电。如果
来电是传真，打印机可以检测到线路上的传真信号并接管来电。

• 如果您申请了您的电话公司提供的特色铃声服务，请确认您为打印机设置了正确的特色铃声模式。否则，
即使您设置了打印机自动接收传真，打印机也不会接收传真。

安装方法 3：打印机和申请了语音邮件功能的电话机共用电话线

如要进行连接：

1 使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

2 从打印机后面的  插口上去掉保护塞，然后将电话机连接在此插口上。

此安装方法的提示：

• 如果您申请了特色铃声服务，此安装方法的效果最好。在这种情况下，请确认您为打印机设置了正确的特
色铃声模式。否则，即使您设置了打印机自动接收传真，打印机也不会接收传真。

• 如果您的电话线上只有一个电话号码，您需要设置打印机手动接收传真（自动应答关）。

当您接听电话并听到传真信号时，请在电话机上按*9*或手动应答码开始接收传真。

• 您也可以设置打印机自动接收传真（自动应答开），但是当您预期接收传真时，您需要禁用语音邮件服务。
如果您使用语音邮件的频率高于传真，此设置效果最好。
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方法 2：数字用户线路(DSL)

数字用户线路(DSL)将您的常规电话线分成两个通道：语音和互联网。电话和传真信号通过语音通道传输，而
互联网信号通过另一个通道传输。在这种情况下，您可以使用同一条线路实现模拟语音电话（包括传真）和数
字互联网连接。

如要使两个通道之间的干扰最小并确保高质量的连接，您需要为网络中的模拟设备（传真机、打印机、电话答
录机）安装一个 DSL 过滤器。干扰会引起电话噪音和静电、打印机传真失败和质量差、计算机的互联网连接
速度慢等问题。

如要为打印机安装一个过滤器：

1 将 DSL 过滤器的线路插口连接在墙壁插座上。

2 使用一根电话线连接打印机后面的  插口和 DSL 过滤器的电话插口。

3 如要继续使用计算机访问互联网，请将计算机连接在 DSL 过滤器的 DSL HPN 插口上。

4 如要将电话机连接在打印机上，请从打印机后面的  插口上去掉保护塞，然后将电话机连接在此插口上。
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方法 3：VoIP 电话服务

如要进行连接：

1 将电话线的一端连接在打印机后面的  插口上。

2 将电话线的另一端连接在 VoIP 适配器上标有“电话线 1”或“电话插口”的插口上。

标有“电话线 2”或“传真插口”的插口通常不能使用。如果您希望启用第二个电话插口，您可能需要向
您的 VoIP 供应商支付额外的费用。

3 从打印机后面的  插口上去掉保护塞，然后将电话机连接在此插口上。

此安装方法的提示：

• 如要确认 VoIP 适配器上的电话插口可以使用，请将一部模拟电话机连接在电话插口上，然后收听拨号音。
如果您可以听到拨号音，说明插口可以使用。

• 如果您的设备需要两个电话插口，但是您不希望支付额外的费用，请不要将打印机连接在第二个电话插口
上。您可以使用电话分线器。将电话分线器插入标有“电话线 1”或“电话插口”的插口中，然后将打印
机和电话机连接在分线器上。

请确认您使用的是电话分线器，而不是线路分线器。如要确认您使用的是正确的分线器，请将一部模拟电
话机连接在分线器上，然后收听拨号音。
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方法 4：通过电缆供应商的数字电话服务

安装方法 1：打印机直接连接在电缆调制解调器上

如果您通常将电话机连接在电缆调制解调器上，请按照此安装方法进行操作。

如要进行连接：

1 将电话线的一端连接在打印机后面的  插口上。

2 将电话线的另一端连接在电缆调制解调器上标有“电话线 1”或“电话插口”的插口上。

标有“电话线 2”或“传真插口”的插口通常不能使用。如果您希望启用第二个电话插口，您可能需要向
您的电缆供应商支付额外的费用。

3 从打印机后面的  插口上去掉保护塞，然后将电话机连接在此插口上。

此安装方法的提示：

• 如要确认电缆调制解调器上的电话插口可以使用，请将一部模拟电话机连接在电话插口上，然后收听拨号
音。如果您可以听到拨号音，说明插口可以使用。

• 如果您的设备需要两个电话插口，但是您不希望支付额外的费用，请不要将打印机连接在第二个电话插口
上。您可以使用电话分线器。将电话分线器插入标有“电话线 1”或“电话插口”的插口中，然后将打印
机和电话机连接在分线器上。

请确认您使用的是电话分线器，而不是线路分线器。如要确认您使用的是正确的分线器，请将一部模拟电
话机连接在分线器上，然后收听拨号音。
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安装方法 2：打印机连接在墙壁电话线插座上；电缆调制解调器安装在房间中的其他地方

如果您的电缆供应商启用了您的房间中的墙壁电话线插座，您不需要将您的设备连接在电缆调制解调器上，请
按照此安装方法进行操作。您的电缆电话服务来自于墙壁电话线插座。

如要进行连接：

1 使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

2 从打印机后面的  插口上去掉保护塞，然后将电话机连接在此插口上。

方法 5：不同国家或地区的特定安装

不同的国家或地区有不同的墙壁电话线插座。被大多数国家或地区所采用的标准墙壁电话线插座是 Registered 
Jack-11(RJ-11)。您需要一个 RJ‑11 插头，或者一根带有 RJ‑11 插头的电话线，以便将设备连接在 RJ‑11 墙
壁电话线插座上。

打印机后面的传真插口和随同打印机一起提供的电话线都是 RJ‑11 的。如果您所在的国家或地区使用不同类
型的插座，您可能需要使用 RJ‑11 适配器。
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将打印机连接在非 RJ‑11 墙壁电话线插座上

如要进行连接：

1 将电话线的一端连接在打印机后面的  插口上。

2 将电话线的另一端连接在 RJ‑11 适配器上，然后将适配器插入墙壁电话线插座中。

3 如果您希望将其他设备（电话机或电话答录机）连接在同一个墙壁电话线插座上，并且设备的插头不是
RJ‑11 的，请将它直接连接在墙壁电话线插座上。

注意：

• 请不要从打印机后面的  插口上去掉保护塞。

• 在您的国家或地区，打印机包装箱内可能不包含 RJ-11 适配器。

传真 78



如果其他设备（电话机或电话答录机）有 RJ-11 插头，您可以从打印机后面的  插口上去掉保护塞，然后将
设备连接在此插口上。

在使用串行连接的国家或地区连接打印机

在一些国家或地区，您需要将所有的设备连接在墙壁电话线插座上。您不能将电话机或电话答录机连接在打印

机的  插口上。这种方法称为串行连接。

澳大利亚 德国 葡萄牙

比利时 爱尔兰 西班牙

丹麦 意大利 瑞典

法国 荷兰 瑞士

芬兰 挪威 英国

警告—可能的损坏：如果您所在的国家或地区包含在列表中，请不要从打印机后面的  插口上去掉保护
塞。如要使电话线上的设备正常工作，此保护塞是必需的。
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如要进行连接：

使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

将打印机连接在墙壁电话线插座上（德国）

德国的墙壁电话线插座有两种插口。N 插口用于传真机、调制解调器和电话答录机。F 插口用于电话机。

传真 80



将打印机连接在任意的 N 插口上。

如要进行连接：

1 将电话线的一端连接在打印机后面的  插口上。

2 将电话线的另一端连接在 RJ‑11 适配器上，然后将适配器插入 N 插口中。

3 如果您希望将电话机和电话答录机连接在同一个墙壁电话线插座上，请按照图示连接设备。

输入您的使用者信息

您的使用者信息包括您的姓名或您的公司名称、您的传真号码（您的电话号码，除非您使用的是专用的传真电
话线）和当您发送传真时您传真机上的日期和时间。此信息出现在您发送的传真的页眉和页脚中。

在一些国家/地区中，没有此信息您将不能发送传真。一些传真机会阻止没有发件人信息的传真，因此请确认
您在您的打印机上输入了此信息。

设置传真页眉

1 从主界面，依次选择：

 > 传真设置 > 拨号和发送 > 传真名称

2 输入您的姓名或您的公司名称，然后触摸 。

3 触摸传真号码。

4 输入您的传真号码或电话号码，然后触摸接受。
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设置传真页脚

1 从主界面，依次选择：

 > 传真设置 > 铃声和应答 > 传真页脚

2 触摸开 > 接受。

配置传真设置
您可以使用打印机操作面板或打印机设置应用程序配置传真设置。如果您在打印机操作面板上配置了传真设
置，打印机设置应用程序将会导入这些设置。所做的改变将会在下一次运行打印机设置应用程序时生效。打印
机也会保存您在实用程序中选择的设置，除非您将打印机设置为阻止来自计算机的改变。

使用打印机操作面板配置传真设置

1 从打印机操作面板，依次选择：

 >传真设置

2 在菜单中进行选择以配置传真设置：

使用此菜单
项

您可以

传真报告 • 打印活动日志。通过活动日志，您能够查看打印机已发送和已接收的传真历史记录。

• 打印确认页或发送报告。这些报告可以帮助您了解您发送的传真是否成功。

铃声和应答 • 将打印机设置为自动或手动接收传真。开启或关闭“自动应答”。

• 调整铃声音量。

• 设置响铃次数。如果您选择自动接收传真（“自动应答”开启），设置铃响次数非常重要。

• 设置特色铃声。如果您在电话线上预订了特色铃声功能，请在此菜单中为打印机设置正确的模式。

• 启用传真转发。

• 设置手动应答码。这是您手动接收传真时要输入的代码。

• 设置您希望的的来电显示模式。一些国家或地区有多个模式。

• 将打印机设置为在打印时使接收的传真适合页面。

• 设置传真页脚。

双面传真 • 将打印机设置为在纸张的双面打印接收的传真。

拨号和发送 • 设置您的传真名称和传真号码。

• 调整拨号音量。

• 设置拨号方法、重拨时间、尝试重拨的次数、拨号前缀和传真发送速度。

• 将发送的文档转换成接收传真机可以识别的模式。否则，此类传真将失败。

• 在发送过程中启用错误修正。

阻止传真 阻止无用的传真来电。

使用传真软件配置传真设置

在您开始操作之前，请确认：

• 打印机正确地连接在电话线上。

• 打印机的电源已打开，并且已连接在计算机上。
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• 打印机没有处于“睡眠”模式。如果打印机处于“睡眠”模式，那么请按 唤醒打印机。

在 Windows 中使用传真设置向导

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 单击打印机主页 > 传真 > 设置打印机以进行传真。

“传真设置向导”将会打开。

4 运行传真设置向导。请确认您选择了正确的电话服务和连接。向导将会根据您的连接来配置最佳的传真设
置。

注意：如果您希望配置高级传真设置，那么请从“打印机主页”中，单击传真 > 配置高级传真设置。打印机
设置应用程序将会打开。

在 Macintosh 中使用打印机设置

1 在 Finder 中的 Applications 文件夹中，或在 Finder 桌面中，双击打印机文件夹。

2 双击 Printer Settings。

3 使用打印机软件配置传真设置。

若要查看关于传真软件的帮助信息，请单击帮助或 。

创建联系人列表
您可以使用打印机操作面板上的“通讯簿”或计算机中的“电话簿”创建联系人列表。如果您在打印机操作面
板上创建了联系人列表，“电话簿”将会自动将这些联系人保存为“电话簿”记录。同样，当您向“电话簿”
中添加联系人时，打印机也会自动将它们保存到打印机“通讯簿”中。

您最多可以在联系人列表中保存 89 个联系人和 10 个传真群组。

使用打印机操作面板创建联系人列表

1 从主界面，依次选择：

 >通讯簿

2 如要添加联系人：

a 依次选择：

添加联系人 >添加联系名称

b 输入联系人名称，然后触摸 。

c 触摸添加传真号码。

d 输入联系人的传真号码，然后触摸接受。

e 再次触摸接受。

f 如果您希望添加其他的记录，请重复步骤 a-e。
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3 如要添加传真群组：

a 依次选择：

添加群组 >添加群组名称

b 输入群组名称，然后触摸 。

c 触摸添加群组成员，然后选择您希望手动添加联系人还是导入联系人：

• 通讯簿—从通讯簿中导入联系人。

• 新建记录—添加新的联系人。

d 每一次您导入联系人或添加联系人之后，请触摸接受保存记录。

使用传真软件创建联系人列表

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 >传真 >编辑联系人列表

将打开打印机设置应用程序的“联系人”选项卡。

4 单击从电话簿中选择。

5 从“电话簿”字段中选择一个电话簿。

6 选择您希望添加的联系人，然后单击添加到列表或改变列表导入联系人。

注意：如要添加联系人，您需要从计算机上受传真软件支持的通讯簿中导入联系人。除了“通讯簿”这
个软件以外，您还可以使用计算机上安装的邮件客户端软件（如 Microsoft Outlook）的电话簿。

7 单击确定。

对于 Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Printer Settings。

3 单击 Contacts 选项卡。

• 如要添加联系人，请单击 Individuals 选项卡。

• 如要添加传真群组，请单击 Groups 选项卡。

4 单击 打开通讯簿。

注意：如要添加联系人，您需要从 Macintosh 电脑上的通讯簿中导入联系人。如果联系人不在 Mac 通讯
簿中，请先将联系人添加到通讯簿中，然后再导入。

5 在通讯簿中单击您希望添加的联系人，然后将它拖动到“Contacts”列表中。

如要获取更多的信息，请单击帮助或 查看有关传真软件的帮助信息。
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发送传真

自动文档传送器(ADF) 扫描仪玻璃

自动文档传送器(ADF)适用于多页文档。

注意：ADF 只在精选打印机型号上才可用。如果您购买的打印
机没有自动文档传送器(ADF)，请将文档或照片的原件放置在扫
描仪玻璃上。

扫描仪玻璃适用于单页的文档、较小的物体（例如明信
片或照片）、透明胶片、照片纸或较薄的介质（例如杂
志剪辑）。

传真发送提示
• 请确保打印机处于打开状态，且已连接到可正常使用的电话、DSL 或 VoIP 线。如果能听到拨号音，即表
示线路可正常使用。

• 请确保完全展开出纸托盘且反转托盘扩展板。

• 根据您打印机的型号，请在扫描双面页面时使用自动文档传送器(ADF)。

• 若要在复印或扫描后更轻松的取回文档，请托起 ADF 进纸匣。

• 当使用 ADF 时，请调节 ADF 的进纸导轨，使之和文档原件的宽度相同。

• 当使用扫描仪玻璃时，请尽可能合紧扫描仪顶盖，以避免扫描的图像中出现黑边。

• 请不要 在 ADF 内装入明信片、照片、较小的物体、透明胶片、照片纸或较薄的介质（例如杂志剪辑）。
请将这些物体放置在扫描仪玻璃上。

• 设置好要传真的文档后，请按  发送传真。

使用打印机操作面板发送传真

1 装入文档原件。

2 触摸传真。

3 发送传真：

将传真发送给单个收件人：

a 输入传真号码，或触摸通讯簿或历史记录以导入联系人。

b 触摸 。
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将传真发送给多个收件人（群组传真）：

a 触摸传真给多人，然后触摸添加号码。

b 输入传真号码，或触摸通讯簿或历史记录以导入联系人。重复此步骤直到您输入了所有收件人的号码。

添加完每一个收件人之后请触摸接受。

c 触摸 。

警告—可能的损坏：发送传真时，请不要触摸电缆或 和 端口。

提示：

• 您最多可以发送群组传真给 30 个收件人。

• 触摸更多选项以设置彩色或黑白传真、调整传真质量、设置文档大小、添加封面页、定时传真或查看等待
发送的传真。

使用计算机发送传真

对于 Windows 用户

1 打开文档，单击文件 >打印。

2 确保选择了具有传真功能的打印机，然后依次单击属性、首选项、选项或设置。

3 单击传真选项卡，然后确认已选择启用传真。

4 在“传真号码”字段输入接收人传真号码。

您可以手动输入或使用“电话簿”功能输入传真号码。

5 如果必要，在“拨号前缀”对话框中输入前缀。

6 选择适当的纸张尺寸和页面方向。

7 如果您希望传真中包含封面页，请选择在传真中包含封面页并输入适当的信息。

8 单击确定。

对于 Macintosh（英文版）用户

1 打开文档，选择 File >Print。

2 从“Printer”弹出菜单中选择具有传真功能的打印机。

注意：为了可以在“Print”对话框中查看传真选项，您必须为打印机使用传真驱动程序。如果列表中未
显示带传真功能的打印机，请单击 Add a printer，然后选择带传真功能的打印机。

3 输入接收人的姓名和号码。

4 单击 Fax。

传真 86



接收传真

接收传真提示

当您接收传真时：

• 请确认打印机的电源已打开，并且连接在可用的电话线、DSL 或 VoIP 线上。如果您可以听到拨号音，说
明线路可以使用。

• 如果您设置打印机手动接收传真（自动应答关），请确认铃声音量没有设置为“关”。

• 如果您设置打印机自动接收传真（自动应答开），请在打印机内装入纸张。

自动接收传真

1 请确认“自动应答”为开：

从主界面，依次选择：

 > 传真设置 > 铃声和应答 > 自动应答 > 开 > 接受

2 设置打印机应答传真来电之前的响铃数目：

a 触摸何时应答。

b 设置响铃数目，然后触摸接受。

当检测到设定数目的铃响之后，打印机开始自动接收传真。

警告—可能的损坏：当正在接收传真时，请不要触摸电缆或 和 插口。

提示：

• 如果打印机和其他模拟设备（电话机、电话答录机）共用电话线，请将打印机设置为比电话答录机多 2 声
铃响应答来电。例如，如果电话答录机在 4 声铃响之后应答来电，请将打印机设置为在 6 声铃响之后应答
来电。在这种情况下，电话答录机首先应答来电，之后将接收您的语音来电。如果来电是传真，打印机可
以检测到线路上的传真信号并接管来电。如果打印机使用的是专用传真线路，您可以将打印机设置为在任
意数目的铃响之后应答来电。

• 如果在一条线路上有多个号码，或者如果您申请了电话公司提供的特色铃声服务，请确认您为打印机设置
了正确的铃声模式。否则，即使您设置了打印机自动接收传真，打印机也不会接收传真。

手动接收传真

1 请确认“自动应答”已禁用：

a 从主界面中依次选择：

 > 传真设置 > 铃声和应答 > 自动应答

b 如果“自动应答”没有设置为“关”，请触摸关”，然后触摸“接受”。

2 当电话铃响，并且您接听电话听筒时听到了传真信号，请按打印机上的  按钮，或者在连接在打印机上的
电话机上按*9*键。

注意：手动应答传真的默认代码为*9*，但是为了提高安全性，您可以将它改变为只有您知道的数字。您
最多可以输入 7 个字符。有效的字符包括数字 0‑-9 和以下符号：#和*。

警告—可能的损坏：当正在接收传真时，请不要触摸电缆或  和  插口。
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传真常见问答

如果我一开始跳过了传真设置，需要再次运行安装程序来设置传真吗？

您不需要再次运行安装程序。您可以通过随打印机软件一起安装的传真软件来安装和配置传真。

1 将打印机与电话线相连。如需更多信息，请参阅第 71 页“设置打印机的传真功能”。

2 使用传真软件配置传真设置。如要访问传真软件：

对于 Windows 用户

a 单击 或开始。

b 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

c 单击打印机主页 > 传真 >设置打印机以进行传真。

“传真设置向导”将会打开。

d 运行该向导。请确认您选择了正确的电话服务和连接。向导将会根据您的连接来配置最佳的传真设置。

对于 Macintosh（英文版）用户

a 在 Finder 中的 Applications 文件夹中，或在 Finder 桌面中，双击打印机文件夹。

b 双击 Printer Settings，然后配置传真设置。

什么是分线器？我应该使用什么类型的分线器？

如果您家中的墙壁电话线插座数量有限，或者您的适配器上的插口数量有限，您可以使用电话分线器。分线器
可以将电话信号分成几部分，允许您在墙壁电话线插座上连接多个设备。分线器上有两个或多个插口，您可以
将设备连接在插口上。请不要使用线路分线器。

如要确认您使用的是正确的分线器，请将一部模拟电话机连接在分线器上，然后收听拨号音。

什么是我的传真号码？

大多数情况下，您的电话号码也就是您的传真号码。如果您申请了电话公司提供的特色铃声模式检测(DRPD)
服务，则您的传真号码是您为打印机指定的号码。请确认您在传真软件或打印机操作面板的“传真设置”菜单
中为此号码输入了正确的特色铃声模式。

如果您有多条电话线，请确认您输入了打印机所连接的线路的号码。

什么是我的拨号前缀？

拨号前缀是一个数字或一系列数字，您必须先按此数字，然后才可以拨打实际的传真号码或电话号码。如果打
印机位于办公室中或者连接在专用分组交换机上，您需要按一个特定的数字，然后才可以拨打外线。如果您要
向外地发送传真，则您需要输入国家代码或地区代码。如果您需要经常向同一个国家或地区发送传真，拨号前
缀功能非常有用。当您在应用程序中设置拨号前缀后，打印机会在您拨打传真号码或电话号码时自动输入前
缀。

您最多可以输入 8 个字符作为您的拨号前缀。有效的字符包括数字 0–9 和以下符号：井号(#)和星号(*)。如果
您使用传真软件输入拨号前缀，您也可以输入以下字符：加号、减号、逗号、点和圆括号。
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我什么时候需要启用“自动应答”？

“自动应答”默认被设置为“开”，可以让打印机自动接收传真。

如果打印机与电话答录机连接在同一条电话线上，则您必须启用“自动应答”，以便您可以同时接收您的语音
来电和传真。请确认设置电话答录机在较少数目的铃响（与打印机设置相比）之后应答来电。这样可以让其他
设备首先应答语音来电。如果来电是传真，打印机可以在线路上检测到传真信号并应答来电。

我应该设置多少声铃响？

如果打印机和电话答录机共用电话线路，请设置打印机在较多数目的铃响之后应答来电。例如，如果电话答录
机在 4 声铃响之后应答来电，请设置打印机在 6 声铃响之后应答来电。在这种情况下，电话答录机首先应答
来电并接收您的语音来电。如果来电是传真，打印机可以检测到线路上的传真信号并接管来电。

如果打印机使用的是专用传真线路，您可以设置打印机在您希望的任意数目的铃响之后应答来电。

如何为打印机设置特色铃声？

如果您申请了电话公司提供的特色铃声模式检测(DRPD)服务，设置正确的铃声是非常重要的。此功能可以允
许您在一条电话线上拥有多个电话号码。每个电话号码有一个指定的铃声模式（全部铃响、仅一声铃响、仅两
声铃响、仅三声铃响、仅一声或两声铃响、仅一声或三声铃响、仅两声或三声铃响）。不同的铃声模式可以让
您知道拨打的是哪一个电话号码以及您应该使用哪一个设备应答来电。

将您的电话号码之一指定给打印机作为传真号码，然后设置打印机应答该号码的铃声模式。如果铃声模式设置
不正确，打印机会响铃，但是不会接收传真。

特色铃声也称为 Ident-a-Call、Smart Ring、Teen Ring、RingMaster 或 IdentaRing。

1 从主界面，依次选择：

 > 传真设置 > 铃声和应答 > 铃声模式

2 触摸打印机的正确铃声模式，然后触摸接受。

我如何检查拨号音？

拨号音可以帮助您知道电话线是否可以使用以及打印机是否正确地连接在电话线上。如果您发送和接收传真时
遇到了问题，请确认您可以在电话线上和通过打印机听到拨号音。

请确认电话线和墙壁电话线插座都可用

1 将一部模拟电话机连接在墙壁电话线插座上。

2 通过电话听筒收听拨号音。

如果您听到了拨号音，说明电话线和墙壁电话线插座可以使用。

如果您没有听到拨号音，请将模拟电话机连接在另一个墙壁电话线插座上，然后收听拨号音。如果您听到
了拨号音，说明电话线可以使用，但是第一个墙壁电话线插座不能使用。

请确认打印机正确地连接在电话线上

1 当打印机通过后面的  插口连接在电话线上时，将一部模拟电话机连接在打印机的  插口上。

2 收听拨号音。

如果您听到了拨号音，说明电话线可以使用，并且正确地连接在打印机上。
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如果您通过墙壁电话线插座和打印机都没有听到拨号音，请参阅第151 页“传真问题解答注意事项”。

如何调整打印机的扬声器音量？

收听拨号音可以检查电话线是否可以使用，并检查电缆和设备是否正确地连接在您的电话网络中。如果您设置
打印机手动接收传真，请确认您设置的铃声音量足够大，以便您能听到。

调整拨号音量

1 从主界面，依次选择：

 >传真设置 >拨号和发送 >扬声器音量

2 选择拨号音量设置，然后触摸接受。

调整铃声音量

1 从主界面，依次选择：

 >传真设置 >铃声和应答 >铃声音量

2 选择铃声音量设置，然后触摸接受。

我如何确保打印机应答传真来电，而电话答录机应答语音来电？

如要确保打印机应答传真来电，请将“自动应答”设置为“开”，然后设置打印机在较多数目的铃响之后应答
来电。例如，如果电话答录机在 4 声铃响之后应答来电，请设置打印机在 6 声铃响之后应答来电。在这种情
况下，电话答录机首先应答来电并接收您的语音来电。如果来电是传真，打印机可以检测到线路上的传真信号
并接管来电。

什么设置最适用于语音邮件服务？

如果您申请了电话公司提供的特色铃声服务，语音邮件和传真可以共用同一条电话线。此功能可以允许您在一
条电话线上拥有多个电话号码。每个电话号码有一个指定的铃声模式（全部铃响、仅一声铃响、仅两声铃响、
仅三声铃响、仅一声或两声铃响、仅一声或三声铃响、仅两声或三声铃响）。不同的铃声模式可以让您知道拨
打的是哪一个电话号码以及您应该使用哪一个设备应答来电。

如果您没有特色铃声服务，请将打印机设置为手动接收传真（自动应答关）。此设置可以允许您同时接收语音
来电和传真来电，但是，如果您更常用语音邮件的话效果最好。每次您预期接收传真时，都需要禁用语音邮
件。

我如何更改所传真文档的分辨率？

您发送的文档的分辨率或传真质量可能会影响传真的发送。接收传真机可能不支持高分辨率，导致传真失败。
可以通过“启用自动传真转换”功能来进行修正。请确认文档原件清晰无污迹。

如果您的高分辨率传真未被接收，请尝试选择较低的质量。

质量 黑白分辨率 彩色分辨率

标准 200x100 200x200

精细 200x200 200x200

超精细 300x300 200x200
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质量 黑白分辨率 彩色分辨率

极精细 300x300（中间色调） 200x200

1 从主界面，依次选择：

传真 > 更多选项 > 质量

2 选择分辨率，然后触摸接受。

我如何在预定的时间发送传真？

1 在主界面中触摸“传真”。

2 输入传真号码，或者触摸“通讯簿”导入联系人。

3 依次选择：

更多选项 > 定时传真

4 输入您希望发送传真的时间，然后触摸“接受”。

5 触摸  保存定时传真。

打印机将会在预定的时间发送传真。在预定的时间之前，请不要关闭打印机或将打印机从电话线上断开。

我如何使用电话卡发送传真？

1 从主界面，依次选择：

传真 > 更多选项 > 拨号音

您应该能够听到电话线的拨号音。

2 输入电话卡信息，当您连接到电话运营商时，请按照提示进行操作。

3 出现提示时，输入收件人的传真号码，然后触摸 。

如何知道传真已成功发送？

您可以设置打印机在每一次发送传真时打印确认页或发送报告。该报告包含传真发送的日期和时间。如果传真
作业失败，报告也将包含发生错误的原因。

1 从主界面，依次选择：

 >传真设置 >传真报告 >发送日志打印

2 选择打印报告选项：

• 如果每次发送传真后都要打印报告，请触摸全部。

• 如果您希望节省墨水且仅当传真作业失败时才打印报告，请触摸出错时打印。

3 触摸接受。

如何查看打印机的传真历史记录？

您可以在显示屏上查看打印机的传真历史记录。您也可以打印已发送和/或已接收传真的报告。

从打印机操作面板，依次选择：
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 >传真设置 >传真报告 >屏幕上的历史记录

如何在纸的双面打印传真？

1 从主界面中，触摸  >传真设置 >传真打印 >双面传真。

2 选择双面打印设置：

• 总是－总是在纸的双面打印收到的传真。

• 从不－从不在纸的双面打印收到的传真。

3 触摸接受。

我如何转发传真？

当您启用此选项后，所有您接收到的传真将会自动转发，直到您禁用此选项。

1 从主界面中依次选择：

 > 传真设置 > 铃声和应答 > 传真转发

2 选择“转发”或“打印并转发”，然后触摸“接受”。

3 输入您希望将传真转发到哪个号码，然后触摸“接受”。

如要禁用传真转发，请返回到“传真转发”菜单，然后选择“关”。

我如何阻止传真？

您可以阻止来自特定号码的传真。您也可以阻止垃圾传真和来自无法识别的发件人（没有来电号码的发件人）
的传真。如果您希望自动接收传真，但是希望过滤您接收的传真，此功能特别有用。

阻止来自特定号码的传真

1 从主界面中依次选择：

 > 传真设置 > 阻止传真 > 打开／关闭 > 开 > 接受

2 添加要阻止的号码。

a 依次选择：

阻止传真发件人 > 添加要阻止的号码 > 添加名称

b 输入联系名称，然后触摸“确定”。

c 触摸“添加传真号码”。

d 输入联系人的传真号码，然后触摸“接受”。

e 再次触摸“接受”。

您最多可以阻止 50 个号码。

阻止来自无法识别的发件人的传真

从主界面中依次选择：

 > 传真设置 > 阻止传真 > 阻止无号码 > 开 > 接受
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能否检索失败的传真？

打印机在打印收到的传真之前，会将传真保存在打印机内存中。如果打印机在接收传真时墨水或者纸张用尽，
会在错误解决之后自动打印传真。

如果因断电未能发出或收到传真，打印机将在电源恢复后自动发送所有准备发送的传真，或打印保存在打印机
内存中的所有已收到的传真。
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网络连接

在无线网络中安装打印机

无线网络兼容性

您的打印机可能包含 IEEE 802.11b、IEEE 802.11g 或 IEEE 802.11n 无线打印服务器。您的打印机可以兼容
经过 Wi-Fi 认证的 IEEE 802.11 b/g/n 路由器。

注意：如果您的打印机带有一个 IEEE 802.11g 无线打印服务器，并且当您使用 n 路由器时出现了问题，请
向您的路由器制造商确认当前的模式设置是否兼容 g 设备，因为此设置根据不同的路由器品牌或型号而不
同。

可支持的网络安全性选项

打印机支持三种无线安全性选项：WPA／WPA2、WEP 和无安全性。

WPA2/WPA

WPA（Wi-Fi 保护访问）和 WPA2（Wi-Fi 保护访问 2）可以提供比 WEP 更强的无线网络安全性。WPA2 和
WPA 是类似的安全性类型。WPA2 使用更复杂的加密方法，比 WPA 更安全。WPA2 和 WPA 都使用一系列
字符（称为 WPA 预共享密钥或密码短语）来保护无线网络，避免遭受未经授权的访问。

WPA2 和 WPA 密码必须为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。WPA 密钥中的
ASCII 字符需要区分大小写。

无线网络中的所有设备都必须使用相同的 WPA 密钥。WPA 安全性只能用于使用接入点（无线路由器）和支
持 WPA 的网卡的 Infrastructure 网络。大多数比较新的无线网络设备也可以选择使用 WPA2 安全性。

注意：如果您的网络使用 WPA2 和 WPA 安全性，当提示您选择您的网络所使用的安全性类型时，请选择
WPA 个人。

WEP

WEP（有线等效加密）是最基本和最薄弱的无线安全性。WEP 安全性依靠一系列字符来实现，称为 WEP 密
钥。

无线网络中的所有设备都必须使用相同的 WEP 密钥。WEP 安全性可以用于 Ad hoc 网络和 Infrastructure 网
络。

有效的 WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。
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无安全性

我们不推荐您在家用无线网络中根本不使用安全性。不使用安全性意味着您的无线网络范围内的所有人都可以
使用您的网络资源—包括 Internet 访问（如果您的无线网络可以连接到 Internet）。您的无线网络的范围可能
会超出您的住所的墙壁，导致在街道上或者在您的邻居家中可以访问您的网络。

打印网络设置页

网络设置页列出了您的打印机的配置设置，包括打印机的 IP 地址和 MAC 地址。

1 装入普通纸。

2 从主界面中依次选择：

 > 网络设置 > 打印设置页

无线设置过程中所需要的信息

如要安装打印机以实现无线打印，您需要知道以下内容：

• 您的无线网络的名称，也称为 SSID（服务设置识别码）

• 是否使用了加密措施保护您的网络安全

• 安全密钥（WEP 密钥或 WPA/WPA2 预共享密钥/密码）

如要查找无线网络的 WPA/WPA2 预共享密钥/密码，请参阅随同您的接入点一起提供的帮助文档，参阅接
入点所对应的网页，或者向您的系统支持人员咨询。

如果您的接入点使用 WEP 安全性，WEP 密钥应该为：

• 10 个或 26 个十六进制字符

或者

• 5 个或 13 个 ASCII 字符

如果您的接入点使用 WPA 或 WPA2 安全性，WPA/WPA2 预共享密钥/密码应该为：

• 64 个十六进制字符

或者

• 8-63 个 ASCII 字符

注意：

• 十六进制字符包括 A–F、a–f 和 0–9。

• ASCII 字符包括字母、数字和可以在键盘上找到的符号。WPA/WPA2 预共享密钥/密码中的 ASCII 字符
需要区分大小写。

如果您的无线网络没有使用安全措施，则您不会有安全密钥。

注意：如果您不知道您的计算机所连接的网络的 SSID，请运行计算机网络适配器的无线应用程序并查找网
络名称。如果您无法找到您的网络的 SSID 或安全信息，请参阅随同接入点一起提供的帮助文档，或者与您
的系统支持人员联系。

高级无线设置过程中所需要的信息

在高级无线设置过程中，Wireless Setup Utility 不会为您检测无线网络 SSID。在手动配置无线打印机设置之
前，您必须知道以下信息：
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无线模式

检查您的无线网络类型：

Infrastructure—无线网络中的所有设备都通过接入点（无线路由器）互相通讯。

Ad Hoc—网络设备无需使用中央安全或接入点即可直接相互进行通讯。Ad hoc 模式可能只在精选打印机
型号或操作系统上可用。

注意：Infrastructure 是推荐使用的网络配置，因为该模式传输速度更快、安全选项更优且易于配置。

网络名称(SSID)
这是区分一个网络和区域中其他网络的识别名称。

频道

自动是默认选择，如果在 infrastructure 模式中配置网络，则无法进行更改。

注意：

• 如果在 ad hoc 模式中设置网络，请选择网络中其他设备正在使用的频道。ad hoc 网络中的所有设备
都必须使用相同的频道才能相互进行通讯。

• 打印机一次只能在一个无线网络中进行通讯。在 Ad hoc 无线网络中配置打印机可以避免打印机在其
他的无线网络（Ad hoc 或 Infrastructure）中工作。

验证

确定您是设置 infrastructure 还是 ad hoc，然后检查相应的验证类型。

注意：某些验证类型可能只在精选打印机型号或操作系统上可用。

无线模式 验证类型

Infrastructure • 开放模式

• 共享模式

• WPA 个人

• WPA2-个人

• WPA2‑企业

• 802.1X‑RADIUS

Ad hoc 开放模式

加密

检查您的网络中使用的加密方式。

注意：某些验证类型可能只在精选打印机型号或操作系统上可用。

验证类型 加密方式

开放模式 • None

• WEP

共享模式 WEP

WPA 个人 TKIP(临时密钥完整性协议)

WPA2-个人 • TKIP(临时密钥完整性协议)

• AES(高级加密标准)
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验证类型 加密方式

WPA2‑企业 • TKIP(临时密钥完整性协议)

• AES(高级加密标准)

802.1X‑RADIUS • None

• WEP‑动态密钥

• WEP‑静态密钥

• WPA‑TKIP

• WPA‑AES

在无线网络中安装打印机

在您开始操作之前，请确认：

• 您的无线网络已设置并且工作正常。

• 要使用的计算机连接在您希望安装打印机的同一个无线网络中。

• 您知道要连接到的无线网络的网络名称(SSID)和 WEP 或 WPA/WPA2 预共享密钥/密码。

对于 Windows 用户

1 关闭所有打开的软件应用程序。

2 插入软件和文档光盘。

如果 1 分钟之后仍然没有显示安装对话框，请手动运行光盘：

a 单击 ，或者依次单击开始和运行。

b 在“开始搜索”或“运行”对话框中，键入 D:\setup.exe，其中 D是您的光盘驱动器或 DVD 驱动
器的盘符。

c 按 Enter 键，或者单击确定。

3 单击安装，然后按照计算机屏幕上的指导进行操作。

注意：提示选择连接类型时，请选择无线连接。

对于 Macintosh（英文版）用户

1 关闭所有打开的应用程序。

2 插入软件和文档光盘。

如果 1 分钟之后安装对话框仍未出现，请单击桌面上的光盘图标。

3 双击软件安装程序包，然后按照计算机屏幕上的指导进行操作。

注意：提示选择连接类型时，请选择 Wireless connection。

在其他计算机上安装打印机

当打印机在无线网络上被设置后，它就能够被网络上的任意其他计算机无线访问。但是，您将需要在每一台将
访问它的计算机上安装打印机驱动程序。虽然您将需要在每一台计算机上运行设置软件来安装驱动程序，但不
需要再次配置打印机。
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对于 Windows 用户

1 关闭所有打开的软件程序。

2 插入软件和文档 CD。

如果安装对话在一分钟后还没有出现，请手动启动 CD：

a 单击 ，或单击开始，然后单击运行。

b 在“开始搜索”或“运行”对话中，键入 D:\setup.exe，其中 D 是 CD 或 DVD 驱动器的盘符。

c 按 Enter（回车键），或单击确定。

3 单击安装，然后按照计算机屏幕上的指导进行操作。

对于 Macintosh 用户

1 关闭所有打开的应用程序。

2 插入软件和文档 CD。

如果在一分钟之后还没有出现安装对话，请单击桌面上的 CD 图标。

3 双击软件安装程序软件包。

4 选择我的打印机已经设置。我正在新的计算机上安装它。

5 单击继续，然后按照计算机屏幕上的指导进行操作。

使用网络指示灯确定打印机状态

注意：

– 某些功能只有精选打印机型号才具备。

– 要确定您的打印机是否具有以太网或无线连接功能，请参阅打印机随附的文档或联系您的系统支持人
员。

• 对于触摸屏打印机，网络（以太网和 Wi‑Fi）指示灯只能从主界面查看。如果主界面没有显示，请按照以
下任一步骤进行操作：

– 如果有必要，请打开打印机。请确保打印机没有 处于睡眠模式。

– 请按打印机操作面板上的 。

• 对于非触摸屏打印机，请检查网络指示灯。
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指示灯 打印机状态

或者

以太网指示灯是持续绿色

打印机已经通过以太网进行连接，并且可以使用。

或者

以太网指示灯关闭

打印机已经配置了以太网连接，但无法接入网络。

或者

Wi‑Fi 指示灯关闭

• 打印机尚未配置无线网络连接，因此无法连接到无线网络。

• 打印机已经配置了 Ad hoc 连接，但是现在没有和其他的 Ad hoc 设备进行通讯。

或者

Wi‑Fi 指示灯是绿灯闪烁

• 打印机不在接入点（无线路由器）范围内。

• 打印机正在尝试与接入点进行通讯，但是接入点可能已关闭电源或者未正常工作。

• 接入点关闭了电源并重新打开，打印机正在尝试建立网络连接。

• 打印机的无线设置可能不再有效。

检查打印机使用的 SSID、WEP 密钥或 WPA/WPA2 密钥、安全类型和 IP 地址是否仍然正
确。

或者

Wi‑Fi 指示灯是持续绿色

• 打印机已经连接到无线网络，并且可以使用。

• 打印机已经通过 Ad hoc 连接到了您的计算机。

特殊的无线安装指导

以下的指导适用于北美洲以外且使用无线宽带 box 的用户。以下是一些 box 的例子：LiveBox、AliceBox、
N9UF Box、Freebox 和 Club Internet。

在您开始安装之前

• 请确认您的 box 具备无线功能，并且可以在无线网络中使用。有关配置 box 以便在无线网络中使用的更多
帮助信息，请参阅随同您的 box 一起提供的说明文档。

• 请确认您的 box 的电源已打开，并且您的计算机已打开并连接在您的无线网络中。

向您的无线网络中添加打印机

1 使用提供的安装指导在无线网络中安装您的打印机。

当提示您选择网络时，请停止操作。

2 如果您的 box 后面有一个关联／注册按钮，请在选择网络之前按此按钮。

注意：按关联／注册按钮之后，您有 5 分钟时间完成打印机的安装。

3 返回到计算机屏幕。

从显示的无线网络列表中选择您的网络，然后单击“继续”。

网络连接 99



如果您的无线网络没有显示在列表中，请：

a 连接到其他的无线网络。

对于 Windows 用户

单击“未列出的网络”。

对于 Macintosh（英文版）用户

从列表中选择 Other Wireless Network，然后单击 Continue。

b 输入有关您的无线网络的详细资料。

注意：您可以从 box 的底部、随同 box 一起提供的帮助文档或者 box 的网页获得 WEP、WPA 或
WPA2 密钥。如果您已经改变了您的无线网络的密钥，请使用您创建的密钥。

4 按照计算机屏幕上的指导完成安装。

分配静态 IP 地址

在大多数网络上，通过 DHCP 可以自动分配 IP 地址给打印机。

1 完成无线或以太网设置，允许打印机从网络上的 DHCP 服务器接收 DHCP 地址。

2 打印网络设置页来查看当前分配给打印机的 IP 地址。

3 打开 Web 浏览器，然后在地址字段中键入打印机 IP 地址。按 Enter（回车键）。

注意：如果您正在使用代理服务器，请临时禁用它以便正确加载 Embedded Web Server。

4 单击设置 >网络/端口 >TCP/IP >设置静态 IP 地址。

5 在“地址”字段中，键入您要分配给打印机的 IP 地址，然后单击提交。

如需检验，请在 Web 浏览器地址字段中键入静态 IP 地址，然后按 Enter（回车键）。

如需更多信息，请与系统支持人员联系。

安装后更改无线设置

如要更改打印机的无线设置（例如配置的网络和安全密钥），请进行以下操作：

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 选择您的打印机，然后浏览至：

打印机主页 > 设置 > wireless setup utility

4 按照计算机屏幕上的指导进行操作。

对于 Macintosh（英文版）用户

1 从 Finder 的 Applications 文件夹或 Finder 桌面上双击打印机文件夹。

2 双击 Wireless Setup Assistant。

3 按照计算机屏幕上的指导进行操作。
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高级无线设置

向现有的 Ad hoc 无线网络中添加打印机

在您开始操作之前，请确认：

• 您的无线网络适配器已正确连接到您的计算机并且正在运行。

• 打印机将要连接到的 ad hoc 无线网络可用。有关创建 ad hoc 无线网络的更多信息，请参阅操作系统附带
的帮助文档。

注意：

• 我们推荐您使用接入点安装您的无线网络。安装的此网络称为 Infrastructure 网络。

• 如果您的计算机有 My WiFi 或 Wi‑Fi Direct，您可以创建到您无线打印机的直接连接。如需更多信息，请
参阅计算机随附的文档。

• 打印机一次只能在一个无线网络中进行通讯。在 Ad hoc 无线网络中配置打印机会将打印机从所有其他配
置过的无线网络（Ad hoc 或 Infrastructure）中删除。

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 选择您的打印机，然后浏览至：

打印机主页 > 设置 > wireless setup utility

4 按照计算机屏幕上的指导进行操作。

注意：Windows Vista 计算机重新启动之后，您可能需要将其重新连接到 Ad hoc 网络中。

对于 Macintosh（英文版）用户

1 从 Finder 的 Applications 文件夹或 Finder 桌面上双击打印机文件夹。

2 双击 Wireless Setup Assistant。

3 按照计算机屏幕上的指导进行操作。

手动配置 Wi‑Fi Protected Setup
注意：请确认您的接入点（无线路由器）是 Wi‑Fi Protected Setup (WPS)认证的。如要获取更多信息，请参
阅《用户手册》。

如果您的打印机或设备还没有配置无线连接而您希望使用 WPS 进行配置，那么请按无线路由器上的 WPS 按
钮。等待打印机操作面板上显示消息以开始 WPS 配置。显示消息之前可能会有短暂的延迟。如果 30 秒钟之
后什么也没有发生，请按照以下的一个步骤进行操作：

使用“按钮配置(PBC)”方法

1 从打印机操作面板，依次选择：

 >网络设置 >无线网络 >Wi-Fi Protected Setup >按钮方法

2 按照打印机显示屏上的指导进行操作。
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使用“个人识别码(PIN)”方法

1 从打印机操作面板，依次选择：

 >网络设置 >无线网络 >Wi-Fi Protected Setup >PIN 方法

2 按照打印机显示屏上的指导进行操作。

配置安全性

简单的无线网络需要 WEP 密钥或 WPA/WPA2 预共享密钥/密码，或者可能根本没有任何安全性。更高级的无
线网络安全可能需要一个或多个证书和验证服务器。如果网络需要证书而您没有证书，请填写 Wireless Setup 
Utility 中提供的证书申请表单，然后按照您的组织程序申请用于网络访问的证书。

以下是受支持的无线网络安全类型列表及其要求：

WEP
• WEP 密钥（最多可能需要 4 个密钥）

• 默认 WEP 传输密钥（如果配置了多个 WEP 密钥，这将指定要使用哪一个密钥）

WPA 个人、WPA2‑个人或 WPA2‑企业

• 预共享密钥

• 加密（AES 或 TKIP）

EAP‑MD5、MSCHAPv2 或 LEAP
• RADIUS 用户名

• RADIUS 密码

PEAP
• RADIUS 用户名

• RADIUS 密码

• CA 证书

EAP‑TLS
• RADIUS 用户名

• CA 证书

• 签名证书

EAP‑TTLS
• 适当的内部验证

• RADIUS 用户名

• RADIUS 密码

• CA 证书
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配置 802.1X 验证

要完成的信息取决于您选择的 802.1X 安全机制。其中一些要求用户名、密码和/或证书。如果您的网络包含多
个使用不同验证模式的访问点，那么您可以选择并配置多个验证机制。

1 从“配置 802.1X 验证”对话，选择一个验证机制。

如果您已经选择 执行

EAP‑MD5、 LEAP 或 
MSCHAPv2

继续下一步。

PEAP 或 EAP‑TTLS 单击安装 CA 证书，然后键入到 CA 证书的路径，或者单击浏览来找到证书文件。

EAP‑TLS a 单击安装签名证书，然后键入到签名证书的路径，或者单击浏览来找到证书文件。

b 单击安装 CA 证书，然后键入到 CA 证书的路径，或者单击浏览来找到证书文件。

2 键入验证服务器要求的必需信息。

3 单击确定，然后按照计算机屏幕上的指导进行操作。

在以太网络中安装打印机

在以太网络上设置打印机所需要的信息

在您开始之前，请确认您有以下信息：

• 供打印机使用的有效、唯一的 IP 地址

• 网络的网关

• 将被使用的打印机所在网络的网络掩码

• 打印机所在域的名称

• 打印机的主机名

• 网络验证所要求的任何安全信息

注意：请确认您有以太网电缆来将打印机连接到网络和可用端口（在网络设备或墙壁插孔上），将打印机物
理连接到网络。

在以太网络上安装打印机

当您在以太网络上安装打印机之前，请确认：

• 您已经完成了打印机的初始设置。

• 您的网络已设置并且工作正常。

• 您的计算机连接在您的网络上。

对于 Windows 用户

1 关闭所有打开的软件程序。

2 插入软件和文档 CD。
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如果安装对话在一分钟后还没有出现，请手动启动 CD：

a 单击 ，或单击开始，然后单击运行。

b 在“开始搜索”或“运行”对话中，键入 D:\setup.exe，其中 D 是 CD 或 DVD 驱动器的盘符。

c 按 Enter（回车键），或单击确定。

3 单击安装，然后按照计算机屏幕上的指导进行操作。

注意：当提示选择连接类型时，请选择以太网连接。

对于 Macintosh 用户

1 关闭所有打开的应用程序。

2 插入软件和文档 CD。

如果在一分钟之后还没有出现安装对话，请单击桌面上的 CD 图标。

3 双击软件安装程序软件包。

4 按照计算机屏幕上的指导进行操作。

注意：当提示选择连接类型时，请选择以太网连接。

执行网络管理任务

在 USB、以太网和无线连接之间转换（仅限于 Windows）
您可以根据您的需要改变访问您的打印机的方法。以下步骤假定您已经按照一种连接类型配置了您的打印机，
并且已经在计算机上安装了打印机驱动程序。如果您在配置过程中遇到了困难，请参阅与该连接类型相关的问
题解答主题。

注意：打印机一次支持一个可用本地(USB)连接和一个可用网络连接（以太网或无线网络）。无法将打印机
同时连接到以太网和无线网络。

以无线方式使用打印机

根据您当前对打印机的访问方式来选择相应的连接类型：

如果打印机当前为本地安装（使用 USB 连接）

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 选择您的打印机，然后浏览至：

打印机主页 > 设置 > wireless setup utility

4 按照计算机屏幕上的指导进行操作。

注意：在无线配置过程中，您不需要断开连接打印机和计算机的 USB 电缆。
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如果打印机当前为以太网设置

1 从打印机上断开以太网电缆。

2 将打印机放置在您希望用于配置打印机以实现无线访问的计算机附近。

注意：您需要使用一根 USB 电缆将打印机连接在计算机上。请确认打印机距离计算机足够近，以便您的
USB 电缆两端都可以连接。

3 单击 或开始。

4 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

5 选择您的打印机，然后浏览至：

打印机主页 > 设置 > wireless setup utility

6 按照计算机屏幕上的指导进行操作。

在本地使用打印机(USB)

根据您当前对打印机的访问方式来选择相应的连接类型：

如果打印机当前为以太网设置

1 使用 USB 电缆连接计算机和打印机。

2 稍等片刻，等待 Windows 找到驱动程序并完成安装打印机。

3 选择 USB 打印机。请参阅第106 页“选择打印机”。

如果打印机当前为无线安装

1 使用 USB 电缆连接计算机和打印机。

2 稍等片刻，等待 Windows 找到驱动程序并完成安装打印机。

3 选择 USB 打印机。请参阅第106 页“选择打印机”。

注意：您可以通过以太网或无线连接继续使用打印机。

通过以太网络使用打印机

根据您当前对打印机的访问方式来选择相应的连接类型：

如果打印机当前为无线安装

1 将以太网电缆的一端连接在打印机上，另一端连接在转换器或墙壁电话线插座的可用插口上。

2 稍等片刻，等待以太网络适配器可用并且从网络获取一个 IP 地址。

3 选择网络打印机。请参阅第106 页“选择打印机”。

注意：当打印机连接到以太网络中以后，无线适配器将会断开。

如果打印机当前为本地安装（使用 USB 连接）

1 将以太网电缆的一端连接在打印机上，另一端连接在转换器或墙壁电话线插座的可用插口上。

2 在您希望用于配置打印机的计算机中插入软件和文档光盘。
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3 按照计算机屏幕上的指导在以太网络中配置打印机。

4 选择网络打印机。请参阅第106 页“选择打印机”。

注意：您需要一根 USB 电缆来完成配置。

选择打印机

1 打开打印机文件夹。

a 单击 或开始。

b 在“开始搜索”或“运行”框中输入控制打印机。

c 按 Enter 键，或者单击确定。

2 右键单击您希望使用的打印机（网络或 USB）。

3 从菜单中选择设为默认打印机。

4 关闭“打印机”或“打印机和传真”窗口。

在 USB、以太网和无线连接之间切换（仅限于 Macintosh 英文版）

您可以根据需要改变访问打印机的方法。以下步骤假定您已经按照一种连接类型配置了打印机，并且计算机上
安装了打印机驱动程序。如果您在配置过程中遇到了困难，请参阅与具体连接类型的疑难解答相关的主题。

注意：打印机一次可支持一个活动的本地连接(USB)和一个活动的网络连接（以太网或无线网络）。无法同
时连接以太网和无线网络。

以无线方式使用打印机

根据您当前对打印机的访问方式选择相应的连接类型：

如果打印机当前为本地设置（使用 USB 连接）

1 关闭所有打开的应用程序。

2 插入软件和文档光盘。

如果 1 分钟之后安装对话框仍未出现，请单击桌面上的光盘图标。

3 双击 Lexmark Extras >Lexmark Setup Assistant。

4 按照计算机屏幕上的指导进行操作。

注意：在无线配置过程中，您不需要断开连接打印机和计算机的 USB 电缆。

如果打印机当前为以太网设置

1 从打印机上拔出以太网电缆。

2 将打印机放置在要用于配置打印机以实现无线访问的计算机附近。

注意：您需要使用一根 USB 电缆将打印机连接在计算机上。请确认打印机距离计算机足够近，以便
USB 电缆两端都可以连接。

3 关闭所有打开的应用程序。

4 插入软件和文档光盘。

如果 1 分钟之后安装对话框仍未出现，请单击桌面上的光盘图标。
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5 双击 Lexmark Extras >Lexmark Setup Assistant。

6 按照计算机屏幕上的指导进行操作。

7 将会再创建一个打印队列。如果您不希望切换回通过以太网连接访问打印机，请删除以太网队列。

在本地使用打印机(USB)

根据您当前对打印机的访问方式选择相应的连接类型：

如果打印机当前为以太网设置

1 将 USB 电缆上正方形的一端牢固地插入打印机后面的 USB 接口中。

2 将 USB 电缆上长方形的一端牢固地插入计算机的 USB 接口中。

3 添加打印机（请参阅第108 页“添加打印机”）。

4 将会再创建一个打印队列。如果您不希望切换回通过以太网连接访问打印机，请删除以太网队列。

如果打印机当前为无线设置

1 使用 USB 电缆连接计算机和打印机。

2 添加打印机（请参阅第108 页“添加打印机”）。

3 将会再创建一个打印队列。如果您不希望切换回通过无线连接访问打印机，请删除无线队列。

通过以太网络使用打印机

根据您当前对打印机的访问方式选择相应的连接类型：

如果打印机当前为无线设置

1 将以太网电缆的一端连接在打印机上，另一端连接在转换器或墙壁插座的可用插口上。

2 稍等片刻，等待以太网络接口可用并从网络获取一个 IP 地址。

3 添加打印机（请参阅第108 页“添加打印机”）。

4 将会再创建一个打印队列。如果您不希望切换回通过无线网络访问打印机，请删除无线队列。

如果打印机当前为本地设置（使用 USB 连接）

1 将以太网电缆的一端连接在打印机上，另一端连接在转换器或墙壁插座的可用插口上。

2 在要用于配置打印机的计算机中插入软件和文档光盘。

3 按照计算机屏幕上的指导进行操作。

注意：您需要一根 USB 电缆来完成配置。
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添加打印机

Mac OS X 10.5 或更高版本

1 从苹果图标菜单中依次选择：

System Preferences >Print & Fax

或

System Preferences >Print & Scan

2 单击+。

3 单击 Default 或 Default Browser 选项卡，然后选择您的打印机。

4 单击 Add。

Mac OS X 10.4 或更早版本

1 从 Finder 中选择 Utilities。

2 双击 Printer Setup Utility 或 Print Center。

3 在“Printer List”对话框中，选择要使用的打印机，然后单击 Add。

4 从“Printer Browser”中选择您的打印机，然后单击 Add。

在 Windows 环境下共享打印机

1 准备好要共享打印机的计算机：

a 在所有需要进行打印的计算机上启用“文件和打印机共享”，使得这些计算机可以出现在“网上邻居”
中。请参阅 Windows 文档获取有关启用“文件和打印机共享”的指导。

b 在所有需要进行打印的计算机上安装打印机软件。

2 标识打印机：

a 在与打印机相连的计算机上，打开打印机文件夹：

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”框中输入控制打印机。

3 按 Enter 键，或者单击确定。

b 右键单击您的打印机名称。

c 单击共享或打印机属性。

d 在“共享”选项卡中选择共享这台打印机或共享为。

e 输入一个不同于其他打印机的名称，然后单击确定。

3 在远程计算机上定位打印机：

注意：远程计算机是指没有直接连接打印机的计算机。

a 打开打印机文件夹：

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”框中输入控制打印机。

3 按 Enter 键，或者单击确定。

b 右键单击您的打印机名称。
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c 单击属性或打印机属性。

d 单击端口 >添加端口 >本地端口 >新端口。

e 输入符合通用命名标准(UNC)的端口名称，包括服务器名称和指定的打印机名称第 108 页中的步骤 2。
端口名称应该为以下格式：\\服务器\打印机。

f 单击确定。

g 在“打印机端口”对话框中单击关闭。

h 请确认在“端口”选项卡中选中了新的端口，然后单击应用。

i 单击确定。

在 Macintosh（英文版）环境下共享打印机

1 在 Finder 桌面上单击 Help > Mac Help。

2 在 Search 字段中输入 sharing the printer on a network，然后按 return 键。

3 从以下选项中只选择一项：

• 与 Mac OS X 用户共享您的打印机 — 允许网络中其他使用 Mac OS X version 10.4 或更高版本的
Macintosh 计算机使用连接在您的 Macintosh 计算机上的打印机。

• 与 Windows 用户共享您的打印机 — 允许网络中的 Windows 计算机使用连接在您的 Macintosh 计算
机上的打印机。

4 按照计算机屏幕上的指导进行操作。

注意：Windows 用户可以参阅 Windows 帮助文档获取有关添加网络打印机并连接到 Macintosh 计算机的信
息。

网络常见问答

什么是 Wi‑Fi Protected Setup？
Wi‑Fi Protected Setup(WPS)是一种简单且安全的配置，可以帮助您建立无线家用网络和启用网络安全性，不
需要提前了解有关 Wi‑Fi 技术的知识。您不再需要为网络设备配置网络名称(SSID)和 WEP 或 WPA 密钥。

注意： WPS 只支持通过接入点（无线路由器）进行通讯的网络。

打印机支持以下方法连接到无线网络：

• 个人识别码(PIN) — 将打印机上的识别码输入到接入点的无线设置中。

• 按钮配置(PBC) — 在指定的一段时间内分别按打印机和接入点上的按钮。

查找以下的识别标记可以检查您的接入点是否兼容 WPS：

您可以在您的接入点的侧面、后面或顶部找到这些 WPS 徽标。
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如要获取更多有关读取无线设置和确定您的无线接入点的 WPS 兼容性的信息，请参阅随同接入点一起提供的
帮助文档，或者与您的系统支持人员联系。

在何处查找 WEP 密钥或 WPA/WPA2 预共享密钥/密码？
• 与您的系统支持人员联系。

– 安装您的网络的人员通常保存着 WEP 密钥或 WPA/WPA2 预共享密钥/密码。

– 如果您的无线网络是由您的 Internet 服务供应商(ISP)安装的，您可以从他们提供的文档中查找相关的
信息。

• 请参阅随同您的接入点（无线路由器）一起提供的帮助文档。

如果您的接入点使用默认设置，您可以在帮助文档中找到相关的信息。

• 在接入点上查看安全性设置。

1 打开 Web 浏览器，然后在地址栏中输入接入点的 IP 地址。按 Enter 键。

注意：

– 如要获取接入点的 IP 地址，请参阅随同接入点一起提供的帮助文档，或者与您的系统支持人员联
系。

– 如果您使用了代理服务器，请暂时禁用代理服务器，以便正确打开网页。

2 当出现提示时，请输入接入点的用户名和密码。

注意：WEP 或 WPA/WPA2 预共享密钥/密码与接入点的密码不同。密码允许您访问接入点设置。
WEP 密钥或 WPA/WPA2 预共享密钥/密码可以允许打印机和计算机加入到您的无线网络中。

3 查找 WEP 密钥或 WPA/WPA2 预共享密钥/密码。

什么是 SSID？

服务集标识符(SSID)是分配给无线网络的名称。网络中的所有设备必须了解无线网络的服务集标识符(SSID),
否则无法互相通信。通常，无线网络会群发服务集标识符(SSID)，以便区域中的无线设备与其进行连接。有
时，为安全起见，不会群发服务集标识符(SSID)。

如果您的无线网络没有群发服务集标识符(SSID)，那么它就无法被自动识别，从而不会在可用无线网络列表中
出现。这种情况下，您必须手动输入网络信息。

服务集标识符(SSID)最多可包含 32 个字母数字字符。字母数字字符是字母字符（字母 A 到 Z)和数字字符（数
字 0 到 9）的组合。

哪里可以找到我的 SSID？
• 查看接入点（无线路由器）的设置。

大多数接入点带有内置的网络服务器，可以使用网络浏览器访问。

• 检查您的计算机是否为您的无线网络适配器安装了相应的程序。

很多网络适配器提供了软件应用程序，可以允许您查看您的计算机的无线设置，包括您的 SSID。

如果使用这些方法不能找到您的 SSID，请与您的系统支持人员联系。

什么是网络？

网络是指一组通过电缆或无线连接在一起并互相通讯的设备，例如计算机、打印机、以太网集线器、接入点和
路由器。一个网络可以是有线的、无线的、或者同时包含有线和无线设备。
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如何找到网络所使用的安全类型？
• 与您的系统支持人员联系。

为您安装网络的人通常保存着您的无线信息。

• 请参阅随同您的接入点（无线路由器）一起提供的帮助文档。

• 检查用于访问您的无线网络的密码所用的字符。

如果你没有使用密码，请选择无或无安全性。

字符 安全类型

10 个或 26 个十六进制字符

或者

5 个或 13 个 ASCII 字符

WEP

64 个十六进制字符

或者

8-63 个 ASCII 字符

WPA 或 WPA2

注意：

– 十六进制字符包括 A–F、a–f 和 0–9。

– ASCII 字符包括字母、数字和可以在键盘上找到的符号。WPA/WPA2 预共享密钥/密码中的 ASCII 字
符需要区分大小写。

• 在接入点上查看安全性设置。

1 打开网页浏览器。在地址字段中输入接入点的 IP 地址，然后按 Enter 键。

注意：

– 如要获取接入点的 IP 地址，请参阅随同接入点一起提供的帮助文档，或者与您的系统支持人员联
系。

– 如果您使用了代理服务器，请暂时禁用代理服务器，以便正确打开网页。

2 当出现提示时，请输入接入点的用户名和密码。

注意：WEP 或 WPA/WPA2 预共享密钥/密码与接入点的密码不同。密码允许您访问接入点设置。
WEP 密钥或 WPA/WPA2 预共享密钥/密码可以允许打印机和计算机加入到您的无线网络中。

3 查找 WEP 密钥或 WPA/WPA2 预共享密钥/密码。

家用网络如何配置？

台式电脑、便携式笔记本电脑和打印机如要在网络中互相通讯，它们必须连接电缆和／或内置或安装无线网络
适配器。

您可以使用多种不同的方法安装网络。以下是四种普通范例。

注意：下面图中的打印机代表内置了内部打印服务器的打印机，可以在网络中进行通讯。

无线网络范例

方法 1：网络中同时包含有线和无线连接，可以连接到 Internet
• 所有计算机和打印机都通过具有以太网和无线功能的路由器连接在网络中。

• 一些计算机和打印机通过无线连接在路由器上，其他计算机和打印机通过有线连接。
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• 网络通过 DSL 或电缆调制解调器连接到 Internet。

方法 2：无线网络，可以连接到 Internet
• 所有计算机和打印机都通过无线接入点或无线路由器连接在网络中。

• 无线接入点通过 DSL 或电缆调制解调器将网络连接到 Internet。

方法 3：无线网络，不可以连接到 Internet
• 计算机和打印机通过无线接入点连接在网络中。

• 网络不能连接到 Internet。
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方法 4：计算机通过无线连接到打印机，不可以连接到 Internet
• 计算机直接连接到打印机，没有通过无线路由器。

• 这种配置方法称作 Ad hoc 网络。

• 网络不能连接到 Internet。

注意：大多数计算机一次只能连接到一个无线网络。如果您通过无线连接访问 Internet，当您连接到 Ad hoc
网络时，您将无法访问 Internet。

什么是 USB 电缆？

通用串行总线(USB)电缆主要用于将 USB 设备连接到主机。普通主机包括计算机和视频游戏控制台。通过 USB
端口和电缆，可以连接计算机外围设备，例如鼠标、键盘、数码照相机、个人媒体播放器、Flash 驱动器和外
部硬盘。对于大部分的外部设备来说，USB 已经成为了标准的连接方式。

为什么需要使用 USB 电缆？

通过无线网络安装打印机的时候，打印机需要暂时使用 USB 电缆连接到计算机。这个临时的连接可以用于建
立打印机的无线设置。

注意：通过 Wi‑Fi Protected Setup (WPS)连接到无线网络时不需要使用 USB 电缆。

我如何连接 USB 电缆？

将 USB 电缆连接到计算机上的 USB 端口和打印机背面的正方形插口。该连接允许您配置打印机进行网络或
本地（USB）安装。

计算机和打印机上的 USB 端口都带有 标记。

注意：出现提示之前请不要连接 USB 电缆。

1 如果打印机后面的 USB 端口粘有胶带，请将其撕掉。
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2 将 USB 电缆上正方形的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上长方形的一端牢固地插入计算机的 USB 接口中。

4 按照计算机屏幕上的指导进行操作。

Infrastructure 和 Ad hoc 网络之间有什么区别？

无线网络可以按照以下两种模式运行：Infrastructure 模式或 Ad hoc 模式

在 Infrastructure 模式下，无线网络中的所有设备都通过接入点（无线路由器）互相通讯。

在 Ad hoc 模式下，带有无线网络适配器的计算机和带有无线打印服务器的打印机直接进行通讯。

Infrastructure Ad hoc

特征

通讯 通过接入点 直接在设备之间

安全性 更多的安全选项 WEP 或无安全性

范围 取决于接入点的范围和数量 受限于网络中单个设备的范围

速度 通常较快 通常较慢

所有设备的需求

每个设备都有唯一的 IP 地址 是 是
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Infrastructure Ad hoc

模式设置为 Infrastructure 模式 Ad hoc 模式

相同的 SSID 是，包括接入点 是

相同的频道 是，包括接入点 是

我们推荐您使用安装软件光盘按照 Infrastructure 模式安装网络。Infrastructure 模式可以提供：

• 网络安全性较高

• 可靠性较高

• 性能较快

• 安装较简易

查找信号强度

信号强度可以告诉您计算机或打印机从无线网络接收的无线信号有多强。较差的信号质量可能会在配置过程中
影响连接性。

检查计算机连接性

1 从您的计算机系统任务栏中单击管理您的无线网络适配器的软件所对应的无线图标。

2 检查信号质量。

检查打印机连接性

• 从打印机打印一张网络设置页。

在“无线”区域中查找“质量”。

• 从打印机操作面板上查看信号强度。

依次选择：

 > 网络设置 > 无线网络

指示信号质量的信号条显示在网络名称旁边。

如要提高信号质量，请去除干扰源和／或将无线设备移动到距离接入点（无线路由器）比较近的地方。
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如何提高无线信号强度？

打印机无法通过网络进行通讯的常见原因是无线信号质量太差。如果因物体阻碍或扭曲了信号或者信号太弱，
将不能在接入点（无线路由器）和打印机之间传递信息。

如果您认为接入点和打印机之间的信号强度有问题，请尝试以下一种或多种方法：

注意：

• 以下解决方案都用于 Infrastructure 网络。如果您使用的是 Ad hoc 网络，请在解决方案建议调整接入点
时对计算机进行调整。

• Ad hoc 网络范围比 Infrastructure 网络范围小。如果打印机和计算机出现通讯问题，请将打印机移到距
离计算机较近的地方。

检查无线信号质量

如要确定打印机是否能从接入点接收到较强的信号，请打印网络设置页。“质量”字段表示打印机接收到的
无线信号的相对强度。信号强度的落差可能是间歇性的，尽管目前信号质量显示信号很强，某些情况下信号
也可能会减弱。如果列出的信号质量是好或者很好，说明导致此问题的是其他因素。

如要获取更多有关打印网络设置页的帮助信息，请参阅用户手册。

将打印机移到距离接入点较近的地方

如果打印机距离接入点太远，将无法与网络中的其他设备通讯。对于大多数室内无线网络而言，接入点和打
印机之间的最大距离大约是 100 英尺（30 米）。根据网络布局和接入点的限制，该距离可能更长或更短。

清除接入点和打印机之间的障碍物

来自接入点的无线信号可穿过大多数物体。大多数的墙壁、地板、家具和其他物体都不会阻碍无线信号。但
是，有些材料密度太大会导致信号无法穿过，例如含有金属和混凝土结构的物体。安排您的打印机和接入
点，以便信号不受此类物体阻碍。

清除干扰源

其他类型的无线电频率可能导致您网络上的无线信号出现问题，从而导致反复出现打印问题。

• 关闭可能存在的潜在干扰源。

• 在通过无线网络进行打印时，避免使用微波炉、无线电话（不包含手机）、婴儿监视器、几乎所有的厨
房用具、无线监视设备、或者任何包含发动机的设备。

• 如果附近有其他无线网络正在运行，请更改接入点的无线通道。

• 请不要将接入点放置在打印机或其他电子设备上。这类设备也可能干扰无线信号。

排列网络以降低信号吸收

虽然无线信号能够穿过物体，但强度会稍微减弱。如果信号穿过太多物体，信号可能明显减弱。当无线信号
穿过物体时，所有物体都会吸收部分无线信号，并且某些类型的物体所吸收的无线信号量会导致通讯问题出
现。将接入点放在房间内尽可能高的位置以避免信号吸收。

网络连接 116



如何确保计算机和打印机连接到同一无线网络？

如果打印机和计算机不在同一个无线网络中，您将不能进行无线打印。如果计算机已经连接在无线网络中，打
印机的 SSID 必须与计算机的 SSID 一致。

对于 Windows 用户

1 获取计算机所连接的网络的 SSID：

a 在 Web 浏览器的地址栏中输入您的接入点（无线路由器）的 IP 地址。

如果您不知道接入点的 IP 地址，请按照以下的步骤进行操作：

1 单击 ，或者依次单击开始和运行。

2 在“开始搜索”或“运行”对话框中输入 cmd。

3 按 Enter 键，或者单击确定。

4 输入 ipconfig，然后按 Enter 键。查看“Wireless Network Connection”部分：

• “Default Gateway”项目通常即为接入点。

• IP 地址由 4 组数字组成，用点分隔，例如 192.168.2.134。

b 当出现提示时，输入您的用户名和密码。

c 单击确定。

d 在“Wireless settings”（无线设置）部分查找 SSID。

e 记录该 SSID。

注意：请确认您准确记录了所有内容，包括任何大写字母。

2 获取打印机所连接的网络的 SSID：

a 使用打印机打印一张网络设置页。

b 在“无线”部分查找 SSID。

3 比较计算机和打印机的 SSID。

如果 SSID 相同，说明计算机和打印机连接在同一个无线网络中。

如果 SSID 不相同，请重新运行实用程序，在计算机所使用的无线网络中安装打印机。

对于使用 AirPort 基站的 Macintosh（英文版）用户

在 Mac OS X 10.5 或更高版本中

1 从苹果图标菜单中依次选择：

System Preferences >Network >AirPort

或

System Preferences >Network >Wi‑Fi

计算机所连接的网络的 SSID 将会显示在“Network Name”菜单中。

2 记录该 SSID。
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在 Mac OS X 10.4 或更早版本中

1 从 Finder 中依次选择：

Applications >Internet Connect >AirPort

计算机所连接的网络的 SSID 将会显示在“Network”菜单中。

2 记录该 SSID。

对于使用接入点的 Macintosh（英文版）用户

1 在您的 Web 浏览器的地址栏中输入接入点的 IP 地址，然后继续进行步骤 2。

如果您不知道接入点的 IP 地址，请按照以下的步骤进行操作：

a 从苹果图标菜单中依次选择：

System Preferences >Network >AirPort
或

System Preferences >Network >Wi‑Fi

b 单击 Advanced 或 Configure。

c 单击 TCP/IP。
“Router”项目通常即为接入点。

2 当出现提示时，请输入您的用户名和密码，然后单击 OK。

3 在“Wireless settings”（无线设置）部分查找 SSID。

4 记录下 SSID、安全类型和 WEP 密钥或 WPA/WPA2 预共享密钥/密码（如果显示）。

注意：

• 请确认您准确地记录了网络信息，包括任何大写字母。

• 将 SSID 和 WEP 密钥或 WPA/WPA2 共享密钥保存在安全的地方，以备将来查阅。

我可以同时通过 USB 连接和网络连接使用我的打印机吗？

是，打印机支持同时使用 USB 连接和网络连接。打印机可以按照以下方法进行配置：

• 本地连接（使用 USB 电缆连接在计算机上）

• 无线网络

• 以太网络

• 同时使用无线网络和本地连接

• 同时使用以太网络和本地连接

什么是 MAC 地址？

媒体访问控制(MAC)地址是与网络设备的硬件相关联的一个 48 位标识符。MAC 地址也称为物理地址，因为它
与设备的硬件有关，而与软件无关。MAC 地址使用十六进制数字显示，格式为：01-23-45-67-89-AB。

虽然可以改变网络设备的 MAC 地址，但是通常不这样做。因此，MAC 地址被认为是固定不变的。IP 地址很
容易改变，因此 MAC 地址是识别网络中特定设备的更可靠的方法。

带有安全功能的路由器可以过滤网络中的 MAC 地址。此功能可以只允许指定的设备访问网络，由它们的 MAC
地址识别，也可以阻止来自不必要的设备的访问。如果您的网络使用了 MAC 地址过滤，请确认将打印机的
MAC 地址添加到允许设备列表中。
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我如何查找 MAC 地址？

网络设备都有一个唯一的硬件识别码，用于和网络中的其他设备区分开。这称为 MAC（媒体访问控制）地址。
其他设备有时使用一种称为统一管理地址(UAA)的 MAC 地址。

当您在网络中安装打印机时，请确认您选择了带有正确 MAC 地址的打印机。

内部打印服务器的 MAC 地址是一系列字母和数字。

注意：

• 您可以在接入点（无线路由器）上设置一个 MAC 地址列表，只允许 MAC 地址相符的设备使用网络。这
称为 MAC 过滤。如果您在您的接入点上启用了 MAC 过滤功能，并且希望将一台打印机添加到网络中，
打印机的 MAC 地址必须包含在 MAC 地址列表中。

• 如果您使用 AirPort 基站，MAC 地址可能称为 AirPort ID，MAC 地址过滤可以通过 MAC 地址访问控制
来实现。

什么是 IP 地址？

IP 地址是设备（如无线打印机、计算机或接入点即无线路由器）在 IP 网络上用来查找其他设备并与其进行通
讯所使用的唯一编号。只有当 IP 网络上的设备具有唯一且有效的 IP 地址时，它们才可以互相进行通讯。一个
唯一的 IP 地址是指在同一网络上没有两个设备具有相同的 IP 地址。

IP 地址是由四组数字组成，用点分隔。IP 地址示例：123.123.123.123。

什么是 TCP/IP？
当计算机、打印机和其他设备能够通过电缆或无线信号互相发送数据时，即表示网络开始工作了。使数据传输
成为可能的数据传输规则集合称为协议。协议可以被想象成带有规则的语言，以便参与者可以有效地相互沟
通。

不同类型的网络使用不同的协议，但是传输控制协议/互联网协议(TCP/IP)是最普遍的。TCP/IP 用于通过互联
网以及大部分公司和家用网络发送数据。
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使用 TCP/IP 的网络中的每台设备都必须具有 IP 地址。IP 地址是计算机的关键的、唯一的数字格式名称，用
于在网络上传输数据。IP 地址允许 TCP/IP 确认网络中各种设备请求和接收数据。

如何查找 IP 地址？

对于 Windows 用户

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”对话框中输入 cmd。

3 按 Enter 键，或者单击确定。

4 输入 ipconfig，然后按 Enter 键。

IP 地址由 4 组数字组成，用点分隔，例如 192.168.0.100。

对于 Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

About This Mac >More Info

2 在 Contents 区域中选择 Network。

3 如果您是通过无线网络进行连接的，请从 Active Services 列表中选择 AirPort。

查找打印机的 IP 地址

• 从打印机打印网络设置页。

在 TCP/IP 区域中查找 Address。

• 查看打印机设置。

1 从打印机操作面板，依次选择：

 >网络设置 >TCP/IP >IPv4

2 查找 IP Address。

IP 地址是如何指定的？

IP 地址可能由网络使用动态主机分配协议(DHCP)自动指定。当打印机在计算机上安装完毕后，计算机将会把
所有的打印作业按照此地址通过网络发送到打印机。

如果 IP 地址没有自动指定，在无线设置过程中，当您从可用的列表中选择您的打印机之后会要求您手动输入
地址和其他的网络信息。

什么是密钥索引？

一个接入点（无线路由器）最多可以配置 4 个 WEP 密钥。但是，每一次在网络中只使用一个密钥。密钥带有
一个编号，密钥的编号就是密钥索引。当接入点上配置了多个 WEP 密钥时，无线网络中的所有设备都必须使
用相同的密钥索引。

在您的打印机上选择您在接入点上使用的同一个密钥索引。
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向导设置和高级设置之间有什么区别？

请使用向导设置，如果：

• 打印机和计算机在同一无线网络中进行通信。

• 您希望 Wireless Setup Utility 自动检测网络。

• 您希望使用 Wi‑Fi Protected Setup(WPS)将打印机连接到无线网络中。

请使用向导设置，如果：

• 打印机和正在安装的计算机不在同一无线网络中，或如果该计算机没有无线接入点。

• 无线网络需要证书。

• 该无线网络应用了企业级安全性。

• 您知道网络 SSID 和安全信息，并且希望在单机屏幕上输入该信息。

• 打印机会被配置为可通过远程网络访问。

• 您知道网络信息并希望快速将其输入。

• 您正在为使用 802.1X 验证的无线网络配置打印机。
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使用 Embedded Web Server
Embedded Web Server 可使您查看和远程定制打印机设置，即使您自己不在打印机旁边也能进行这些操作。
您还可以查看有关打印机活动的报告、在线监视和订购打印机耗材、联系客户支持以及下载打印机的更新。

Embedded Web Server 要求打印机通过以太网连接到网络。有关将打印机连接到网络的更多信息，请参阅打
印机的《用户指南》。

访问 Embedded Web Server
注意：请确认打印机连接在您的网络上。如要获取更多的信息，请参阅打印机的《用户手册》。

1 获取打印机的 IP 地址：

• 从打印机的主界面

• 从“网络/端口”菜单中的“TCP/IP”部分

注意：IP 地址由 4 组数字组成，用点分隔，例如 123.123.123.123。

2 打开 Web 浏览器，然后在地址栏中输入打印机的 IP 地址。

此时将显示 Embedded Web Server。

了解主页

选项 用途

1 导航窗格 访问 Embedded Web Server 菜单。

2 标题栏 • 查看打印机耗材的简短摘要。

• 查看有关打印机型号、IP 地址、联系信息和地点的信息。

• 访问搜索功能。

注意：搜索字段可能不会显示在 Embedded Web Server 中（依打印机型号而定）。

3 信息窗格 根据从导航窗格中选择的菜单，查看特定信息和访问子菜单项。
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定制打印机设置
1 从导航窗格中选择设置。

2 请执行以下一项操作：

单击 用途

常规设置 查看和定制常规打印机设置。

复印设置 查看和定制复印设置。

注意：此功能可能不会显示在 Embedded Web Server 中（依打印机型号而定）。

传真设置 查看和定制用于发送和接收传真的设置。

注意：此功能可能不会显示在 Embedded Web Server 中（依打印机型号而定）。

电子邮件/FTP 设置 查看和定制用于发送电子邮件或者将文件发送到“文件传输协议”(FTP)地址的设置。

注意：此功能可能不会显示在 Embedded Web Server 中（依打印机型号而定）。

打印设置 查看和定制打印设置。

纸张设置 查看和定制纸张设置选项。

网络/端口 查看和定制网络设置。

安全 查看和定制打印机以及 Embedded Web Server 的安全设置。

注意：此功能可能不会显示在 Embedded Web Server 中（依打印机型号而定）。

电子邮件警报设置 设置 Embedded Web Server 的电子邮件服务器，然后定制电子邮件警报设置。

扫描到网络文件夹设置 在使用“扫描到网络”应用程序时添加或管理文件夹目标。

注意：

• 此功能可能不会显示在 Embedded Web Server 中（依打印机型号而定）。

• 要使用此功能，请首先确保您正在使用“安全超文本传输协议”(HTTPS)连接。

管理快捷方式 为打印机任务添加或管理快捷方式设置。

注意：此功能可能不会显示在 Embedded Web Server 中（依打印机型号而定）。

管理配置文件 查看配置文件的 IP 地址或删除 IP 地址。

注意：此功能可能不会显示在 Embedded Web Server 中（依打印机型号而定）。

通讯簿设置 发送电子邮件时添加或管理通讯薄。

干预管理 查看打印机中任何需要用户进行干预的消息。

导入/导出 导入或导出配置文件。

其他解决方案 安装、定制或卸载解决方案。

设备管理 允许 Embedded Web Server 从打印机收集数据。

3 单击提交以保存，或单击重置表单以废弃新设置。
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使用 SmartSolutions

什么是 SmartSolutions？
SmartSolutions 是一些您可以在 SmartSolutions 网站(http://smartsolutions.lexmark.com)上创建、定制并
下载到您打印机上的解决方案。您可以创建一触式自定义解决方案，以简化重复的复印、扫描和打印任务。您
还可以在打印机操作面板上浏览 RSS 传送、日历和网上相册。

如要使用您创建或定制的解决方案，请在打印机操作面板上触摸 SmartSolutions，然后选择解决方案的图标
或名称。

对于带有发送电子邮件选项的解决方案，您必须首先通过主界面上的 ，为打印机设置电子邮件。

注意：根据您购买的打印机的功能，某些解决方案可能没有配备到打印机上。

创建和定制打印机解决方案

开始操作之前，请确保：

• 您的打印机和计算机已经通过以太网或无线网络连接到 Internet。

• 您的打印机的电源已打开。

1 访问 SmartSolutions 网站，网址为：http://smartsolutions.lexmark.com。

2 登录或创建帐号。

3 单击 SMARTSOLUTION 中心或解决方案中心。

4 单击屏幕底部的添加打印机。

5 按照计算机屏幕上的指导进行操作。

6 使用网站创建、定制解决方案并下载到您的打印机上。

如要获取更多信息，请从“解决方案中心”中单击 SmartSolutions 快速入门。
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维护打印机

维护打印墨盒
您可以执行以下任务；除此之外，如果您的打印机连接在适当有效的接地式电源插座上，将会执行自动维护操
作周期。打印机将会暂时退出“睡眠”模式，或者将临时开机（如果打印机已关闭）。

查看墨水量

使用打印机控制面板

在主界面中触摸 。

墨水量图像将会出现在显示屏上。

使用打印机软件

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 >选择您的打印机 >维护选项卡 >耗材状态

对于 Macintosh（英文版）用户

1 从 Apple 菜单依次选择：

System Preferences > Print & Fax >选择您的打印机

2 单击 Options & Supplies 或 Print Queue。

3 单击 Supply Levels。

校正打印头

如果您打印的图像中的字符或线条出现锯齿状或波浪状，您可能需要校正打印头。

1 装入普通的无标记纸张。

2 从主界面中，触摸  > 更多选项 > 校正打印机。

打印机将会打印出一张校正测试页。

注意：请不要移开校正测试页，直到打印完成。

清洗打印头喷头

打印质量差有时候是由打印头喷头堵塞引起的。清洗打印头喷头可以提高您的打印质量。
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注意：

• 清洗打印头喷头将会使用墨水，因此请只在必要的时候进行清洗。

• 深度清洗将会使用更多的墨水，因此请首先尝试“清洗打印头”选项，以便节省墨水。

• 如果墨水量太低了，您必须先更换打印墨盒，然后才可以清洗打印头喷头。

1 在主界面中触摸  >更多选项。

2 触摸清洗打印头或深度清洗打印头.

3 选择选项，然后等到打印机准备就绪。

清洗打印机外部
1 请确认打印机的电源已关闭，并且已从电源插座上断开。

当心—电击危险：当清洗打印机的外壳时，为了避免电击危险，请在操作之前从电源插座上断开电
源线，并断开打印机上的所有电缆。

2 从打印机内取出所有的纸张。

3 用水将一块干净且不掉毛的软布润湿。

警告—可能的损坏：请不要使用普通家用的清洁剂或去污剂，因为它们可能会损坏打印机的表面涂层。

4 请只清洗打印机的外面，并确认擦掉出纸托盘上的墨迹。

警告—可能的损坏：使用湿布清洗打印机的内部可能会损坏您的打印机。

5 在开始新的打印作业之前，请确认打印机完全干燥。
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清洁扫描仪玻璃
当打印页上出现垂直条纹或您在此类部件上看到污点或污迹时，请清洁扫描仪玻璃和其他相关部件。

1 用水将一块干净且不掉毛的软布润湿。

2 将扫描仪玻璃和其他相关部件轻轻擦拭干净。

1 背面材料

2 扫描仪玻璃

3 自动文档传送器扫描仪玻璃

4 自动文档传送器压板

注意：确认文档上的所有墨水或纠正液都干透之后，再将文档放置在扫描仪玻璃上。

清洗触摸屏
您的打印机操作面板触摸屏有时候可能需要清洗，以去除指纹和污迹。

1 请确认打印机的电源已关闭，并且已从电源插座上断开。

当心—电击危险：当清洗触摸屏时，为了避免电击危险，请在操作之前从电源插座上断开电源线，
并断开打印机上的所有电缆。

2 使用随同您的打印机一起提供的布或者其他干净、干燥且不掉毛的布擦拭触摸屏。

警告—可能的损坏：请不要使用液体、普通家用清洁剂或去污剂，因为它们可能会损坏触摸屏。

将打印机移到其他位置
将打印机和可选进纸匣移到其他位置时，请遵照以下注意事项：

• 用来移动打印机的拖车平台必须能够支持打印机底盘。用来搬动配件的拖车平台必须能够支持配件尺寸。

• 确保接纸架扩展板和输出接纸架位于原位。

• 保持打印机竖立。

• 确认已从打印机中取出打印墨盒。
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• 将已使用的打印墨盒喷头朝上存储在包装箱内。

• 移动时避免严重颠簸。

• 条件允许的话，请使用打印机的原始包装，并根据需要塞入缓冲垫，以便在运输期间保护打印机。
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疑难解答

在您解决问题之前
使用这些注意事项可以解决大多数打印机问题：

• 确认电源线的一端连接在打印机上，另一端连接在正确接地的电源插座上。

• 确认打印机的电源已打开。

• 确认打印机牢固地连接在计算机、打印服务器或其他网络接入点上。

• 检查打印机是否有错误信息，并解决错误。

• 检查是否有卡纸信息，并清除卡纸。

• 检查打印墨盒，如有必要，请安装新的打印墨盒。

• 关闭打印机电源，等待大约 10 秒钟后重新打开打印机电源。

注意：确认打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

如果疑难解答没有解决您的问题
请访问我们的网站 http://support.lexmark.com 以查找以下内容：

• 包含有关您的打印机的最新信息和疑难解答信息的知识库文章

• 在线客户支持

• 电话客户支持的联系号码

• 固件和软件更新

设置疑难解答
• 第130 页“显示屏上的文字是错误的语言”

• 第130 页“软件不能安装”

• 第130 页“恢复打印机的安全 PIN”

• 第131 页“打印作业不打印或者缺页”

• 第132 页“打印机打印出空白页”

• 第132 页“打印机正忙或无反应”

• 第133 页“无法从打印队列中删除文档”

• 第133 页“无法通过 USB 进行打印”
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显示屏上的文字是错误的语言

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的方法：

使用打印机菜单改变语言

1 从主界面中依次选择：

 > 设备设置 > 语言

2 选择语言，然后触摸“接受”。

3 触摸“是”确认此设置。

软件不能安装

如果您在安装过程中遇到了问题、您的打印机没有出现在打印机文件夹中的列表里，或者发送打印作业时您的
打印机没有出现在打印机选项中，您可以尝试卸载并重新安装软件。

在您重新安装软件之前，请完成以下操作：

请确保您的计算机满足最低系统需求

在安装软件之前暂时禁用 WINDOWS 安全程序

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏，请换用新电缆。

2 将 USB 电缆上正方形的一端牢固地插入打印机后面的 USB 端口中。

3 将 USB 电缆上长方形的一端牢固地插入计算机的 USB 端口中。

USB 接口旁标有 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 端口。您可能连接到了有故障的端口上。

重新连接打印机电源

1 关闭打印机的电源。

注意：确保打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

2 从墙壁电源插座上拨出电源线，再将其从电源插口取出。

3 一分钟后，将电源线重新依次插入打印机电源插口和墙壁电源插座。

4 打开打印机的电源。

恢复打印机的安全 PIN
联系客户支持人员。
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打印作业不打印或者缺页

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

请确认打印墨盒安装正确

1 打开打印机的电源，然后打开打印墨盒保护门。

2 请确认打印墨盒安装正确。

打印墨盒应该牢固地固定在相应颜色的插槽中。

3 关闭打印墨盒保护门。

发送打印作业之前，请在“打印”对话框中选择打印机

注意：此解决方案只适用于 Macintosh 用户。

1 打开文档，依次选择 File > Print。

2 请从“Printer”弹出菜单中选择打印机，然后单击 Print。

如果您的打印机没有出现在“Printer”列表中，那么请选择 Add Printer。请从“Default”标签中的打
印机列表选择打印机，然后单击 Add。

如果您的打印机没有出现在列表中，那么请尝试以下任一操作：

• 对于 USB 连接的打印机，请移除并重新连接 USB 电缆。

• 对于无线连接的打印机，请查看“无线”问题解答章节。

请确认打印作业没有被暂停

请确认您的打印机被设置为默认打印机

重新连接打印机电源

1 关闭打印机的电源。

注意：确保打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

2 从墙壁电源插座上拨出电源线，再将其从电源插口取出。

3 一分钟后，将电源线重新依次插入打印机电源插口和墙壁电源插座。

4 打开打印机的电源。

断开并重新连接您的打印机上的 USB 电缆

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏，请换用新电缆。

2 将 USB 电缆上正方形的一端牢固地插入打印机后面的 USB 端口中。
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3 将 USB 电缆上长方形的一端牢固地插入计算机的 USB 端口中。

USB 接口旁标有 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 端口。您可能连接到了有故障的端口上。

移除并重新安装打印机软件

打印机打印出空白页

空白页可能是由不正确地安装打印墨盒所引起的。

重新安装打印墨盒并深度清洗和校正打印头

1 重新安装打印墨盒。如要获取更多的信息，请参阅第 14 页“更换打印墨盒”。

打印墨盒应该牢固地固定在相应颜色的插槽中。

2 装入普通的无标记纸张。

3 从主界面中，触摸  > 更多的选项 > 深度清洗打印头。

4 选择选项，然后等到打印机准备就绪。

5 从主界面中，触摸  > 更多选项 > 校正打印机。

打印机将会打印出一张校正测试页。

注意：请不要移开校正测试页，直到打印完成。

打印机正忙或无反应

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

确保打印机没有处于“睡眠”模式

如果电源指示灯在缓慢闪烁，那么打印机正处于“睡眠”模式。按 以唤醒打印机。

如果打印机未从“睡眠”模式中恢复，那么请重置电源：

1 从墙壁电源插座中拔下电源线并等待 10 秒钟。

2 将电源线插入电源插座，然后打开打印机的电源。

如果仍出现该问题，那么请访问我们的网站，检查是否有您打印机软件或固件的更新。

重新连接打印机电源

1 关闭打印机的电源。

注意：确保打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

2 从墙壁电源插座上拨出电源线，再将其从电源插口取出。

3 一分钟后，将电源线重新依次插入打印机电源插口和墙壁电源插座。

4 打开打印机的电源。
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无法从打印队列中删除文档

如果您的作业滞留在打印队列中无法删除，导致其他的作业不能打印，计算机和打印机可能无法进行通讯。

重新启动计算机并重新尝试

断开并重新连接您的打印机上的 USB 电缆

无法通过 USB 进行打印

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

请确认 WINDOWS 中的 USB 端口已启用

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 devmgmt.msc。

3 按 Enter 键，或者单击“确定”。

设备管理器将会出现。

4 单击“通用串行总线控制器”旁边的加号(+)。

如果您看到 USB Host Controller 和 USB Root Hub 列在其中，说明 USB 端口已经正确启用。

请参阅计算机的相关文档获取更多的信息。

反安装并重新安装打印机软件

了解打印机消息

校正问题

请尝试以下的一种或多种方法：

• 校正打印墨盒时，请只装入普通的无标记纸张。

如果所用纸张上存在可能导致显示校正错误消息的标记，打印机都会读取。

• 触摸重试。

• 触摸取消以清除消息。
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无法逐份打印作业

请尝试以下的一种或多种方法：

• 触摸继续以打印保存在打印机内存中的页面，然后逐份打印打剩下的打印作业。

• 触摸取消打印以取消当前打印作业。

将[纸张来源]更改为[自定义字符串]
请尝试以下的一种或多种方法：

• 使用正确的纸张尺寸或类型选择进纸匣。

• 触摸纸张已装入，继续，在默认进纸匣内装入类型和尺寸都正确的纸张后继续打印。

• 按 取消当前作业。

将[纸张来源]更改为[自定义类型名称]
请尝试以下的一种或多种方法：

• 使用正确的纸张尺寸或类型选择进纸匣。

• 触摸纸张已装入，继续，在默认进纸匣内装入类型和尺寸都正确的纸张后继续打印。

• 按 取消当前作业。

将[纸张来源]更改为[尺寸]纸张

请尝试以下的一种或多种方法：

• 使用正确的纸张尺寸或类型选择进纸匣。

• 触摸纸张已装入，继续，在默认进纸匣内装入类型和尺寸都正确的纸张后继续打印。

• 按 取消当前作业。

将[纸张来源]更改为[尺寸][类型]纸张

请尝试以下的一种或多种方法：

• 使用正确的纸张尺寸或类型选择进纸匣。

• 触摸纸张已装入，继续，在默认进纸匣内装入类型和尺寸都正确的纸张后继续打印。

• 按 取消当前作业。

关闭打印机

打印机处于打开状态。关闭打印机以清除消息。
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通信错误

打印机无法与请求的目的地通信。请尝试以下一种或多种方法：

• 确保您的打印机和计算机已经通过以太网或无线网络连接到 Internet。

• 确保打印机牢固地连接在主计算机、打印服务器或其他网络接入点上。

• 触摸确认以清除消息。

默认电子邮件消息

请尝试以下一种或多种方法：

• 请触摸是，将您输入的消息设置为打印机默认电子邮件消息。

• 请触摸否，仅为当前作业保存新消息。

检测到数字线路

将打印机连接到标准模拟电话线。如果适用，也可以将数字过滤器连接到电话线。触摸确认以清除消息。

要获取更多信息，请与您的电话公司联系。

双面打印部件缺失

请尝试以下的一种或多种方法：

• 请确认双面打印部件已正确安装在打印机的背面以清除消息。

• 取消当前作业。
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未指定电子邮件服务器

请尝试以下一种或多种方法：

• 触摸继续返回之前的菜单。

• 请确认已指定电子邮件服务器。

在主界面中依次触摸  > 电子邮件 设置 > SMTP 设置。输入 SMTP 服务器设置，然后触摸确认或接收保
存每项。

• 如果必要，请确保打印机连接到的网络具有 Internet 连接。一些电子邮件服务器可能不要求 Internet 连接，
例如那些在私用网络中设置的电子邮件服务器。如要获取更多有关电子邮件账号设置的信息，请与您的电
子邮件供应商或您的系统支持人员联系。

电子邮件发送错误

请尝试以下一种或多种方法：

• 在发送电子邮件之前，请确认打印机连接在以太网络或无线网络中。

打印机在某一时刻只支持一种可用的网络连接(以太网或无线)。

• 如有必要，请确认网络连接在 Internet 中，以便打印机可以和 SMTP 服务器进行通讯。如果打印机不能连
接到 Internet，请与您的系统支持人员联系。

• 请确认 SMTP 服务器设置是正确的。

• 触摸确认以清除消息。

输出接纸架已满

从输出接纸架移除纸张以清除消息。

连接失败

打印机无法检测拨号音。

检查电话线上的拨号音。

传真内存已满

请降低分辨率或减少传真页数。触摸继续以清除消息。

不支持的传真调制解调器

请尝试以下一种或多种方法：

• 启动将彩色传真转换成黑白传真。

• 降低传真分辨率

• 在 A4 或 letter 尺寸的纸上重新格式化文档。

传真调制解调器错误

关闭并重新打开打印机电源，然后重新发送传真。
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未设置传真名称

设置传真以输入传真名称和号码。触摸继续以清除消息。

打印墨盒保护门处于打开状态

打印墨盒保护门处于打开或分开状态。

• 如果打印墨盒保护门处于打开状态，那么请将其关闭以清除消息。

• 如果打印墨盒保护门处于打开状态，请重新关闭以清除消息。

1 插入门铰链直到其发出卡嗒声。确保成 90 度角将保护门垂直插入。

2 关闭打印墨盒保护门以清除消息。

打印墨盒寿命到期

请尝试以下一种或多种方法：

• 更换指定的打印墨盒。

• 确保打印机支持所安装的打印墨盒。

• 触摸继续，然后按 继续打印。

警告—可能的损坏：继续使用指定的打印墨盒可能会损坏打印头。

• 触摸取消打印取消打印作业。

• 请参阅用户指南或访问 Lexmark 支持站点 http://support.lexmark.com 以获取支持的打印墨盒列表。

打印墨盒错误

打印机无法验证一个或多个已安装的打印墨盒。请尝试以下一种或多种方法：

• 按 取消当前作业。

• 请仅使用原装 Lexmark 打印墨盒。

• 正确安装指定的打印墨盒。
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• 关闭打印机电源，等待大约 10 秒钟后重新打开打印机电源。

注意：确保打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

• 请参阅用户手册，或访问 Lexmark 支持网站 http://support.lexmark.com 以获取更多信息。

打印墨盒缺失

请尝试以下一种或多种方法：

• 安装缺少的指定打印墨盒。

• 重新装入指定的打印墨盒。

• 如果已将“查找打印墨盒”小组件下载到打印机，那么请触摸查找墨水。

将显示在 SmartSolutions 菜单中可用的“查找打印墨盒”解决方案。

• 触摸确认以清除信息。

• 请参阅用户手册，或访问 Lexmark 支持网站，网址为：http://support.lexmark.com，以获取支持的打印
墨盒列表。

不支持的打印墨盒

请尝试以下的一种或多种方法：

• 用受打印机支持的打印墨盒取代无法识别的打印墨盒。

• 如果已将“查找打印墨盒”小组件下载到打印机，那么请触摸查找墨水。

将显示在 SmartSolutions 菜单中可用的“查找打印墨盒”解决方案。

• 触摸确认以清除消息。

• 请参阅用户指南或访问 Lexmark 支持站点 http://support.lexmark.com 以获取受支持的打印墨盒列表。

墨水量偏低

您可能很快就需要更换指定的打印墨盒。尝试以下一项或多项操作：

• 如果已将“查找打印墨盒”小组件下载到打印机，请触摸查找墨水。

将显示在 SmartSolutions 菜单中可用的“查找打印墨盒”解决方案。

• 触摸确认以清除消息并继续打印。

注意：根据您的打印机设置，您可能要在更换指定的打印墨盒后才能继续打印。

• 请参阅《用户指南》或访问 Lexmark 支持网站，网址为：http://support.lexmark.com ，以获取支持的打
印墨盒列表。

使用[自定义类型名称]装入[纸张来源]
请尝试以下的一种或多种方法：

• 在进纸匣中装入指定纸张。

• 触摸纸张已装入，继续以清除消息并继续打印。

• 按 取消当前作业。
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使用[自定义字符串]装入[纸张来源]
请尝试以下的一种或多种方法：

• 在进纸匣中装入指定纸张。

• 触摸纸张已装入，继续以清除消息并继续打印。

• 按 取消当前作业。

使用[尺寸][类型]纸张装入[纸张来源]
请尝试以下的一种或多种方法：

• 在进纸匣中装入指定纸张。

• 触摸纸张已装入，继续以清除消息并继续打印。

• 按 取消当前作业。

使用[尺寸][类型]纸张装入[纸张来源]
请尝试以下的一种或多种方法：

• 在进纸匣中装入指定纸张。

• 触摸纸张已装入，继续以清除消息并继续打印。

• 按 取消当前作业。

存储设备访问错误

请尝试以下一种或多种方法：

• 移除存储设备，然后重新将其插入卡插槽或 USB 端口。

• 触摸确认以清除消息。

网络[x]软件错误

[x]是该网络连接的号码。

请尝试以下的一种或多种方法：

• 触摸继续以清除消息。

• 关闭并重新打开打印机电源以重置打印机。

无应答

请尝试以下一种或多种方法：

• 请确认传真号码并重新发送。

• 稍后再发送传真。
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无电子邮件地址

电子邮件联系人或您选择的组中至少有一名组成员没有电子邮件地址。请尝试以下一种或多种方法：

• 请触摸是以输入电子邮件地址，然后在添加完每位收件人后触摸接受。

• 请触摸编辑组以输入缺少的电子邮件地址，然后在添加完每位收件人后触摸接受。

• 请触摸依然发送，仅向具有电子邮件地址的组员发送电子邮件。

• 请触摸否以取消电子邮件。

检测到进纸匣[x]
请尝试以下一种或多种方法：

• 请触摸确认以清除消息。

• 请触摸改变设置，然后为装入的介质选择纸张大小和纸张类型。请在每次选择后触摸接受。

进纸匣[x]已拆除

将指定的进纸匣插入打印机，或触摸确认。

电话连接到错误的插座上

将电话电源线连接到打印机背面正确的插座上，然后触摸确定。

电话线路忙

如果打印机和其他设备共用电话线，请确认这些设备不在使用中。

电话线路错误

打印机无法检测拨号音。检查电话线上的拨号音。

电话线没有连接

确保打印机连接到标准的模拟电话线上，然后触摸确认。

打印机内存已满

请尝试以下一种或多种方法：

• 根据打印机型号，触摸确定或按 以清除信息，然后重试打印。

• 在计算机中，调整打印机设置以降低打印作业质量，然后重试打印。

打印头无法移动

请尝试以下的一种或多种方法：

• 触摸确定。

• 取出打印机内堵塞打印头的物体。
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• 关闭打印机。

打印头错误

打印头出现了问题。联系技术支持。

打印头警告

清理或深度清理打印头以恢复打印质量。

注意：

• 清洗打印头喷头将会使用墨水，因此请只在必要的时候进行清洗。

• 深度清洗将会使用更多的墨水，因此请首先尝试“清洗打印头”选项，以便节省墨水。

• 如果墨水量偏低，您必须先更换打印墨盒，然后才可以清洗打印头喷头。

• 请参阅用户手册，以获关于如何清理打印头喷头的更多信息。

代理错误

请尝试以下一种或多种方法：

• 请触摸设置代理以输入代理设置。

• 触摸确认以清除消息。

远程传真错误

接收传真的机器无法接收该传真。接收端可能出错。

更换打印墨盒

请尝试以下的一种或多种方法：

• 用受打印机支持的打印墨盒取代无法识别的打印墨盒。

• 如果已将“查找打印墨盒”小组件下载到打印机，那么请触摸查找墨水。

将显示在 SmartSolutions 菜单中可用的“查找打印墨盒”解决方案。

• 触摸确认以清除消息。

• 请参阅用户指南或访问 Lexmark 支持站点 http://support.lexmark.com 以获取受支持的打印墨盒列表。

扫描文档的时间过长

扫描作业超出最大页数。请触摸取消作业以清除消息并取消当前扫描作业。

扫描仪 ADF 顶盖打开

请尝试以下一种或多种方法：

• 关闭 ADF 顶盖以清除消息。

• 按 以取消当前扫描作业。
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扫描仪已禁用

请尝试以下一种或多种方法：

• 请从打印机检查打印机软件设置或“管理”设置以启用扫描仪。

• 触摸确认以清除消息。

纸张尺寸太小

请尝试以下一种或多种方法：

• 请根据打印机型号，触摸确认或按 。

• 确认纸张尺寸设置正确。

• 在进纸匣中或纸张支架上装入尺寸正确的纸张。

• 检查进纸导轨，确认在进纸匣或纸张支架上装入了正确的纸张。

• 取消当前打印作业。

安全证书错误

请尝试以下一种或多种方法：

• 请触摸设置日期以检查打印机日期，然后尝试重新连接到服务器。

• 触摸确认以清除消息。

SmartSolutions 升级失败

请尝试以下一种或多种方法：

• 确保您的打印机和计算机已经通过以太网或无线网络连接到 Internet。

• 确保打印机牢固地连接在主计算机、打印服务器或其他网络接入点上。

• 触摸确认以清除消息。

标准网络软件错误

请尝试以下的一种或多种方法：

• 触摸继续以清除消息。

• 关闭并重新打开打印机电源以重置打印机。

无法获取解决方案

请尝试以下一种或多种方法：

• 确保您的打印机和计算机已经通过以太网或无线网络连接到 Internet。

• 确保打印机牢固地连接在主计算机、打印服务器或其他网络接入点上。

• 触摸确认以清除消息。

不可恢复的传真错误

关闭并重新打开打印机电源，然后重新发送传真。
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不可恢复的扫描错误

请尝试以下一种或多种方法：

• 重新启动您的打印机。

• 升级打印机固件。

不支持 USB 设备

移除并用受支持的设备替换无法识别的 USB 设备。

不支持的 USB 集线器

移除无法识别的 USB 集线器。

清除卡纸
• 第143 页“打印机内发生卡纸”

• 第144 页“双面打印部件内发生卡纸”

• 第144 页“自动文档传送器内发生卡纸（仅限于精选型号）”

• 第145 页“纸张或特殊介质进纸错误”

打印机内发生卡纸

注意：打印机的内部部件很灵敏。清除卡纸时，请避免对这些部件的不必要碰触。

1 检查进纸匣、输出接纸架或卡纸清除区域是否有任何卡纸。

注意：

• 对于支持第二个进纸匣的某些型号，请确认也检查了第二个进纸匣。

• 如果已拆除进纸匣，请确认在清除卡纸后才换用此进纸匣。

• 检查卡纸清除区域时，请确保不要将打印机倾斜。请抓住打印机操作面板下面的保护盖并将其拉出以
打开打印机。

• 清除卡纸前，请确保将打印头移到一边，使其远离被卡住的纸张。
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2 抓紧纸张并将其轻轻地从打印机中拉出。

注意：小心不要在取出卡纸时将其撕坏。

3 如果必要，请关闭打印机以清除信息。

双面打印部件内发生卡纸

注意：打印机的内部部件很灵敏。清除卡纸时，请避免对这些部件不必要的碰触。

1 向上拉双面锁，然后取下双面打印部件。

2 抓紧纸张并将其轻轻地从打印机中拉出。

注意：请小心不要在取出纸张时将其撕坏。

3 重新插入双面打印部件以清除消息。

自动文档传送器内发生卡纸（仅限于精选型号）

注意：打印机的内部部件很灵敏。清除卡纸时，请避免对这些部件的不必要碰触。

1 打开自动文档传送器的盖板，轻轻地拉出卡纸。
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注意：

• 请确保自动文档传送器的盖板完全打开以便适当地取出卡纸。

• 小心不要再取出卡纸时将其撕坏。

2 关闭自动文档传送器盖板。

注意：在关闭自动文档传送器盖板时，请确保自动文档传送器进纸匣上没有纸张。

3 触摸确定。

4 恢复复印、扫描或传真作业。

纸张或特殊介质进纸错误

如果纸张或特殊介质进纸不正常、扭曲、同时进多页纸或者粘在一起，以下是可能的解决方法。请尝试其中的
一种或多种方法：

检查纸张条件

请只使用新的且没有皱褶的纸张。

检查纸张装入
• 请在打印机内装入较少数量的纸张。

• 装入纸张时请确认可打印的一面朝下。（如果您不确定哪一面可打印，请参阅随同纸张一起的指导。）

• 请参阅针对您的纸张和特殊介质的详细装纸指导。

随时移开打印机送出的打印页

调节进纸导轨以适合装入的纸张

打印疑难解答
• 第146 页“打印页边缘处的打印质量非常差”

• 第147 页“打印的图像中出现条纹或线条”
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• 第147 页“打印速度慢”

• 第148 页“当打印时计算机速度变慢”

打印页边缘处的打印质量非常差

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

检查最小打印设置

除非您使用无边界功能，否则请使用以下的最小打印边距设置：

• 左边距和右边距：

– Letter 尺寸的纸张：6.35 毫米（0.25 英寸）

– 除 Letter 以外的所有其他纸张：3.37 毫米（0.133 英寸）

• 上边距：1.7 毫米（0.067 英寸）

• 下边距：12.7 毫米（0.5 英寸）

选择无边界打印功能

对于 Windows 用户

1 打开照片，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

纸张/完成 选项卡 >选择无边界设置 > 确定

4 单击打印。

对于 Macintosh（英文版）用户

1 打开照片，选择 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择名称中带有(Borderless)的纸张尺寸。

例如，如果您装入了一张 4 x 6 照片纸，那么请选择 US 4 x 6 in (Borderless)。

4 单击 OK。

5 从菜单栏中单击 File > Print。

6 从 Printer 弹出菜单中选择您的打印机。

7 从打印选项弹出菜单中选择 Quality & Media。

8 从 Paper Type 弹出菜单中选择纸张类型。

9 从 Print Quality 弹出菜单中选择 Best 或 Photo。

10 单击 Print。
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打印的图像中出现条纹或线条

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

查看墨水量

更换墨水量偏低或空的打印墨盒。

在打印机软件中选择较高的打印质量

请确认打印墨盒安装正确

校正打印头

清洗或深度清洗打印头喷头

注意：如果这些方法不能去除打印的图像中的条纹或线条，请联系技术支持。

打印的页面上有墨迹或污迹

注意：在打印机中出现墨迹或污迹时，可以应用以下解决方案。

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

选择为打印作业推荐的纸张

如要获取更多的信息，请参阅用户手册中关于“使用其他尺寸和类型的纸张”的部分。

将页面干燥时间值设置为“延长”

高湿度条件下或对于某些纸张类型和品牌，在正常的干燥时间内可能无法让墨水完全干透。如要获取更多信
息，请参阅用户手册中的“设置页面干燥时间”。

打印速度慢

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

在打印机软件中选择较低的打印质量

手动选择您使用的纸张类型

反安装并重新安装打印机软件

提高计算机处理速度
• 请关闭所有不用的应用程序。

• 尽量减小文档中照片和图像的数量和尺寸。
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为计算机增加内存

考虑升级内存(RAM)。

当打印时计算机速度变慢

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

检查打印机和计算机之间的 USB 连接

如果您的计算机通过 USB 电缆连接在打印机上，请尝试使用不同的 USB 电缆。

刷新您的网络连接

1 如果您的计算机连接在以太网或无线网络中，请关闭接入点（无线路由器）的电源，然后重新打开。

2 等待 1 分钟，让打印机和计算机重新建立连接。

请关闭所有不用的应用程序

在您的计算机上临时关闭不用的应用程序或结束占用太多内存的进程。

检查您的计算机性能

您可能需要改变您的计算机如何管理资源和进程。

如要获取更多有关提高计算机性能的帮助信息，请参阅您的操作系统的帮助文档。

复印和扫描疑难解答
• 第148 页“打印机不能复印或扫描或者没有反应”

• 第149 页“扫描仪部分没有关闭”

• 第149 页“复印或扫描的质量非常差”

• 第149 页“文档或照片只复印或扫描了一部分”

• 第149 页“扫描不成功”

• 第150 页“扫描任务花费很长的时间或者导致死机”

• 第150 页“无法通过网络扫描至计算机”

打印机不能复印或扫描或者没有反应

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

将您的打印机设置为默认打印机

反安装并重新安装打印机软件
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扫描仪部分没有关闭

1 抬起扫描仪部分。

2 取出所有导致扫描仪部分打开的堵塞物。

3 关闭扫描仪部分。

复印或扫描的质量非常差

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

擦洗扫描仪玻璃

调整扫描质量

浏览有关复印和扫描的提示以提高打印质量

使用更清晰的文档或图像原件

请确认文档或照片正面朝下放置在扫描仪玻璃上，并且位于正确的角落

文档或照片只复印或扫描了一部分

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

请确认文档或照片正面朝下放置在扫描仪玻璃上，并且位于放置角落

选择您装入的纸张尺寸

请确认“原件尺寸”设置与您要扫描的文档尺寸一致

扫描不成功

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏，请换用新电缆。

2 将 USB 电缆上正方形的一端牢固地插入打印机后面的 USB 端口中。

3 将 USB 电缆上长方形的一端牢固地插入计算机的 USB 端口中。

USB 接口旁标有 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 端口。您可能连接到了有故障的端口上。
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重新启动计算机

扫描任务花费很长的时间或者导致死机

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

关闭其他不用的应用程序

重新启动计算机

无法通过网络扫描至计算机

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

请确认打印机和目的地计算机连接在同一个网络中

请确认在目的地计算机上安装了打印机软件

电子邮件疑难解答
• 第150 页“无法发送电子邮件”

无法发送电子邮件

检查您的电子邮件配置设置

请确认您正确地完成了电子邮件设置，并且成功地配置了 SMTP 服务器。

检查您的网络连接

请确认打印机连接在以太网络或无线网络中。您的网络必须连接在 Internet 中，以便打印机可以与 SMTP
服务器进行通讯。

检查您的代理服务器配置

您的代理服务器配置应该允许 SMTP 服务器连接。有关您的代理服务器或 SMTP 设置的帮助信息，请与您
的系统支持人员联系。

请确认输入了有效的收件人电子邮件地址

请确认收件人的邮箱没有满

这种情况可能会导致电子邮件被退回到您的收件箱。
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传真疑难解答
• 第151 页“传真问题解答注意事项”

• 第151 页“无法发送传真”

• 第152 页“无法接收传真”

• 第153 页“无法运行传真软件”

有关常用术语和任务的详细说明，请参阅：

• 第 71 页“设置打印机的传真功能”

• 第 88 页“传真常见问答”

传真问题解答注意事项

如果您在发送和接收传真时遇到了问题，请首先检查连接：

1 将一部模拟电话机连接在您用于连接打印机的墙壁电话线插座、DSL 过滤器、VoIP 设备或电缆调制解调
器上，然后检查电话线上的拨号音。请确认您将电话机连接在同一个插口上。

如果您没有听到拨号音，请与您的线路供应商联系。

2 当打印机连接在电话线上时，将一部模拟电话机连接在打印机后面的  插口上，然后检查拨号音。

如果您没有听到拨号音，请检查以下的注意事项，检查每一项之后再次收听拨号音。

如果您听到了拨号音，但是发送和接收传真仍然有问题，请参阅本章中的其他主题。

连接注意事项

• 请确认打印机和线路上的其他设备（如果有的话）都已经按照您的安装方法正确安装和配置。

• 请确认电缆连接在正确的插口上。

• 请确认电缆连接牢固。

请检查以下硬件（如果使用）的电缆连接：

电源适配器 电话答录机 电缆调制解调器 分线器

电话机 VoIP 适配器 DSL 过滤器 RJ‑11 适配器

• 如果打印机连接在数字用户线路(DSL)上，请确认您为打印机使用了一个 DSL 过滤器。

• 如果打印机连接在 VoIP 适配器或电缆调制解调器上，请确认打印机连接在第一个电话插口上。

• 如果您使用了分线器，请确认您使用的是电话分线器。请不要使用线路分线器。

无法发送传真

如果“传真问题解答注意事项”没有解决问题，请尝试以下的一种或多种方法：

确认在打印机中输入使用者信息

如果您在初始设置过程中没有输入使用者信息，请输入您的传真名称和传真号码。您发送的所有传真中都将
包含此信息，表明您是发件人。一些国家或地区需要您提供传真号码和传真名称才可以发送传真，并且一些
传真机会阻止匿名传真。
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降低传真调制解调器的传输速度

打印机的调制解调器能够以 33,600 bps 的速度发送和接收数据。但是，您不必将调制解调器设置为最快的
传输速度。接收传真机的调制解调器的速度必须等于或大于您发送传真的速度。否则，接收方将不能接收您
的传真。

1 从主界面，依次选择：

 > 传真设置 > 拨号和发送 > 最大发送速度

2 选择发送速度，然后触摸接受。

启用错误修正

如果线路上有太多的噪音，传真的文档中可能会出现错误和污点。此功能可以让打印机重新发送损坏的数据
块并修正错误。当传真中的错误太多时，接收传真机可能会拒收此传真。

从主界面，依次选择：

 > 传真设置 > 拨号和发送 > 错误修正 > 开 > 接受

启用自动传真转换

如果接收传真机不支持彩色传真，此选项可以自动将准备发送的彩色传真转换为黑白传真。它也可以将传真
的分辨率自动降低至接收传真机可以支持的分辨率。

从主界面，依次选择：

 > 传真设置 > 拨号和发送 > 自动传真转换 > 开 > 接受

请确认“拨号前缀”设置正确

拨号前缀是一个数字或一系列数字，您必须先按此数字，然后才可以拨打实际的传真号码或电话号码。如果
打印机位于办公室中或者连接在专用分组交换机上，您需要按一个特定的数字，然后才可以拨打外线。

1 从主界面，依次选择：

 > 传真设置 > 拨号和发送 > 拨号前缀

2 检查前缀。

如果前缀不正确，请输入正确的前缀，然后触摸接受。

无法接收传真

如果“传真问题解答注意事项”没有解决问题，请尝试以下的一种或多种方法：

请确认您已经为您的安装方法配置了正确的设置

如果打印机和其他设备共用电话线，请确认设置了以下内容：

• 自动应答为开。

• 和其他设备相比，打印机在较多数目的铃响之后应答来电。

• 打印机在正确的特色铃声时应答来电（如果您申请了特色铃声服务）。
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请确认打印机连接在模拟插口上

打印机是一种模拟设备。如果您使用专用分组交换机(PBX)系统，请确认打印机连接在 PBX 的模拟插口上。
您可能需要一个可以将数字信号转换成模拟信号的数字线路转换器。

确认释放打印机内存

打印机在打印接收到的传真之前会将传真保存在打印机内存中。如果打印机在接收传真时墨水用完了或者纸
张用完了，打印机可以保存传真，以便您以后打印。但是，如果打印机的内存已满，打印机可能无法接收更
多的传真。当打印机内存已满时，触摸屏上将会出现错误信息。请解决错误以释放打印机内存空间。

请确认“传真转发”已禁用

从主界面，依次选择：

 > 传真设置 > 铃声和应答 > 传真转发 > 关 > 接受

增大铃声音量

如果您将打印机设置为手动接收传真（自动应答关），请增大铃声音量。

请确认您有正确的手动应答码

如果您将打印机设置为手动接收传真（自动应答关），当有传真来电时，您需要输入正确的代码，打印机方
可接收传真。

1 从主界面，依次选择：

 > 传真设置 > 铃声和应答 > 手动应答码

2 记录下触摸屏上显示的手动应答码。

注意：默认代码为*9*，但是为了提高安全性，您可以将它改变为只有您知道的数字。

无法运行传真软件

必须先将打印机连接到电话、DSL、VoIP 或电缆服务，然后才可以在传真软件中配置传真设置。

确认已安装传真驱动程序

只有具有 PostScript 驱动程序或通用传真驱动程序才可以使用传真选项。关于安装这些驱动程序的信息，请
查阅软件和文档 CD。

请确认打印机连接在电话线上

在您可以打开传真软件和并配置传真设置之前，您需要通过标准墙壁电话线插座、DSL 过滤器、VoIP 适配
器或电缆调制解调器将打印机连接到您的电话线上。

存储卡疑难解答
• 第154 页“存储卡问题解答注意事项”

• 第154 页“插入存储卡后没有任何反应”
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存储卡问题解答注意事项

在您解决问题之前，使用以下的注意事项可以解决大多数存储卡问题：

• 请确认您使用的存储卡是打印机所支持的类型。

• 请确认存储卡没有损坏。

• 请确认存储卡中包含支持的文件类型。

插入存储卡后没有任何反应

如果“存储卡问题解答注意事项”没有解决问题，请尝试以下方法：

重新插入存储卡

存储卡可能插入太慢。请取出并快速地重新插入存储卡。

网络疑难解答
• 第154 页“网络疑难解答查对表”

• 第155 页“'继续'按钮无法使用”

• 第156 页“计算机防火墙阻止与打印机进行通讯”

• 第157 页“当连接到虚拟个人网络(VPN)时与打印机的通讯中断了”

网络疑难解答查对表

在开始解决无线打印机的问题之前，请检验：

常规网络连接

确认：

• 打印机、计算机和访问点（无线路由器）全部插入电源并且已打开。

• 无线网络工作正常。

请尝试访问您的无线网络上的其他计算机。如果您的网络有 Internet 接入，请尝试通过无线连接来连接到 
Internet。

• 打印机驱动程序被安装在您正在执行任务的计算机上。

• 选择了正确的打印机端口。

• 您网络的 IP 地址、网关和网络掩码是正确的。

从打印机打印网络设置页来检查网络设置。

• 所有交换机、集线器以及其他连接设备的电源都已经打开。

以太网络连接

确认：

• 以太网电缆和连接器没有损坏。

检查连接器的两端没有任何明显损坏。如有可能，请使用新电缆。

• 以太网电缆牢固地插入到打印机和集线器或者墙壁连接中。
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无线网络连接

确认：

• SSID 是正确的。

从打印机打印网络设置页来检查网络设置。

• 您的无线安全设置是正确的。

注册到访问点并检查安全设置。

如果您不确定您的安全信息是否正确，请再次运行无线设置。

• 打印机和计算机在无线网络的范围内。

• 计算机和打印机都被连接到相同的无线网络上。

• 打印机远离可能干扰无线信号的障碍物或电子设备。

确认打印机和无线访问点没有被含有金属或混凝土的棒杆、墙壁或支撑柱隔开。

许多设备会干扰无线信号，包括婴儿监视器、电机、无绳电话、安全系统摄像头、其他无线网络和一些蓝
牙设备。

• 计算机没有连接到 VPN。

• 您的计算机防火墙更新到最新版本并允许打印机软件通过网络通信。

“继续”按钮无法使用

请以出现的顺序依次尝试以下解决方案，直到“继续”按钮激活激活并可用：

检查 USB 电缆是否牢固地连接到了计算机和打印机的 USB 端口上

USB 端口带有 标记。

请确认打印机已接通电源并且已打开

请确认 按钮指示灯亮着。如果您刚刚打开打印机，那么可能需要断开 USB 电缆然后重新连接。

请确认计算机上的 USB 端口可以正常工作

通过连接到其它设备来测试 USB 端口。如果可以通过端口使用其他设备，那么端口可以正常工作。

注意：

• 您的端口可能运行良好，但连接到多种 USB 设备的时候可能会发生某些冲突。请尝试断开其中某个
USB 设备。

• 如果计算机上的某个 USB 端口不能正常工作，请尝试使用计算机上的其它 USB 端口。

请确认 USB 电缆可以正常工作

尝试使用不同的 USB 电缆。如果您使用的电缆长度超过 10 英尺，那么请尝试短一些的电缆。

注意：USB 转换器、扩展电缆、端口复制器和扩展坞都可能引起连接问题。请尝试断开这些设备，使打印
机可以直接连接到计算机。

疑难解答 155



请确认您使用的是针对您的打印机型号的正确的 CD
比较 CD 上的打印机型号和打印机上的打印机型号。号码应该完全相同或属于同一系列。

如果不能确定，请在 Lexmark 网站上搜索最新版本的打印机软件。如要获取更多的信息，请参阅打印机用
户指南。

重新连接打印机电源

1 关闭打印机的电源。

注意：确保打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

2 从墙壁电源插座上拨出电源线，再将其从电源插口取出。

3 一分钟后，将电源线重新依次插入打印机电源插口和墙壁电源插座。

4 打开打印机的电源。

再次运行安装程序

1 关闭安装程序。

2 取出 CD，然后重新启动计算机。

3 插入 CD，然后再次运行安装程序。

请确认您的计算机能够注意到 USB 端口上的 USB 活动

打开“设备管理器”，检查 USB 设备连接到 USB 端口之后是否活动：

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”框中输入 devmgmt.msc。

3 按输入键，或者单击确定。

4 将 USB 电缆或其他设备连接到 USB 端口时，查看“设备管理器”窗口。“设备管理器”检测到 USB
连接后，会刷新窗口。

• 如果“设备管理器”可以检测到活动，但之前的解决方案都无法正常工作，那么请电话联系客户支
持。

• 如果“设备管理器”检测不到活动，那么您的计算机和它的 USB 支持可能出现了问题。为了正常安
装，计算机必须能够检测到 USB 连接。

计算机防火墙阻止与打印机进行通讯

防火墙设置可能会阻止打印机连接到您的计算机。

如果您的计算机上安装了防火墙，请执行以下操作之一：

• 禁用计算机防火墙。

• 将您的计算机防火墙更新到最新版本，然后允许打印机软件通过网络进行通讯。

如要获取更多有关禁用和更新防火墙的信息，请参阅您操作系统的帮助页面。
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当连接到虚拟个人网络(VPN)时与打印机的通讯中断了

当您连接到大多数虚拟个人网络(VPN)时，与您的本地网络中的无线打印机的连接将会中断。

大多数虚拟个人网络只允许计算机与 VPN 进行通讯，不可同时与其他网络进行通讯。在计算机上安装驱动程
序或者在计算机上运行无线设置之前，请从 VPN 上断开连接。

如要检查计算机现在是否连接在 VPN 中，请打开您的 VPN Client 软件，然后检查您的 VPN 连接。如果您没
有安装 VPN Client 软件，请使用 Windows VPN Client 手动检查连接。

如果您希望可以同时连接到您的本地网络和 VPN，请要求 VPN 的系统支持人员允许使用 Split Tunneling（分
离通道）功能。请注意，一些机构组织出于安全或技术的原因不允许使用此功能。

如果您只希望连接到 VPN，在结束 VPN 会话之前，将不打印您要打印的文档。如果您希望在连接到 VPN 时
继续打印，请使用 USB 电缆将打印机连接到计算机。如要获取更多信息，请参阅用户手册。

无线疑难解答
• 第157 页“将无线设置恢复为出厂默认设置”

• 第157 页“无法通过无线网络进行打印”

• 第160 页“没有安装无线打印服务器”

• 第160 页“进行无线打印时显示'无法通讯'消息”

• 第162 页“解决间歇无线通讯问题”

将无线设置恢复为出厂默认设置

从主界面中依次选择：

 > 网络设置 > 恢复网络设置 > 是

如要确认，请打印一张网络设置页，然后查看无线设置。

无法通过无线网络进行打印

如果您在安装过程中遇到了问题、您的打印机没有出现在打印机文件夹中、或者发送打印作业时您的打印机没
有出现在打印机选项中，您可以尝试反安装并重新安装软件。

在您重新安装软件之前，请先检查疑难解答注意事项，然后尝试以下的方法：

关闭并重新打开接入点（无线路由器）

等待 1 分钟，让打印机和计算机重新建立连接。此操作有时可以刷新网络连接，解决连接问题。

从虚拟个人网络(VPN)上断开连接

当您通过 VPN 连接在其他网络中时，将不能通过无线网络访问打印机。请结束您的 VPN，然后重新尝试打
印。

请确认“演示模式”已关闭

当“演示模式”开启时，一些打印机功能将无法使用。

从主界面中，依次选择：

 >演示模式 >关 > 保存设置
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检查您的 WEP 密钥或 WPA 密码

如果您的接入点使用 WEP 安全性，WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的符号。WEP 密钥中的 ASCII
字符需要区分大小写。

如果您的接入点使用 WPA 或 WPA2 安全性，WPA/WPA2 预共享密钥/密码应该为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的符号。WPA/WPA2 预共享密
钥/密码中的 ASCII 字符需要区分大小写。

注意：如果您不知道此信息，请参阅随同无线网络一起提供的帮助文档，或者联系无线网络安装人员。

检查接入点上是否有关联/注册按钮

在欧洲、中东和非洲，当您向无线网络中添加打印机时，无线宽带盒（例如 LiveBox、AliceBox、N9UF 
Box、FreeBox 或 Club Internet）可能会要求您按下关联/注册按钮。

如果您使用这些设备之一并且需要更多信息，请参阅随您的设备一起提供的文档，或者与您的 Internet 服务
提供商(ISP)联系。

移动您的无线接入点，使之远离其他电子设备

一些电子设备（例如微波或其它电器用具、无线电话、婴儿监视器和安全系统照相机）可能会产生临时的干
扰。请确认您的接入点没有放置在距离这些设备很近的地方。

将计算机和/或打印机移动到距离接入点比较近的地方

您的无线网络范围取决于很多因素，包括接入点和网络适配器的能力。如果您在打印时遇到问题，请尝试调
整计算机和打印机的位置，使它们之间的距离不超过 100 英尺。

检查无线信号质量

打印网络设置页并检查信号质量。如果列出的信号质量是好或者很好，说明导致问题的是其他因素。

检查您的高级安全设置

• 如果您要使用 MAC（媒体访问控制）地址过滤功能来限制其他人访问您的无线网络，必须将打印机的
MAC 地址添加到允许连接到接入点的地址列表中。

• 如果您要设置接入点只分配有限数量的 IP 地址，必须先改变此设置，然后才能添加打印机。

注意：如果您不了解如何进行这些改变，请参阅随同接入点一起提供的帮助文档，或者与无线网络的安装
人员联系。

请确认您的计算机连接在您的接入点上

• 打开您的 Web 浏览器并访问任意网站，确定您是否可以访问 Internet。

• 如果您的无线网络中有其他的计算机或资源，请检查并确认是否可以从您的计算机上访问这些资源。
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请确认您的计算机和打印机连接在同一个无线网络中

如果打印机和计算机不在同一个无线网络中，您将不能进行无线打印。如果计算机已经连接在无线网络中，
打印机的 SSID 必须与计算机的 SSID 一致。

对于 Windows 用户

1 获取计算机所连接的网络的 SSID。

a 在您的 Web 浏览器的地址栏中输入您的接入点的 IP 地址。

如果您不知道接入点的 IP 地址：

1 单击 ，或者依次单击开始和运行。

2 在“开始搜索”或“运行”对话框中输入 cmd。

3 按 Enter 键，或者单击确定。

4 输入 ipconfig，然后按 Enter 键。查看“Wireless Network Connection”部分：

• “Default Gateway”项目通常即为接入点。

• IP 地址由 4 组数字组成，用点分隔，例如 192.168.2.134。

b 当出现提示时，请输入接入点的用户名和密码。

c 单击确定。

d 在“Wireless settings”（无线设置）部分查找 SSID。

e 记录该 SSID。

注意：请确认您准确记录了所有内容，包括任何大写字母。

2 获取打印机所连接的网络的 SSID：

a 使用打印机打印一张网络设置页。

b 在“无线”部分查找 SSID。

3 比较计算机和打印机的 SSID。

如果 SSID 相同，说明计算机和打印机连接在同一个无线网络中。

如果 SSID 不相同，请重新运行实用程序，在计算机所使用的无线网络中安装打印机。

对于使用 AirPort 基站的 Macintosh（英文版）用户

在 Mac OS X 10.5 或更高版本中

1 从苹果图标菜单中依次选择：

System Preferences >Network >AirPort

或

System Preferences >Network >Wi‑Fi

计算机所连接的网络的 SSID 将会显示在“Network Name”菜单中。

2 记录该 SSID。
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在 Mac OS X 10.4 或更早版本中

1 从 Finder 中依次选择：

Applications >Internet Connect >AirPort

计算机所连接的网络的 SSID 将会显示在“Network”菜单中。

2 记录该 SSID。

对于使用接入点的 Macintosh（英文版）用户

1 在您的 Web 浏览器的地址栏中输入接入点的 IP 地址，然后继续进行步骤 2。

如果您不知道接入点的 IP 地址，请按照以下的步骤进行操作：

a 从苹果图标菜单中依次选择：

System Preferences >Network >AirPort
或

System Preferences >Network >AirPort

b 单击 Advanced 或 Configure。

c 单击 TCP/IP。
“Router”项目通常即为接入点。

2 当出现提示时，请输入您的用户名和密码，然后单击 OK。

3 在“Wireless settings”（无线设置）部分查找 SSID。

4 记录下 SSID、安全类型和 WEP 密钥/WPA 密钥（如果显示）。

注意：

• 请确认您准确地记录了网络信息，包括任何大写字母。

• 将 SSID 和 WEP 密钥/WPA 密码保存在安全的地方，以备将来查阅。

请确认您的操作系统兼容通过 AIRPORT 的无线打印

打印机只支持在 Mac OS X 10.5 或更高版本中通过 AirPort 基站进行无线打印。

没有安装无线打印服务器

在安装过程中，您可能会看到一条信息，提示您打印机没有安装无线打印服务器。如果您不确定打印机是否可
以进行无线打印，请尝试以下的方法：

检查电源

请确认  指示灯亮着。

进行无线打印时显示“无法通讯”消息

尝试以下一项或多项操作：

请确认您的计算机和打印机都有适合于网络的有效 IP 地址

如果您使用的是便携式笔记本电脑，并且启用了节能设置，则尝试进行无线打印时，笔记本电脑屏幕上可能
显示“无法通讯”消息。如果笔记本电脑的硬盘处于节能模式，可能会发生此情况。
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如果您看到了此消息，请等待几秒钟，然后重新尝试打印。笔记本电脑和打印机需要等待几秒钟才能恢复正
常模式并重新连接到无线网络。

如果您等待了足够长的时间让笔记本电脑和打印机连接网络，但是仍然看到此消息，可能是您的无线网络出
现了问题。

请确认笔记本电脑和打印机都收到了 IP 地址：

对于 Windows 用户

1 单击 ，或者依次单击开始和运行。

2 在“开始搜索”或“运行”对话框中输入 cmd。

3 按 Enter 键，或者单击确定。

4 输入 ipconfig，然后按 Enter 键。

IP 地址由 4 组数字组成，用点分隔，例如 192.168.0.100。

对于 Macintosh（英文版）用户

1 从苹果图标菜单中依次选择：

About This Mac >More Info

2 在“Contents”区域中选择 Network。

3 如果您通过无线网络进行连接，请从“Active Services”列表中选择 AirPort。

“Router”项目通常即为接入点。

查找打印机的 IP 地址

• 使用打印机打印一张网络设置页。

在“TCP/IP”部分查找 Address。

• 查看打印机设置。

1 从打印机操作面板中，依次选择：

 >网络设置 >TCP/IP >IPv4 设置

2 查找 IP Address。

如果打印机和/或笔记本电脑没有 IP 地址，或者其 IP 地址是 169.254.x.y（其中 x 和 y 是 0–255 之间的任
意两个数字）：

1 关闭缺少有效 IP 地址的设备。

2 打开设备，然后再次检查 IP 地址。

如果打印机或笔记本电脑仍然没有收到有效的 IP 地址，可能是您的无线网络出现了问题。请尝试以下方法：

• 确认您的接入点（无线路由器）的电源已打开，并且可以正常工作。

• 移开所有可能阻挡信号的物体。

• 临时关闭网络中所有不必要的无线设备，并暂停所有网络密集型活动，例如大型文件传输或网络游戏。
如果网络太忙，打印机有可能在允许的时间内收不到 IP 地址。

• 确认您的 DHCP 服务器（也可能是您的无线路由器）可以正常工作，并且经过配置可以分配 IP 地址。
如果您不确定如何操作，请参阅随同您的无线路由器一起提供的手册。

如果打印机和计算机都有有效的 IP 地址，并且网络工作正常，请继续进行疑难解答操作。
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确认选择了无线端口

注意：此方法只适用于 Windows 用户。

1 单击 ，或者依次单击开始和运行。

2 在“开始搜索”或“运行”对话框中输入 control printers。

3 按 Enter 键，或者单击确定。

4 右键单击打印机图标，然后从菜单中选择属性或打印机属性。

5 单击端口选项卡。

6 找到所选端口。在“端口“列中，选定的端口旁边有一个选中标记。

7 如果选定端口的“描述”列表明它是一个 USB 接口，请滚动查看列表并从中选择“描述”列是“打印机
端口”的端口。检查“打印机”列中的打印机型号，确认您选择了正确的打印机端口。

8 单击确定，然后重新尝试打印。

确认双向通讯已启用

注意：此方法只适用于 Windows 用户。

1 单击 ，或者依次单击开始和运行。

2 在“开始搜索”或“运行”对话框中输入 control printers。

3 按 Enter 键，或者单击确定。

4 右键单击打印机图标，然后从菜单中选择属性或打印机属性。

5 单击端口选项卡。

6 选中启用双向支持旁边的框（如果尚未选中）。

7 单击应用 >确定，然后重新尝试打印。

解决间歇无线通讯问题

尽管您的无线网络中明显没有任何改变，您可能会注意到您的打印机工作了一小段时间，然后停止了工作。

很多不同的问题可能导致网络通讯中断，并且有时多个问题同时存在。尝试以下一项或多项操作：

当您尝试使用无线网络时，请断开所有 VPN 连接

大多数虚拟个人网络(VPN)只允许计算机与 VPN 进行通讯，不可以同时与其他网络进行通讯。在计算机上
安装驱动程序或者在计算机上运行无线设置之前，请从 VPN 上断开连接。

如要检查计算机现在是否连接在 VPN 中，请打开您的 VPN Client 软件并检查您的 VPN 连接。如果您没有
安装 VPN Client 软件，请使用 Windows VPN Client 手动检查连接。

如果您希望可以同时连接到您的本地网络和 VPN，请要求 VPN 的系统支持人员允许使用 Split Tunneling
（分离通道）功能。请注意，一些机构组织出于安全或技术的原因不允许使用此功能。

关闭接入点（无线路由器）的电源，然后重新打开

等待 1 分钟，让打印机和计算机重新建立连接。此操作有时可以刷新网络连接，解决连接问题。
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消除网络拥堵

如果无线网络太忙，计算机和打印机可能很难互相通讯。导致无线网络拥堵的原因可能包括：

• 通过网络传输很大的文件

• 网络游戏

• 点对点文件交换应用程序

• 流视频

• 无线网络中同时存在太多的计算机

消除干扰源

普通家庭用品有可能会中断无线网络通讯。位于无线网络附近的无线电话（不包括手机）、微波炉、婴儿监
视器、几乎所有的厨房用具、无线监视设备以及任何包含发动机的用具都有可能会中断无线网络通讯。

请尝试打开这些可能的干扰源，看它们是否导致了问题。如果是，请将您的无线网络与这些设备分开。

改变接入点使用的频道

有时候您可以通过改变您的接入点用于广播的频道来消除来自未知来源的干扰。路由器上有 3 个独特的频
道。请参阅随同您的路由器一起提供的帮助文档确定是哪三个。其他的频道作为可选项提供，但是它们是互
相交迭的。如果路由器配置为使用默认设置，请改变频道设置，使用不同的独特频道。如果您不确定如何改
变频道，请参阅随同您的接入点一起提供的帮助文档。

使用唯一的 SSID 配置接入点

很多无线网络使用路由器制造商最初为路由器配置的 SSID。当多个使用相同 SSID 的网络在同一区域内同
时运行时，使用默认 SSID 可能会导致问题。尽管会显示正在尝试连接到正确的网络，但是打印机或计算机
可能会尝试连接到错误的网络。

如要避免出现这种类型的干扰，请在您的接入点上改变 SSID，不要使用默认值。如果您不确定如何改变
SSID，请参阅随同您的接入点一起提供的帮助文档。

注意：如果您在接入点上改变了 SSID，您必须在所有其他访问无线网络的设备上改变 SSID。

为网络中的所有设备指定静态 IP 地址

大多数无线网络使用无线路由器内置的 DHCP（动态主机分配协议）服务器为无线网络中的用户分配 IP 地
址。DHCP 地址在需要的时候才会分配，例如当新的设备添加到无线网络中或者当设备打开电源时。无线设
备必须向路由器发送请求，然后接收一个 IP 地址，以便可以在网络中工作。由于无线路由器除了分配地址
以外还要完成很多其他的任务，有时可能不会很快地响应并分配地址。请求的设备有时会在接收到地址之前
就放弃了。

请尝试为您的网络中的设备指定静态 IP 地址以解决此问题。

如要为打印机指定一个静态 IP 地址：

1 完成无线设置，允许打印机从网络中的 DHCP 服务器接收一个 DHCP 地址。

2 打印一张网络设置页，查看当前为打印机分配的 IP 地址。

3 打开网络浏览器，然后在地址栏中键入打印机的 IP 地址。按 Enter 键。

4 单击设置。 >网络/端口 >TCP/IP >设置静态 IP 地址。

5 在“地址”字段中，输入您希望为打印机指定的 IP 地址，然后单击提交。
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在网络浏览器的地址栏中输入静态 IP 地址，查看打印机网页是否可以打开，以确认 Embedded Web Server
是否已更新。如要获取更多有关指定静态 IP 地址的帮助信息，请参阅随同您的路由器和操作系统一起提供
的帮助文档。

查看接入点的已知问题

一些无线路由器带有明确的缺陷，已经得到了制造商的验证和确认。请访问路由器制造商的公司网站。从制
造商了解固件更新信息和其他的建议。如果您不确定如何访问制造商网站，请参阅随同您的无线路由器一起
提供的帮助文档。

检查无线网络适配器更新

如果您从一台特定的计算机打印时遇到了问题，请查看该计算机的无线网络适配卡的制造商网站。网站上可
能有更新的驱动程序，可以解决问题。

将所有的网络设备改变为相同的类型

虽然在同一个无线网络中可以成功地同时包含 802.11b、802.11g 和 802.11n 设备，但是较快的设备有时会
阻止较慢的设备进行通讯。

请尝试只打开相同类型的网络设备，看网络通讯是否有所改善。如果此方法可以解决问题，您可能需要使用
较新的无线网络适配器升级较旧的设备。

购买一个新的路由器

如果您的路由器已经使用了很多年，它可能无法与网络中较新的无线设备完全兼容。请考虑购买一个可以完
全兼容 802.11 IEEE 规范的较新的路由器。

以太网络疑难解答

打印机没有出现在已在网络中查找到的打印机列表中

检查以太网电缆

• 检查以太网电缆和两端的以太网插头是否有明显的损坏。

• 将以太网电缆的一端牢固地连接在打印机上。将以太网电缆的另一端牢固地连接在网络集线器或墙壁网
络插座上。

• 尝试使用不同的电缆。电缆的损坏可能并不明显。

请确认打印机的电源已打开

请确认打印机已接通电源，并且电源已打开。

请确认网络工作正常

• 尝试访问网络中的其他计算机。

• 请确认所有的转换器、集线器和其他连接设备的电源都已打开。
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请确认打印机的网络设置正确

使用打印机打印一张网络设置页，然后检查以下内容。请参阅《用户指南》的“网络连接”一节获取有关如
何打印网络设置页的指导。

• 请确认 IP 地址对于您的网络是正确的。

• 请确认网关正确。

• 请确认网络掩码与您的网络中其他计算机和打印机所使用的网络掩码相同。

无法打印到网络打印机

检查以太网电缆

• 检查以太网电缆和两端的以太网插头是否有明显的损坏。

• 将以太网电缆的一端牢固地连接在打印机上。将以太网电缆的另一端牢固地连接在网络集线器或墙壁网
络插座上。

• 尝试使用不同的电缆。电缆的损坏可能并不明显。

请确认打印机的电源已打开

请确认打印机已接通电源，并且电源已打开。

请确认网络工作正常

• 尝试访问网络中的其他计算机。

• 请确认所有的转换器、集线器和其他连接设备的电源都已打开。

反安装并重新安装软件

查看《用户指南》的“重新安装打印机软件”部分。

Embedded Web Server 没有打开
请尝试下列办法中的一个或多个：

检查网络连接
确认打印机和计算机的电源已打开并连接到相同的网络。

检查在 WEB 浏览器中输入的地址
• 根据网络设置，您可能需要在打印机 IP 地址之前键入“https://”而不是“http://”才能访问 

Embedded Web Server。如需更多信息，请联系系统支持人员。

• 确认打印机 IP 地址是正确的。

临时禁用 WEB 代理服务器
代理服务器可能阻止或限制您访问某些 Web 站点，包括 Embedded Web Server。如需更多信息，请联系
系统支持人员。
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联系客户支持
联系客户支持时，请描述您遇到的问题、打印机显示屏上显示的信息，以及您为寻找解决方案所采取的问题解
决步骤。

您还需要知道您打印机的型号类型和序列号。如要获取更多信息，请查看打印机前部盖板顶部内的标签。序列
号也列在菜单设置页中。

Lexmark 提供各种方法来帮助您解决打印时遇到的问题。请访问 Lexmark 网站
(http://support.lexmark.com)，然后选择以下一项：

技术库 您可以浏览我们的手册、支持文档、驱动程序以及其他下载内容等技术库以帮助您解决常见问题。

电子邮
件

您可以向 Lexmark 团队发送电子邮件，说明您遇到的问题。Lexmark 团队代表将进行答复，并提供给您解决
问题的信息。

实时交
谈

您可以直接与 Lexmark 服务代表交谈。他们将与您协作来解决打印机问题或者提供“协助服务”（Lexmark
服务代表会通过 Internet 远程连接到您的计算机，并对问题进行故障诊断、安装更新或者完成其他任务以帮助
您成功使用 Lexmark 产品）。

还提供了电话支持服务。美国或加拿大客户请致电 1-800-539-6275。其他国家或地区客户请访问 Lexmark 网
站：http://support.lexmark.com。
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注意事项

产品信息

产品名称：

Lexmark Pro5500 Series

机器类型：

4447

型号：

Pro5500 Series: 200, 20E

版本注意事项

2012 年 4 月

以下文字如果与当地法律法规有所冲突，可能并不适用于那些地区：LEXMARK INTERNATIONAL, INC.以其
现状提供此手册，并没有任何保证（不论明示的或暗示的），包括，但不限于以其特定目的进行销售及适用的
暗示保证。某些司法管辖区并不准许在某些交易中排除明示的或暗示的保证；因此，这份声明可能并不适用于
你方。

本手册中可能会有技术上的不准确或印刷错误。鉴于此，本手册中的内容会阶段性地更新；这些改动将会体现
在以后的版本中。产品或程序有可能会随时改动，如有改动，恕不另行通知。

本手册中提到的有关产品、程序或服务等并不意味着生产厂商打算将这些产品、程序或服务向所有的国家提
供，也不意味着只能使用此产品、程序或服务。任何功能一样的产品、程序或服务，只要不侵犯现有的知识产
权，都可以用来替换使用。与其他的产品、程序或服务（除厂商明确标明外）共同操作并进行评估与验证是用
户的责任。

如需 Lexmark 技术支持，请访问 http://support.lexmark.com。

如需有关耗材和下载的信息，请访问 www.lexmark.com。

如果您不能访问 Internet，您可以通过邮件联系 Lexmark：

Lexmark International, Inc.
Bldg 004-2/CSC
740 New Circle Road NW
Lexington, KY 40550
USA

© 2012 Lexmark International, Inc.

All rights reserved. 保留所有权利。

商标

Lexmark 和带有菱形图案的 Lexmark 是 Lexmark International, Inc. 的商标，在美国和/或其他国家注册。

Mac 和 Mac 徽标是 Apple Inc. 在美国和其他国家注册的商标。
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PCL® 是 Hewlett-Packard（惠普）公司的注册商标。

所有其他商标的所有权属于它们各自的所有者。

AirPrint 和 AirPrint 徽标是 Apple, Inc. 的商标。

模块化组件通告

此产品可能包含以下模块化组件：

Lexmark 管理机型/型号 LEX-M03-003；FCC ID：US:2G2CN00BM03003；Industry Canada IC：2376A-
M03003

Lexmark 管理机型/型号 LEX-M01-003；FCC ID：IYLM01003；Industry Canada IC：2376A-M01003

噪音水平

下列测量按照 ISO 7779 进行，并且报告符合 ISO 9296 标准。

注意：一些模式可能不适用于您的产品。

1 米平均声压，dBA

打印 52 dBA

扫描 47 dBA

复印 52 dBA

就绪 无声

值可能会有所变化。请参阅 www.lexmark.com 上的当前值。

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of 
the European Union. We encourage the recycling of our products.

If you have further questions about recycling options, visit the Lexmark Web site at www.lexmark.com for 
your local sales office phone number.
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电池通告

此产品包含高氯酸盐材料，可能需要特殊的处理方法。请访问网站
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/获取更多的信息。

静电灵敏度注意事项

此符号表示对静电敏感的部件。请先接触打印机的金属外框，再接触这些符号附近的区域。

ENERGY STAR
在产品上或者在启动屏幕上带有 ENERGY STAR 标志的任何 Lexmark 产品已经认证在由 Lexmark 出厂时其
配置符合美国环保署（EPA）的 ENERGY STAR 要求。

中国 RoHS 计划的信息

部件名称 有毒及有害物质或元素

铅（Pb） 汞（Hg） 镉（Cd） 六价铬（Cr VI） 多溴联苯（PBB） 多溴二苯醚（PBDE）

电路板 X O O O O O

电源 X O O O O O

电源线 X O O O O O

连接器 X O O O O O

机械配件—杆、辊 X O O O O O

机械配件—电机 X O O O O O

机械配件—其他 X O O O O O

扫描仪配件 X O O O O O

LCD 显示屏 X O O O O O

O：表示部件的所有同质材料中有毒和有害物质的含量低于 SJ/T11363-2006 中描述的浓度限制要求。

X：表示部件中至少一种同质材料中的有毒和有害物质含量高于 SJ/T11363-2006 中描述的浓度限制要求。

此产品符合欧盟指令 2002/95/EC 中有关某些有害物质使用的限制。
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温度信息

环境操作温度 15-32°C (60-90°F)

运输和存储温度 -40-60°C (-40-140°F)、1-60°C (34-140°F)

功耗

产品功耗

下表记录了该产品的功率消耗特性。

注意：一些模式可能不适用于您的产品。

模式 描述 功耗（瓦特）

打印 产品正在从电子输入生成硬拷贝输出。 37.68 W

副本 产品正在从硬拷贝的原始文档生成硬拷贝输出。 35.31 W

扫描 产品正在扫描硬拷贝文档。 18.66 W

就绪 产品正在等待打印作业。 12.37 W

睡眠模式 产品处于高级别能源节省模式。 5.74 W

关 产品已被插入墙壁电源插座中，但电源开关被关闭。 0.52 W

前面表格中列出的功耗水平表示平均时间测量值。瞬时功率拉升可能远远超过平均水平。

值可能会有所变化。请参阅 www.lexmark.com 上的当前值。

睡眠模式

本产品被设计为使用一种称为睡眠模式的能源节省模式。“睡眠模式”通过在长期不活动时间内减少电力消耗
来节约能源。本产品在指定时间段（称为睡眠模式超时）未被使用后自动进入“睡眠模式”。

本产品的出厂默认“睡眠模式超时”（以分钟为单位）： 30

通过使用配置菜单，可以在 1 分钟至 240 分钟之间修改“睡眠模式超时”。将“睡眠模式超时”设置为较低
的值可以减少能源消耗，但是可能会增加产品的响应时间。将“睡眠模式超时”设置为较高的值可以保持较快
的响应速度，但是会使用更多的能源。

“关”模式

如果此产品具有仍然消耗少量电能的关模式，那么如需完全停止产品功耗，请从电源插座上断开电源线。

能源消耗总量

有时候计算此产品所消耗的能源总量是非常有用的。因为能源消耗声明是以 Watts（瓦特）作为单位的，因
此，如要计算实际消耗的能源总量，还应该分别乘以此产品在各种模式下所工作的时间。将各种模式下所消耗
的能源加在一起，就是此产品所消耗的能源总量。
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通信终端设备管制通告

本章包含有关通信终端设备产品（例如传真机）的管制信息。

无线产品管制通告

本章包含以下有关无线产品（包括但不限于发射机、无线网卡或感应式读卡器）的管制信息。

无线频率辐射暴露通告

此设备的辐射输出能量远远低于美国通信委员会(FCC)和其他管制机构有关无线频率辐射暴露的限制。此设备
的天线和操作人员之间的距离必须保持至少 20 厘米（8 英寸），以满足 FCC 和其他管制机构有关无线频率辐
射暴露的要求。
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打印墨盒错误  137
打印墨盒缺失  138
打印墨盒寿命到期  137
打印确认页  91
打印设置 
定制打印机设置的方式  123

打印时计算机速度变慢  148
打印顺序 
更改  39

打印速度慢  147
打印头 
校正  125

打印头错误  141
打印头警告  141
打印头喷头 
清洁  125

打印头无法移动  140
打印页边缘处的打印质量非常
差  146
打印疑难解答 
打印的图像中出现条纹或线
条  147

打印的页面上有墨迹或污
迹  147

打印时计算机速度变慢  148
打印速度慢  147
打印页边缘处的打印质量非常
差  146

无法从打印队列中删除文
档  133

打印作业 
继续  51
取消  52
暂停  51

代理错误  141
导航窗格  122
导入/导出 
定制打印机设置的方式  123

电话簿 
设置  83, 84

电话簿, 电子邮件 
设置  68

电话插头  77
电话答录机 
设置  71
最佳传真设置  90

电话分线器  75
电话连接到错误的插座上  140
电话线路错误  140
电话线路忙  140
电话线没有连接  140
电缆 

USB  113
安装  113

电源接口 
位置  11

电子邮件 
取消  70
扫描的文档  64
扫描文档或照片  70
设置  67
提示  69
通讯簿  68

电子邮件/FTP 设置 
定制打印机设置的方式  123

电子邮件发送错误  136
电子邮件警报设置 
定制打印机设置的方式  123

电子邮件设置 
配置  67

电子邮件疑难解答 
无法发送电子邮件  150

订购纸张和其他耗材  15
定时传真 
发送  91

定位 
WEP 密钥  110
WPA/WPA2 预共享密钥/密
码  110

服务设置识别码(SSID)  110
读卡器指示灯 
位置  10

多个 WEP 密钥  120

E
EAP  102
EAP-MD5  103
EAP-TLS  103
EAP-TTLS  103
Embedded Web Server 
访问  122
访问问题  165

EXT（电话分机）接口 
位置  11

F
FCC 注意事项  171
Freebox  99
发件人信息 
注册  81

发送报告, 传真  91
发送传真, 提示  85
发送电子邮件 
扫描文档或照片  70

发送定时传真  91
发送历史记录报告  91
发送终端识别(TTI) 
设置  81

法国 
特殊的无线设置指导  99

放大图像  55
分线器, 选择  88
服务设置识别码(SSID) 
查找  117
定位  110
无线网络  110

辐射注意事项  168, 171
复印  53

ID 卡  54
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调整质量  55
放大图像  55
将多页图片复印到一张纸上  56
进行复印  53
去除背景  57
使复印效果变浅或加深  55
缩小图像  55
提示  53
添加背景图案消息  56
在复印件间插入分隔页  56
在纸张的双面  57
纸张节省  56
逐份复印  56

复印和扫描疑难解答 
复印机或扫描仪没有反应  148
仅扫描了部分文档或照片  149
扫描不成功  149
扫描任务花费很长时间或者导致
死机  150

图像扫描质量非常差  149
无法通过网络扫描至计算
机  150

复印机或扫描仪没有反应  148
复印设置 
定制打印机设置的方式  123

复印双面文档 
使用 ADF  54
使用扫描仪玻璃  54

复印疑难解答 
扫描仪部件没有关闭  149

复印质量, 调整  55
复印作业 
取消  58

G
干扰 
无线网络  116

干预管理 
定制打印机设置的方式  123

高级无线设置  95
个人识别码(PIN) 
安全设置  20

个人识别码方法 
使用  101

更改“睡眠”时限  19
更改打印顺序  39
更改默认打印模式  50
更改页面顺序  39
更换打印墨盒  141, 14
更新打印机软件  24
共享打印  109
关闭打印机  134

关联进纸匣  36
管理快捷方式 
定制打印机设置的方式  123

管理配置文件 
定制打印机设置的方式  123

光面纸 
装入  29

H
触摸屏 
浏览  18
清洁  127

合并打印, 打印  40
贺卡 
装入  31

黑白扫描  66
恢复 
将内部无线打印服务器恢复为出
厂默认设置  157

恢复安全 PIN  130
恢复出厂默认设置  20
回收  7

Lexmark 产品  15

I
ID 卡 
复印  54

Infrastructure 网络  114
IP 地址  119
配置  100

IP 地址, 指定  120
IP 语音(VoIP) 
传真设置  75

J
计算机上的防火墙  156
继续 
打印作业  51

“继续”按钮无法使用  155
检测到进纸匣[x]  140
检测到数字线路  135
检查拨号音  89
检查未响应的打印机  129
检索失败的传真  93
将[尺寸] [类型]纸张装入[纸张来
源]  139
将[尺寸]纸张装入[纸张来源]  139
将[纸张来源]更改为[尺寸]的[类型]
纸张  134
将[纸张来源]更改为[尺寸]纸
张  134

将[纸张来源]更改为[自定义类型
名称]  134
将[纸张来源]更改为[自定义字符
串]  134
将[自定义类型名称]装入[纸张来
源]  138
将[自定义字符串]装入[纸张来
源]  139
接收传真 
手动  87
提示  87
自动  87
自动应答设置  87

接收历史记录报告  91
接纸架扩展板 
位置  10

节省能源  19
节约能源  19
节约能源、墨水和纸张  7
节约纸张  19
解决方案  124
仅扫描了部分文档或照片  149
进纸匣 
关联  36
装入纸张  27

进纸匣（进纸匣 1） 
位置  10

进纸匣（进纸匣 2） 
位置  10

进纸匣已拆除  140
校正打印头  125
校正问题  133

K
卡纸和进纸错误疑难解答 

ADF 内发生卡纸  144
打印机内发生卡纸  143
双面打印部件内发生卡纸  144
纸张或特殊介质  145

客户支持  129
客户支持标签 
位置  11

快速拨号 
设置  83

L
LEAP  102, 103
LINE（线路）接口 
位置  11

LiveBox  99
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垃圾传真 
阻止  92

来电显示 
设置  81

来电显示模式, 传真 
设置  82

连接 
配置  118

连接失败  136
联系客户支持  166
联系人列表 
设置  83, 84

联系人列表, 电子邮件 
创建  68
设置  68

铃声音量 
调整  90

浏览菜单 
使用触摸屏  18

M
Macintosh 

USB  106
无线  106
在无线网络中安装打印机  97

Macintosh 打印机软件 
使用  23

MAC 地址  118
查找  119

MAC 地址过滤  118
MSCHAPv2  103
密码  111
密钥索引  120
免提传真  91
明信片 
装入  31

墨水 
节约  7

墨水量 
检查  125

墨水量偏低  138
默认打印机, 设置  50
默认打印模式 
更改  50

默认电子邮件消息  135
默认设置 
恢复  20

N
N9UF Box  99

内部无线打印服务器 
恢复出厂默认设置  157

能源 
节约  7

P
PDF 
从扫描结果创建  65

PEAP  102, 103
PictBridge 和 USB 接口 
位置  10

PictBridge 兼容数码相机 
连接  46

Printer Settings  82
配置 

IP 地址  100
传真设置  82
电子邮件设置  67

配置 Wi-Fi Protected Setup 
PBC, 按钮配置方法  101
PIN, 个人识别码方法  101

配置安全设置  102

Q
其他计算机 
安装无线打印机  97

其他解决方案 
定制打印机设置的方式  123

清洗打印机操作面板  127
清洗打印机外壳  126
清洗打印头喷头  125
驱动程序 
下载  24

取消 
打印作业  52
电子邮件  70
复印作业  58
扫描作业  66

确认页, 传真  91
群组拨号 
设置  83, 84

群组传真, 发送 
立刻  85

R
RJ-11 适配器  77
热转印纸 
装入  30

软件, 可选 
查找, 安装  24

软件更新 
检查  24

软件未安装  130

S
SmartSolutions  124
SmartSolutions 更新失败  142
SMTP 服务器 
配置  67

扫描 
从扫描结果创建 PDF  65
到网络  60
到网络计算机  60
到网络文件夹  60
个人识别码(PIN)  66
黑白  66
扫描文档并发送电子邮件  64
使用 ADF  61
使用触摸屏  59, 60
使用打印机操作面板  60
双面  61
双面文档  61
提高质量  66
提示  59
要编辑的文档  63
至本地计算机  59
至存储卡  61
至闪存驱动器  61

扫描不成功  149
扫描到网络文件夹设置 
定制打印机设置的方式  123

扫描任务花费很长时间或者导致
死机  150
扫描文档的时间过长  141
扫描仪 ADF 顶盖打开  141
扫描仪玻璃 
复印双面文档  54
清洁  127
位置  11

扫描仪部件没有关闭  149
扫描仪已禁用  142
扫描照片 
使用 Macintosh 打印机软件  62
使用 Windows 打印机软件  62
使用打印机操作面板  63

扫描作业 
取消  66

闪存驱动器 
插入  43
打印文档  41
扫描至  61

索引 176



设备 
无线网络  116

设备管理 
定制打印机设置的方式  123

设置 
自动应答  89
最大发送速度  82

设置传真 
DSL 连接  74
VoIP 连接  75
标准电话线连接  71
国家或区域特定  77
数字电话服务  76

设置打印机 
传真  88
电子邮件  67
在无线网络中（Macintosh 英文
版）  97

在无线网络中(Windows)  97
在有线网络中（Macintosh 英文
版）  103

在有线网络中(Windows)  103
设置电子邮件  67
设置双面打印干燥时间  48, 35
设置疑难解答 
打印机打印出空白页  132
打印机无响应  132
恢复安全 PIN  130
软件未安装  130
无法通过 USB 进行打印  133
显示屏上显示的语言有误  130
页面未打印  131

设置纸张尺寸和类型  34
失败的传真 
检索  93

使用 
Macintosh 打印机软件  23
Web Links  23

使用存储卡错误  154
使用高级色彩选项进行打印  38
使用者信息, 传真 
设置  81, 82

输出接纸架 
位置  10

输出接纸架已满  136
数码相机 
连接  46

数字电话服务 
传真设置  76

数字用户线路(DSL) 
传真设置  74

双面 
传真  92
打印, 自动  47
复印, 手动  57
复印, 自动  57

双面, 传真 
设置  82

双面打印  47
双面打印绑定 
长边  54
短边  54

双面打印部件 
位置  11

双面打印部件内发生卡纸  144
双面打印部件缺失  135
双面打印干燥时间 
设置  35, 48, 35, 48

双面扫描  61
使用 ADF（适用于精选打印机
型号）  10

双向通讯 
启用  160

睡眠时限 
更改  19

缩小图像  55
索引卡 
装入  31

T
TCP/IP  119
调整 
扫描颜色  66

调整拨号和铃声音量  90
调整扬声器音量  90
特色铃声  89
提高扫描质量  66
提示 
打印  37
电子邮件  69
发送传真  85
复印  53
接收传真  87
扫描  59

添加 
网络文件夹快捷方式  60

通讯簿 
设置  83, 84

通讯簿, 传真 
设置  82

通讯簿, 电子邮件 
设置  68

通讯簿设置 
定制打印机设置的方式  123

通讯错误  135
通用打印驱动程序 
下载  24

透明胶片 
装入  30

图标 
打印机操作面板  16
主界面  16

图像扫描质量非常差  149
涂层纸 
装入  29

推荐的纸张品牌 
类型和尺寸  33

U
USB  118

Macintosh  106
电缆  113

USB 电缆  113
定义  113

USB 接口 
位置  11

USB 连接 
同时使用网络连接  118

V
VoIP 适配器  75
VPN（虚拟个人网络） 
本地打印  157
与打印机的连接中断  157

W
Web Links 
使用  23

WEP  94, 102
WEP 传输密钥  102
WEP 密钥 
定位  110
密钥索引  120

Wi-Fi Protected Setup 
使用  109
手动配置  101

Wi-Fi Protected Setup 徽标 
识别  109

Wi-Fi 指示灯 
图标的描述  98

Windows 
在无线网络中安装打印机  97
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Windows 软件 
Abbyy Sprint OCR  21
Office 工具  21
Wireless Setup Utility  21
产品更新  21
打印机设置应用程序  21
打印机主页  21
打印首选项  21
电话簿  21
状态报告器  21
状态监控中心  21

WPA  94, 102
WPA/WPA2 预共享密钥/密码 
定位  110

WPA2  94
网络[x]软件错误  139
网络/端口 
定制打印机设置的方式  123

网络安全  111
网络打印机 
安装  120

网络概述  110
网络连接 

IP 地址  120
查找打印机的 IP 地址  120
查找计算机的 IP 地址  120
查找计算机的 IP 地址
（Macintosh 英文版）  120

使用 USB 连接  118
与 Macintosh 计算机共享打印
机  109

与 Windows 计算机共享打印
机  109

网络设置页 
打印  95

网络疑难解答 
无法打印到网络打印机  165
要配置的打印机没有出现在已在
网络中查找到的打印机列表
中  164

网络指示 
灯  98

网络指示灯  98
网站 
查找  8

未指定电子邮件服务器  136
文档 
打印  37
放置在扫描仪玻璃上  31
扫描并进行编辑  63
扫描至电子邮件  70
使用操作面板发送传真  85

使用触摸屏扫描  59, 60
使用打印机操作面板扫描  60
使用计算机发送传真  86
添加网络文件夹快捷方式  60
装入自动文档传送器(ADF)  32

文件类型 
支持的  45

无电子邮件地址  140
无法从打印队列中删除文档  133
无法打开 Embedded Web 
Server  165
无法打印到网络打印机  165
无法发送传真  151
无法发送电子邮件  150
无法获取解决方案  142
无法接收传真  152
无法通过 USB 进行打印  133
无法通过网络扫描至计算机  150
无法通过无线网络进行打印  157
无法通讯 
消息  160

无法运行传真软件  153
无法逐份打印作业  134
无线  118

Macintosh  106
无线打印服务器 
没有安装  160

无线设置 
安装后更改（Macintosh 英文
版）  100

安装后更改(Windows)  100
高级  95, 121
向导  121
需要的信息  95

无线设置过程中所需要的信息  95
无线网络 
安全  94
安全信息  111
安装打印机（Macintosh 英文
版）  97

安装打印机(Windows)  97
服务设置识别码(SSID)  110
干扰  116
高级设置  95
解决通讯问题  162
普通家用配置  111
设置无线打印时所需的信息  95
无线网络的类型  114
向现有的 Ad hoc 网络中添加打
印机  101

信号强度  115
疑难解答  154

无线网络兼容性  94
无线信号 
强度  115

无线信号吸收  116
无线信号质量  116
无线疑难解答 
安装后更改无线设置
（Macintosh 英文版）  100

安装后更改无线设置
(Windows)  100

打印机和计算机在不同的网络
中  117

打印机在无线网络中间歇工
作  162

无法通过无线网络进行打
印  157

与打印机的连接中断  157
无应答  139

X
下载 PCL 驱动程序  24
下载 PS 驱动程序  24
下载通用打印驱动程序  24
显示屏上显示的语言有误  130
线路过滤器  74
协议  119
卸载打印机软件  25
信封 
打印  41
装入  30, 41

信息 
查找  8

信息窗格  122
虚拟个人网络  157
选择分线器, 传真  88
选择无线端口  160

Y
延长双面打印干燥时间  48, 35
验证 

802.1X  103
扬声器音量 
调整  90

要配置的打印机没有出现在已在
网络中查找到的打印机列表
中  164
页面顺序 
更改  39

页面未打印  131
移动打印机  127
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疑难解答 
传真注意事项  151
“继续”按钮无法使用  155
检查未响应的打印机  129
解决基本打印机问题  129
联系客户支持  129, 166
无法打开 Embedded Web 

Server  165
无线网络  154

疑难解答, 传真 
无法发送传真  151
无法接收传真  152
无法运行传真软件  153

疑难解答, 存储卡 
插入存储卡后没有任何反
应  154

注意事项  154
疑难解答, 打印 
打印的图像中出现条纹或线
条  147

打印时计算机速度变慢  148
打印速度慢  147
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(Windows)  100

解决通讯问题  162
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以太网  118
以太网接口 
位置  11

以太网络 
设置以太网打印时所需的信
息  103

以太网设置 
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以太网指示灯 
图标的描述  98

音量, 调整 
铃声和拨号音  90
扬声器  90

英国 
特殊的无线设置指导  99

有线（以太）网络（Macintosh
英文版）  103
有线（以太）网络
(Windows)  103
语言 
更改  130

语音邮件 
设置  71

语音邮件, 传真设置  90
远程传真错误  141

Z
在 Windows 环境下共享打印
机  108
在以太网络中设置打印机时所需
的信息  103
在有线网络中安装打印机
（Macintosh 英文版）  103
在有线网络中安装打印机
(Windows)  103
暂停 
打印作业  51

噪音水平  168

照片 
扫描至电子邮件  70
使用打印机操作面板打印  45

照片卡 
装入  31

照片纸 
装入  29

证书申请  103
支持的操作系统  21
支持的存储卡和文件类型  45
纸张 
节约  7
装入  27, 29

纸张, 推荐的品牌 
类型和尺寸  33

纸张尺寸和类型 
设置  34

纸张尺寸太小  142
纸张和其他耗材 
订购  15

纸张或特殊介质进纸错误  145
“纸张节省”复印  56
纸张设置 
保存  31
定制打印机设置的方式  123

指定 IP 地址  120
逐份复印  56
主界面 
图标  16

主页 
了解  122
区域  122

注意事项  168, 169, 170, 171
传真疑难解答  151
存储卡疑难解答  154
在您解决问题之前  129

转发传真  92
装入 
各种类型的纸张  29
将文档放置在扫描仪玻璃上  31
将文档装入自动文档传送器

(ADF)内  32
进纸匣  27
信封  41

自定义尺寸的纸张 
打印  43

自动传真转换 
设置  82

自动文档传送器(ADF) 
复印双面文档  54
清除卡纸  144
扫描使用  61
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位置  10
支持的纸张尺寸  32
纸张容量  32
装入文档  32

自动文档传送器(ADF)扫描仪玻
璃 
清洁  127

自动文档传送器(ADF)压板 
清洁  127

自动文档传送器进纸匣 
位置  10

自动应答 
何时启用  89

阻止传真  92
设置  82

最低系统需求  21
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